Contents

Chapter 1: Introduction ............................................. 1

1.1 SchedulePro Uses ................................................. 2
1.2 Quick Start .......................................................... 2
1.3 Organization of this Manual ...................................... 2
1.4 SchedulePro Installation .......................................... 3
  1.4.1 System Requirements ........................................ 3
  1.4.2 Installation from Download Site .......................... 4
  1.4.3 Installation from a CD-ROM ............................... 4
  1.4.4 Database Setup ................................................ 4
1.5 Hardware Key Renewal (Protected Annual Versions Only) ....... 5
1.5 Technical Support Contact Information ......................... 6

Chapter 2: Getting Started ............................................. 7

2.1 Understanding SchedulePro ...................................... 8
  2.1.1 General ......................................................... 8
  2.1.2 Recipes ......................................................... 8
  2.1.3 Scheduling ................................................... 11
2.2 SchedulePro Features ........................................... 12
  2.2.1 Scheduling Timing Options ............................... 12
  2.2.2 Scheduling Modes ........................................... 13
  2.2.3 Visualizing and Reporting Results ...................... 14
  2.2.4 Interaction with Other Programs ......................... 14
2.3 Launching SchedulePro ........................................ 15
  2.3.1 General Options ............................................. 15
2.4 Create Your First Schedule .................................... 16
  2.4.1 Create a Facility and Equipment ......................... 16
2.4.2 Create a Simple Recipe ........................................................................... 16
2.4.3 Schedule the Recipe .............................................................................. 16

Chapter 3: User Interface .......................................................................... 19

3.1 Interface Concepts ................................................................................ 22
3.1.1 The SchedulePro Document ............................................................... 22
3.1.2 Navigation ......................................................................................... 22
3.1.3 Context (Right-Click) Menus ............................................................... 22
3.1.4 Toolbar Buttons ................................................................................. 22

3.2 SchedulePro Navigation Tree .................................................................. 24

3.3 SchedulePro Windows .......................................................................... 25
3.3.1 Campaign Window ............................................................................ 25
3.3.2 Batch Window .................................................................................. 28
3.3.3 Recipe List Window ........................................................................... 29
3.3.4 Recipe Window ................................................................................ 32
3.3.5 Section Window ................................................................................ 35
3.3.6 Procedure Window .......................................................................... 35
3.3.7 Materials List Window ....................................................................... 37
3.3.8 Facilities List Window ....................................................................... 40
3.3.9 Labor Window .................................................................................. 41
3.3.10 Staff Window .................................................................................. 43
3.3.11 Utilities Window ............................................................................. 44
3.3.12 Equipment (Work Area / Transfer Panel) Window ......................... 45
3.3.13 Storage Unit/Material Supply System Window ................................. 47
3.3.14 Campaign Entry Window .................................................................. 48
3.3.15 Batch Entry Window ................................................................-------- 50
3.3.16 Scheduled Procedure Entry Window ............................................... 52

3.4 SchedulePro Main Menu ....................................................................... 53
3.4.1 File Menu Item ................................................................................ 53
3.4.2 Edit Menu Item ................................................................................. 54
3.4.3 Recipe Menu Item ............................................................................. 55
3.4.4 Resources Menu Item ....................................................................... 55
3.4.5 Schedule Menu Item ........................................................................................................56
3.4.6 View Menu Item .............................................................................................................57
3.4.7 Reports Menu Item .........................................................................................................58
3.4.8 Connectivity Menu Item .................................................................................................59
3.4.9 Window Menu Item ........................................................................................................60
3.4.10 Help Menu Item ...........................................................................................................60
3.5 Standard Toolbar Buttons .................................................................................................61
3.6 Scheduling Toolbar Buttons .............................................................................................61
3.7 Interface Options ...............................................................................................................62
3.7.1 Physical Units Defaults ..................................................................................................62
3.7.2 General Preferences .....................................................................................................62

Chapter 4: Tutorial ..................................................................................................................65
4.1 Introduction ..........................................................................................................................66
4.2 Tutorial Structure ...............................................................................................................68
4.3 The Tutorials ......................................................................................................................69
Tutorial-1a: Creating and Scheduling a Simple Recipe .........................................................69
Tutorial-1b: Impact of Equipment Pools ..............................................................................88
Tutorial-1c: Scheduling with Flexible Shifts ......................................................................90
Tutorial-2a: Multiple Recipes and Equipment Routing ....................................................93
Tutorial-2b: Considering Changeover Times .....................................................................96
Tutorial-3a: Drag & Drop Schedule Adjustments ............................................................99
Tutorial-3b: Representing Process Delays ........................................................................101
Tutorial-4a: Resource Tracking .........................................................................................105
Tutorial-4b: Inventory Tracking .........................................................................................113
Tutorial-5: Debottlenecking Production Lines ..................................................................118
Tutorial-6a: Scheduling with Facility Downtimes .............................................................121
Tutorial 6b: Interruptible Operations ...............................................................................124
Tutorial-7: Scaling Recipes and Campaigns .....................................................................126

Chapter 5: Creating Recipes ..................................................................................................133
5.1 Introduction .......................................................................................................................134
5.2 Importing Recipes from SuperPro

5.2.1 SuperPro Recipe Export

5.2.2 SchedulePro Recipe Import

5.2.3 Managing the Recipe Database

5.3 Building Recipes in SchedulePro

5.3.1 Recipe Classifications and Types

5.3.2 Adding a Recipe

5.3.3 Recipe Sections

5.3.4 Procedures

5.3.5 Operations

5.4 Editing Data for the Entire Recipe

5.4.1 Assigning Operation Types

5.4.2 Assigning Flexible Shifts

5.4.3 Managing Streams

5.4.4 Editing Labor Requirements

5.4.5 Editing Procedure Data

5.4.6 Scaling Recipes

5.4.7 Operation Report Text

5.5 Validating a Recipe

5.5.1 Recipe Check Function

Chapter 6: Declaring Resources

6.1 Introduction

6.1.1 Used-By Feature for Resources

6.2. Material Resources

6.2.1. Adding Material

6.2.2 Editing Material

6.3. Facility Resources

6.3.1 Adding a Facility

6.3.2. Editing a Facility

6.3.3 Facility Resource Calendar
6.3.4 Labor Resources ........................................................................................................ 176
6.3.5 Staff Resources ........................................................................................................ 177
6.3.6 Utility Resources ...................................................................................................... 178
6.3.7 Equipment ................................................................................................................ 180
6.3.8 Work Areas ............................................................................................................... 185
6.3.9 Transfer Panels ........................................................................................................ 186
6.3.10 Storage Units .......................................................................................................... 190
6.3.11 Material Supply Systems ....................................................................................... 196
6.3.12 Suites ...................................................................................................................... 198

Chapter 7: Scheduling Campaigns ................................................................................. 201

7.1 Introduction .................................................................................................................. 203

7.2 Scheduling Modes ....................................................................................................... 203
  7.2.1 Built-In Scheduling Modes .................................................................................... 203
  7.2.2 Defining and Selecting Scheduling Modes .......................................................... 203
  7.2.3 Editing a Scheduling Mode .................................................................................. 204

7.3 Planning a Campaign .................................................................................................. 209
  7.3.1 Campaigns ............................................................................................................. 209
  7.3.2 Campaign Setup Options ..................................................................................... 209
  7.3.3 Campaign Scaling ................................................................................................ 218
  7.3.4 User-Defined Campaign Properties .................................................................... 218
  7.3.5 Campaign Projects ............................................................................................... 219

7.4 Scheduling Campaigns ............................................................................................... 219
  7.4.1 Scheduling and Unscheduling ........................................................................... 219
  7.4.2 Scheduled Entities ................................................................................................ 219
  7.4.3 Viewing Conflicts ................................................................................................ 221
  7.4.4 Resolving Conflicts .............................................................................................. 222
  7.4.5 Campaign Scheduling Dependencies ................................................................. 222

7.5 Modifying the Schedule ............................................................................................. 224
  7.5.1 Modifying Scheduled Campaigns ...................................................................... 224
  7.5.2 Modifying Scheduled Batches ........................................................................... 225
  7.5.3 Modifying Scheduled Procedures ...................................................................... 229
Contents

7.5.4 Modifying Scheduled Operations ................................................................. 229
7.5.5 Modifying the Completion Status .................................................................... 231
Chapter 8: Charts and Reports .............................................................................. 233

8.1 Introduction ........................................................................................................ 236

8.2 Contents and Ordering Options for Charts and Reports ................................. 236

8.2.1 Clipping Options .......................................................................................... 237
8.2.2 Contents and Ordering ................................................................................. 238

8.3 Common Chart Timescale Toolbars and Commands ........................................ 240

8.3.1 Timescale Buttons ....................................................................................... 240
8.3.2 Timescale Options ....................................................................................... 240

8.4 Gantt Chart ....................................................................................................... 241

8.4.1 Gantt Chart Commands ............................................................................... 242

8.5 Equipment Occupancy Charts ......................................................................... 243

8.5.1 Equipment Occupancy Chart Toolbars ......................................................... 245
8.5.2 Drag and Drop Editing Menu ....................................................................... 245
8.5.3 Scheduler Settings ....................................................................................... 245
8.5.4 Campaign Management .............................................................................. 246
8.5.5 Database Menu ............................................................................................ 247
8.5.6 Weekend Hours ............................................................................................ 248
8.5.7 Viewing Other Charts from the Equipment Occupancy Chart ..................... 249
8.5.8 Conflict Display ........................................................................................... 250
8.5.9 Equipment Occupancy Context Menu ......................................................... 250
8.5.10 Styles in Detail ........................................................................................... 251
8.5.11 Editing from the Occupancy Chart .............................................................. 252
8.5.12 Managing Campaigns from the Equipment Occupancy Chart .................. 253
8.5.13 Trace and Rollback for Changes to the Schedule ........................................ 255
8.5.14 Resource Search ........................................................................................ 255

8.6 Resource Consumption Charts ......................................................................... 256

8.6.1 Resource Chart General Features ................................................................. 256
8.6.2 Material Profiles ........................................................................................ 259
9.3.2 Configuring the MRP Interface ............................................................... 293
9.3.3 Importing and Exporting Data ................................................................. 296
9.4 Scheduling from Text File Input ................................................................. 296
  9.4.1 Formatting the Schedule File ................................................................. 296
  9.4.2 Loading the Schedule File ................................................................. 297
9.5 Using the SQL Server Database ................................................................. 297
Index ................................................................................................................. 307
Chapter 1: Introduction

Chapter 1: Introduction ................................................................................................. 1

1.1 SchedulePro Uses ................................................................................................. 2

1.2 Quick Start ............................................................................................................. 2

1.3 Organization of this Manual .................................................................................. 2

1.4 SchedulePro Installation ....................................................................................... 3

1.4.1 System Requirements ....................................................................................... 3

Sentinel Driver (Hardware Protected Version Only) ..................................................... 3
MDAC Installation ........................................................................................................ 3
Microsoft .NET Framework ......................................................................................... 4
SQL Server and Report Viewer .................................................................................... 4

1.4.2 Installation from Download Site ......................................................................... 4

1.4.3 Installation from a CD-ROM ............................................................................. 4

All CD Versions .......................................................................................................... 4
Hardware Protected Version Only .............................................................................. 4

1.4.4 Database Setup .................................................................................................. 4

Database Locations ..................................................................................................... 4
Report Database .......................................................................................................... 5

1.5 Hardware Key Renewal (Protected Annual Versions Only) .................................. 5

1.5 Technical Support Contact Information .................................................................. 6
1.1 SchedulePro Uses
SchedulePro is a software finite capacity scheduling tool for manufacturing processes. Some typical applications for SchedulePro include:

Production scheduling
Production Tracking and Reporting
Capacity analysis
Plant de-bottlenecking

SchedulePro meets the needs of both the occasional planner or designer, who cares about feasibility and capacity with no concern about actual execution, as well as of the production manager who is responsible for developing and maintaining a feasible schedule under the uncertainties of everyday operation.

SchedulePro uses an intuitive recipe-oriented representation of a manufacturing process. SchedulePro handles resources such as equipment, staff, work areas, labor, materials, utilities and inventory capacity. SchedulePro allows for interruptions in the availability of resources to account for shift schedules, holidays, and planned maintenance.

1.2 Quick Start
For the quickest start, skim chapter 3 for the basic concepts. Go over tutorial 1 (Chapter 4). This provides the basic concepts for SchedulePro.

You may select additional tutorials to fit your needs.

1.3 Organization of this Manual

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Introduction</td>
<td>Introduction, organization of the manual, system requirements, installation notes, system administrator information and technical support information.</td>
</tr>
<tr>
<td>2 Getting Started</td>
<td>This chapter explains basic SchedulePro concepts and features.</td>
</tr>
<tr>
<td>3 User Interface Features</td>
<td>This chapter explains how SchedulePro’s user interface works.</td>
</tr>
<tr>
<td>4 Tutorial</td>
<td>A step-by-step guide to using SchedulePro on a variety of scheduling problems. This chapter is accompanied by several example SchedulePro files.</td>
</tr>
<tr>
<td>5 Creating Recipes</td>
<td>A reference guide to creating and using recipes.</td>
</tr>
<tr>
<td>6 Declaring Resources</td>
<td>A reference guide to creating and using resources.</td>
</tr>
<tr>
<td>7 Creating Schedules</td>
<td>A reference guide to creating and working with campaigns, batches, and schedules.</td>
</tr>
</tbody>
</table>
8 Charts & Reports | A reference guide to SchedulePro’s charts, reports and data exporting features.
---|---
9 Data Import/Export | A reference guide to SchedulePro’s data import/export features and to the SQL Server database features.

The scheduled history management and web-based reporting features are documented in a separate publication: SchedulePro Schedule Database.

1.4 SchedulePro Installation

1.4.1 System Requirements

Intelligen recommends that SchedulePro be run with the specifications listed below. These guidelines

<table>
<thead>
<tr>
<th>Operating Systems</th>
<th>MS Windows 7, Windows Vista, MS Windows XP Professional, Note: Installation on Windows 2000 is no longer supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Memory (RAM)</td>
<td>1 GB or more</td>
</tr>
<tr>
<td>Free Disk space</td>
<td>50 MB or more</td>
</tr>
<tr>
<td>Microsoft Data Access Components (MDAC) Required for use with SuperPro Designer or MS Project®</td>
<td>Version 2.6 or higher (Same as SuperPro Designer)</td>
</tr>
<tr>
<td>SuperPro Designer (optional)</td>
<td>Version 7.0 or higher</td>
</tr>
<tr>
<td>Historical Database</td>
<td>SQL Server or SQLExpress</td>
</tr>
<tr>
<td>Report Viewer</td>
<td>MS Report Viewer</td>
</tr>
</tbody>
</table>

Sentinel Driver (Hardware Protected Version Only)

The Single-user (key-protected) version of SchedulePro requires installation of the drivers for the hardware security key. The drivers are installed automatically at the end of the installation procedure. If the driver installation fails, you may receive an error message upon launching SchedulePro. The installation file will be located in the SchedulePro installation directory. The Sentinel driver may alternatively be found at http://www.safenet-inc.com/support-downloads/sentinel-drivers/.

MDAC Installation

SchedulePro uses Microsoft Data Access Components (MDAC) to upload data from SuperPro Designer and to export data to Microsoft Project®. If you are running on an older system or you are not using a recent version of Microsoft Office®, you may need to install MDAC 2.6 or later.

*If you have installed or plan to install SuperPro Designer* there is nothing more you need to do. MDAC is installed with SuperPro, if necessary.
If you do not have SuperPro Designer and you are using an older system, and you receive a warning about MDAC missing, you may need to install MDAC. MDAC is not distributed in the download version of SuperPro. You may obtain it from the Microsoft download site (www.microsoft.com/downloads/).

Microsoft .NET Framework
The Microsoft .NET framework is required. This will be installed if it is not already present.

SQL Server and Report Viewer
The schedule history tracking features require access to a SQL Server relational database. The database does not need to be installed on the same computer that is used for SchedulePro, however it may be convenient to install Microsoft SQLServer Express along with the management studio. This is available from Microsoft (www.microsoft.com/express/Database/).

Microsoft Report Viewer must be installed in order to use the schedule history features. Report Viewer may be installed optionally, but is is not automatically installed with the application.

1.4.2 Installation from Download Site
If you have chosen to install SchedulePro from a download site, you will receive separate instructions with the download site location and any necessary passwords.

Click on the download link to run the file. You may wish to create a directory in which to save the installation files in order to have a backup. Otherwise the installation files will be created in a temporary directory. The installation program will run automatically. Follow the directions to complete the installation.

1.4.3 Installation from a CD-ROM

All CD Versions
If you are installing from a CD-ROM, insert the CD and follow the on-screen prompts. If the installation program does not start, launch the “Setup.exe” program directly from the CD. Follow the instructions on the setup program.

Hardware Protected Version Only
The Single-user (key-protected) version of SchedulePro requires installation of the drivers for the hardware security key. The drivers will install automatically after SchedulePro is installed. Be sure to attach the key before launching SchedulePro.

SchedulePro will check for up to two attached keys. If you have a separate key for SuperPro Designer, you may leave it attached. It is not recommended that you use SchedulePro with three or more keys attached.

1.4.4 Database Setup

Database Locations
SchedulePro uses two Microsoft Access databases. Normally these databases are located in the “ScheduleProData” subdirectory of your public documents directory, e.g.

Libraries\Documents\Intelligen\SchedulePro\ScheduleProData.

The following table outlines the important features of each database:
### Database, Purpose, ODBC Data Source Name, Password

<table>
<thead>
<tr>
<th>Database</th>
<th>Purpose</th>
<th>ODBC Data Source Name</th>
<th>Password</th>
</tr>
</thead>
<tbody>
<tr>
<td>SP RecipeDBv6.mdb</td>
<td>Importing recipes from SuperPro Designer</td>
<td>SchedulePro Recipe DB (SchedulePro Recipe DB v1 is maintained for SuperPro compatibility.)</td>
<td>“changeme”</td>
</tr>
<tr>
<td>SCP Project DB.mdb</td>
<td>Exporting schedules to MS Project</td>
<td>SCP MSProj DB 2000</td>
<td>NONE</td>
</tr>
<tr>
<td>SPOutput.mdb</td>
<td>Custom Reports</td>
<td>ScheduleProOutput</td>
<td>NONE</td>
</tr>
<tr>
<td>SQL Server DB</td>
<td>Archive/Reports</td>
<td>Not used</td>
<td>Set by user</td>
</tr>
</tbody>
</table>

If you move or change the data source name (DSN) of any of these databases, you may need to update the new information in SchedulePro.

Select “Connectivity/Recipe Data/Edit Location…” from the main menu.

For each database you may edit the following:

**Password**
This is the access database password. Note that the password entered is the one that SchedulePro stores for use with the corresponding database. The actual database password may be changed through Access.

**Location**
This is the path for the Access file.

**Status (Read only)**
Any problems are displayed here.

**Report Database**
The reporting output database, SPOutput.mdb is also initially located in the databases subdirectory. To edit the location of this database, select “Connectivity/MDB Repore/Register Report Database” from the main menu.

Creating a Login ID

The database login ID is a personal ID that may be used to identify who has made changes to the database. This ID is *not* related to database access.

If the database is not shared, then there is no need to create an ID.

To create an ID or to login with a previously created ID, select “Connectivity/Login New User…” from the main menu. Enter the ID along with the password and confirmation.

### 1.5 Hardware Key Renewal (Protected Annual Versions Only)
If you have an annual key it will expire after your license term is completed. If you renew your license you will receive a key renewal code. You may run the key renewal utility application from the start menu to enter the code and refresh your key. You may also use the renewal utility at any time to determine your key type and expiration date.

1.5 Technical Support Contact Information

E-Mail (preferred):

techSupport@intelligen.com

Standard mail:

INTELLIGEN, Inc.

2326 Morse Ave.

Scotch Plains, NJ 07076, USA

www.intelligen.com

Telephone

+1 856 235-1438 (from 9:00 am to 5:00 pm US Eastern Time EST)

+1 609 410-6484 (from 9:00 am to 5:00 pm US Eastern Time EST)

+1 908 654-0088 (from 9:00 am to 5:00 pm US Eastern Time EST)
Chapter 2: Getting Started

Chapter 2: Getting Started

2.1 Understanding SchedulePro

2.1.1. General

2.1.2. Recipes

Recipe Organization
Recipe Resources

2.1.3. Scheduling

Campaigns
Batches
Scheduler
Current Time

2.2 SchedulePro Features

2.2.1 Scheduling Options

2.2.2 Scheduling Modes

2.2.3 Visualizing and Reporting Results

2.2.4 Interaction with Other Programs

2.3 Launching SchedulePro

2.3.1 General Options

2.4 Create Your First Schedule

2.4.1 Create a Facility and Equipment

2.4.2 Create a Simple Recipe

2.4.3 Schedule the Recipe
2.1 Understanding SchedulePro

2.1.1. General

SchedulePro is a finite capacity scheduling tool especially designed to handle batch-oriented manufacturing processes. This is distinct from project scheduling in two important ways:

Batch manufacturing is repetitive. A production campaign may require many batches, so the manufacturing process is repeated over and over.

The duration of many batch manufacturing tasks is independent of the number of resources available. A batch chemical reaction, for example, will take the same amount of time whether there are two operators or four.

Scheduling in SchedulePro is a user-driven activity. Users control the pace at which the schedule gets generated, what constraints to consider and how to resolve conflicts resulting from constraint violations. Scheduling or updating can be performed in a fully-automated or completely manual mode.

This section provides a general understanding of how SchedulePro works.

2.1.2. Recipes

Recipe Organization

SchedulePro addresses the need to represent repetitive batch manufacturing by providing the concept of a recipe. A recipe is a template or description of how to make one batch of something.

Recipes are organized into branches and sections. Recipe branches are supported in SchedulePro to maintain compatibility with SuperPro Designer. Branches do not have any function in SchedulePro.

Recipe sections are intended to represent a distinct portion of a process. For example, a recipe may have a bulk mixing section and a filling and packaging section. Sections may optionally be assigned to a suite or a set of equipment that must be used together.
Sections contain **unit procedures**. A unit procedure— *procedure* for short—is a distinct manufacturing step that utilizes at least one primary piece of equipment for its entire duration. For example, a mixing procedure might utilize a blending tank.

Unit procedures are further divided into **operations**. Operations describe distinct sub-steps in a unit procedure. Operations may require other resources such as labor, materials, utilities, auxiliary equipment and staff.

The relative timing of the various operations is determined by the operation’s duration and by scheduling relationships among operations. An operation may have the following duration specifications:

- **Fixed duration (default):** The operations duration is set by the user.
- **Rate based duration:** The duration is based on a rate and is therefore dependent on the amount. For example the duration of a filling operation may be dependent on the filling rate.
- **Dependent duration:** The duration is equal to that of another operation or series of operations.
- **Inventory-dependent duration:** The duration of the operation is related to the time it takes for a storage unit inventory to reach a specified level (in other words, the operation ‘holds’ until that specified level is reached)

An operation may have the following scheduling relative timing relationships:

- **Start of batch:** The operation starts relative to the start of the batch.
- **Start of another operation:** The operation starts relative to the beginning of another operation.
- **End of another operation:** The operation starts relative to the end of another operation.
- **Start to finish:** The operation finishes relative to the start of another operation.
- **Finish to finish:** The operation ends relative to the end of another operation.

In addition to the above specifications, an operation may have a fixed or flexible shift time. A fixed shift is a delay (or advance) that is always applied. A flexible shift is only applied if the operation needs to wait for a resource to become available. An operation can also be declared as ‘interruptible’ meaning that it can stop and resume operation when the resources it needs become again available. The maximum number of breaks and the total break duration are user-defined.

All resources other than primary equipment or work areas are specified at the operation level. Operations may require resources including:

- Auxiliary equipment
- Materials (input or output)
- Utilities (heating/cooling)
- Power
- Labor (pooled labor resource)
- Staff (for scheduling individuals)
Recipe Resources

Resources in SchedulePro represent the physical items that are necessary to execute a recipe, i.e. create a batch. Scheduled entities (operations, procedures, batches) might need to delay their execution until the resources they need become available.

For organization, all resources (except materials) are organized into facilities. Facilities and their resources are equipped with calendars where their outages, downtimes etc can be declared.

Resources act as constraints that the scheduler tries to satisfy, otherwise they generate conflicts. SchedulePro attempts to schedule in a way that does not exceed the supply of resources.

Equipment

Equipment is intended to represent the manufacturing equipment needed to carry out a specific process step, for example a tank, a reactor or a filling machine. From a scheduling point of view, an equipment item is a non-consumable reusable resource.

Every unit-procedure requires an equipment resource. Each operation may optionally require an auxiliary equipment resource. Any equipment may be assigned as either main equipment or auxiliary equipment.

Main equipment and auxiliary equipment are assigned in pools. For example if a mixing step may be carried out in Tank-1 or Tank-2 both tanks may be listed in the pool. SchedulePro will pick the first available tank for a given batch.

Tip: If multiple equipment units are used in a step you may either (1) create separate procedures in the recipe or (2) create an equipment unit that represents the combined equipment.

Equipment in SchedulePro is a simple resource, however, equipment may (optionally) have a size and a rate. SchedulePro uses the size to determine whether the equipment is appropriate for a given procedure or operation. The rate may be used to calculate the duration of rate-dependent operations.

Equipment can optionally be declared able to accommodate multiple simultaneous procedures with user-defined limitations.

Besides facilities, equipment may be further organized into suites. A suite is a set of equipment that must be used together.

Work Areas

Work areas represent rooms or places where procedures are carried out. Like equipment, work areas can accommodate multiple simultaneous procedures with user-defined limitations.

Materials

Materials in SchedulePro are a non-reusable resource. They may be bulk (measured in mass or volume) or discrete (measured in number of individual entities).

Materials are assigned to streams, when they either enter or leave an operation. Streams may be assigned to storage units to aid in tracking or limiting certain material flows. Storage units may be used to place a limit on the rate at which a material may be used. Storage units may also track the inventory of the materials that they handle.

Labor

The labor resource in SchedulePro is a pool of a specific type of labor. The total size of the pool may be set by the user.
Staff
Staff resources are individuals that may be assigned to an operation. Both the number of individuals required and the allowable individuals may be specified.

Utilities
Utilities in SchedulePro are non-reusable resources which can not be stored or inventoried. Utilities may include electrical power, heating agents such as steam, or cooling utilities like cooling water.

Utilities are assigned to operations and may have user-defined limits. They may also be associated with materials in which case the materials consumed for the generation of a utility and the waste generated by the use of that utility can be accounted for.

2.1.3. Scheduling
While a recipe describes a process in general, a schedule is a specific plan that specifies which recipes are executed when and with what resources.

The relationship between recipes and the schedule is shown below:

![Diagram of recipe and campaign relationships]

Campaigns
A campaign is a series of batches of a particular recipe. In SchedulePro a campaign may be planned or scheduled. A planned campaign does not have any scheduled batches but contains the information for scheduling them, e.g. number of batches, start time, due date etc. A campaign is scheduled when all its batches are created.

Campaigns have a release date representing their earliest start time and several scheduling options including due date, start relative to the start or end of some other campaign.

Campaigns contain options on how to size and schedule their batches. A scale factor or target batch size may be specified for all batches of campaign. Cycle time for campaign (i.e. time interval between the start of two consecutive batches) can either be fixed by the user or can be set to (an estimated) minimum value plus some user-defined slack.

Campaigns may also contain optional preproduction and postproduction steps to represent time spent setting up or cleaning out the equipment. These non-production steps are treated as regular operations that may consume materials and resources.
Batches
A batch represents the execution of a single recipe at specific time and with specific resources. Procedures and operations in a recipe have corresponding entries in each batch. A batch has specific start and end times. Batch procedure entries are assigned a specific main equipment unit. Batch operation entries define the utilization of other resources.

Scheduler
Most users begin a scheduling exercise by defining the recipes, planning the campaigns, and allowing SchedulePro to generate a preliminary schedule. When generating a schedule, SchedulePro handles each campaign in the order listed. It then proceeds batch-by-batch calculating timing, assigning resources on a first-available basis and resolving conflicts.

There are modes that control the behavior of the scheduler in all its actions. These modes are presented in section 2.2.1.

After the initial schedule is laid out, the user may edit the schedule by adjusting durations, shifts or start times for particular batches. These adjustments may be made by “dragging and dropping” in the interactive occupancy charts or by precisely specifying a start time. After a manual edit, SchedulePro readjusts the batch to conform to the master recipe (e.g. resets the start time of operations whose start time depends on the edited one) and recalculates conflicts. SchedulePro will not attempt to resolve any resulting conflicts unless invoked by the user.

SchedulePro offers options to reschedule unschedule or resolve conflicts on a batch, a campaign or a portion of the entire schedule starting or ending at a specific batch or campaign. With these options the user has full control on the pace at which the entire schedule is generated and corrected.

Note: Because campaigns are handled in order, their order determines their priority for getting resources. Campaigns that appear later in the list are more likely to have to wait for resources.

Current Time
SchedulePro supports the concept of current time to separate past from future activities. Batches or campaigns ending before the current time are labeled as completed while those starting before the current time but finishing later are labeled as started.

These assignments get modified as the user resets the current time. Completed batches and campaigns can be deleted from the schedule; in this way, the schedule gets updated and the actual plant production process is simulated more realistically.

Batches can also be labeled as locked implying that their timing and resources are fixed and should not be modified. Non-locked batches should try to resolve own conflicts with locked batches even if they have higher priority according to the campaign definition sequence. Batch locking is essentially a way to assign highest priority to a scheduled batch.

2.2 SchedulePro Features

2.2.1 Scheduling Timing Options
SchedulePro provides a number of options for generating a schedule. Options relate to batch timing, the identification of conflicts and the conflict resolution mechanisms.

The following options are available for calculating the start time of batches within a campaign:
**Cycle-time based**: use the campaign cycle time (set by the user or calculated based on the estimated minimum cycle time). Scheduler is free to move the batch start later if needed to avoid conflicts.

**Locked**: for unscheduled batches, their start is locked at their cycle-time-based start time. For scheduled batches, their start is locked at its current value. In both cases, scheduler cannot move their start.

**As Soon As Possible (ASAP)**: each batch gets the earliest possible start after the campaign release time ignoring cycle-time settings.

SchedulePro considers the following scheduling conflicts:

- outage violations
- resource use overlaps (for equipment, work areas and staff)
- resource limit violations (for labor, utilities)
- material supply limit and inventory violations

There are options for all these conflict types so that users can select the scheduling constraints they care about. Outage violations and resource use overlaps are considered *hard-constraints* meaning that they are always identified and reported. Even these, however, can be ignored in scheduling and will not get resolved.

Finally, SchedulePro offers selections for the conflict resolution mechanism to use when constraints get violated. There are three resolution mechanisms available:

- use of alternative resource (for reusable pooled resources)
- use of operation timing flexibilities (flexible shifts and breaks)
- move of the batch start

There are options to turn on or off each of these mechanisms or turn off the entire conflict resolution algorithm. In the latter case, batches are scheduled according to their default timing and resource allocation settings and no attempt is made to resolve any resulting conflicts in the schedule.

### 2.2.2 Scheduling Modes

For convenience, scheduling options are grouped into scheduling *modes*. A mode contains options for timing the batches, identifying and resolving conflicts. A mode and its options do not belong to any particular campaign or batch; they apply to any scheduling activity invoked by the user. While scheduling or updating, users can move back and forth between different modes.

There are three pre-defined scheduling modes in SchedulePro that mainly differ in the batch timing option they implement:

- **Automatic**: this is the default mode. It uses cycle-time-based batch timing, it considers outage violations and resource use overlaps constraints and uses all available mechanisms for conflict resolution.
- **Layout**: it uses locked batch timing and, therefore, does not use moving the batch start as a resolution mechanism
- **ASAP**: it uses ASAP batch timing.

User can modify the options behind these pre-defined modes (except for their batch timing option) but can also introduce their own modes.
2.2.3 Visualizing and Reporting Results

SchedulePro displays schedules in a variety of formats:

- As an explorer tree view (similar to recipes and resources).
- As an interactive oriented Gantt chart.
- As an interactive reusable-resource occupancy chart – this view shows the blocking of equipment, work areas and staff over time.

Functionality to generate, edit or update a schedule exists in all these three views.

SchedulePro generates the following charts:

- Resources (material, labor or utilities demand, or waste generation) as a function of time.
- Material inventories as a function of time.
- Resource utilization statistics.

SchedulePro also provided the following reports in HTML format:

- Full Schedule Report.
- Batch Report.
- Equipment Utilization Tables.
- Daily Activity Report
- HTML Gantt and Equipment Occupancy Charts.
- Recipe report.

See Chapter 8 for more details about charts and reports.

2.2.4 Interaction with Other Programs

SuperPro Designer

SchedulePro has import or export routines for the following programs: SuperPro Designer (import only), Microsoft Project (export only). In addition, the scheduler may be driven from an input file. See chapter 5 for details.

ERP/MRP Systems

SchedulePro’s Connectivity feature provides two ways to connect production order information to external ERP/MRP systems. SchedulePro currently supports configurable text file and MS Access interfaces. See chapter 8 for details.

External Database (SQL Server)

An entire schedule or individual campaigns may be stored in a SQL Server database. SchedulePro provides basic reporting capabilities. See Chapter 9 for more information.
2.3 Launching SchedulePro

SchedulePro may be launched from the Start menu. By default it is located in the SchedulePro menu in the Programs menu.

The initial screen will appear as shown below.

If you have had an earlier version of SchedulePro, the program will ask if you wish to use settings from the previous version. These settings include the recently opened file list, and any user-selected options in the Edit/Preferences menu.

If you receive a warning concerning databases you may need to manually set the location of the database files. After the program starts, select Databanks/Locations from the menu. Ensure that the database files exist and that you have read/write permission.

2.3.1 General Options

Select “Edit/Preferences…” from the main menu.

The following general options may be set:

Show Recipe Branches in Tree
Recipe branches are displayed in the navigation tree. This option is saved with the project file.

Show Recipe Sections in Tree
Recipe sections are displayed in the navigation tree. This option is saved with the project file.

Show Campaign Projects
A project is a group of campaigns. This option must be selected to enable the use of campaign projects.

Show Default Equipment for Procedures
The top-priority equipment is shown for recipe procedures in the navigation tree. This option is saved with the project file.

Display Calendar/Relative Time
Getting Started

This sets the default format in which time is displayed in SchedulePro’s tables and charts. This option is saved with the project file.

Report Viewer
This option sets whether reports are viewed with the system web browser or with SchedulePro’s built-in report view. This option is saved with the application settings.

Autosave Settings
SchedulePro can automatically save the currently open document. The saved file will reside in the same directory as the working file, and the saved files will have the extension, “SAV.” The default save interval is 15 minutes. When you use the autosave feature, you should have write access to your SchedulePro files.

2.4 Create Your First Schedule
This section describes the process of creating an extremely simple schedule. Please see the tutorial for a more complete set of instructions.

2.4.1 Create a Facility and Equipment
All schedules in SchedulePro must have some equipment resources.

Click on Facilities in the navigation tree on the left.

In the right-hand window, click the magic wand ( ) button to create a new facility. Select OK from the dialog.

Expand the new facility in the navigation tree by clicking the (+) just left of the facility’s name.

Select Equipment and click the magic wand button to create a new equipment resource. Click Ok.

2.4.2 Create a Simple Recipe
Click on Recipes in the navigation tree.

In the right-hand window, click the magic wand to create a new recipe. Enter a name for the new recipe, e.g. “My Process”. Click Ok.

Click on the new recipe in the navigation tree.

Click the add procedure button ( ) to add a new procedure. Click Ok. The new procedure has one default operation, which has a duration of 1 hour.

Select “P-1” from the procedure table and click the edit procedure button ( ) to view the procedure’s properties.

Select the Main Equipment Pool tab.

Select “New Equipment” from the Available Equipment list and click the add button ( ) to assign the equipment to the procedure. Click Ok.

2.4.3 Schedule the Recipe
Select Production Schedule in the navigation tree.
In the right-hand window, select the Add New Campaign button just above the Campaign Sequence grid. Click Ok.

Click the Schedule Campaigns button to schedule the campaign.

Congratulations! You have just created and scheduled a simple one-step process. Select “View/Gantt Chart...,” or the button from the toolbar to see the Gantt chart.

Use “File/Properties” from the main menu to add a title and description for your project.

Use “File/Save As” to save your work as a SchedulePro (.scp) file.

Please refer to the tutorial for more comprehensive scheduling examples.
Chapter 3: User Interface

3.1 Interface Concepts .................................................................................................................. 22

3.1.1 The SchedulePro Document .......................................................................................... 22

3.1.2 Navigation ......................................................................................................................... 22

3.1.3 Context (Right-Click) Menus ......................................................................................... 22

3.1.4 Toolbar Buttons ................................................................................................................ 22

   Main Toolbar ......................................................................................................................... 22

3.2 SchedulePro Navigation Tree ............................................................................................. 24

3.3 SchedulePro Windows ......................................................................................................... 25

   3.3.1 Campaign Window ....................................................................................................... 25

      Scheduler Settings .............................................................................................................. 25

      Campaign Sequence .......................................................................................................... 26

      Campaign Sequence Toolbar ............................................................................................ 26

      Campaign Sequence Context Menu .................................................................................. 27

   3.3.2 Batch Window .............................................................................................................. 28

      Batch Sequence .................................................................................................................. 28

      Batch Sequence Toolbar ................................................................................................... 28

      Batch Sequence Context Menu .......................................................................................... 29

   3.3.3 Recipe List Window ..................................................................................................... 29

      Recipes Toolbar .................................................................................................................. 30

      Recipe Context Menu ........................................................................................................ 31

   3.3.4 Recipe Window ............................................................................................................ 32

      Recipe Properties ............................................................................................................... 32

      Recipe Scheduling Information .......................................................................................... 33

      Incomplete Recipe .............................................................................................................. 33

      Recipe Procedures .............................................................................................................. 33

      Procedures Toolbar ............................................................................................................ 33

      Procedures Context Menu ................................................................................................. 34
3.3.5 Section Window .......................................................... 35

3.3.6 Procedure Window ....................................................... 35
  Procedure Properties ....................................................... 35
  Operation Sequence ......................................................... 36
  Operation Sequence Toolbar .............................................. 36
  Operation Sequence Context Menu .................................... 37

3.3.7 Materials List Window ................................................ 37
  Materials List ............................................................... 38
  Materials Toolbar ........................................................... 38
  Materials Context Menu .................................................. 39

3.3.8 Facilities List Window .................................................. 40
  Facilities List .............................................................. 40
  Facilities Toolbar .......................................................... 40
  Facilities Context Menu ................................................... 41

3.3.9 Labor Window ............................................................ 41
  Labor List ................................................................. 41
  Labor Toolbar .............................................................. 41
  Labor Context Menu ........................................................ 42

3.3.10 Staff Window ............................................................. 43
  Staff Toolbar ............................................................... 43
  Staff Context Menu ......................................................... 43

3.3.11 Utilities Window ........................................................... 44
  Utilities List ............................................................... 44
  Utilities Toolbar ............................................................ 44
  Utilities Context Menu ..................................................... 44

3.3.12 Equipment (Work Area / Transfer Panel) Window .............. 45
  Equipment List ............................................................ 45
  Equipment Toolbar .......................................................... 45
  Equipment Context Menu ................................................ 46

3.3.13 Storage Unit/Material Supply System Window .................... 47
Storage Unit List .................................................................................................................. 47
Storage Unit Toolbar ......................................................................................................... 47
Storage Unit Context Menu .............................................................................................. 48
3.3.14 Campaign Entry Window ....................................................................................... 48
Scheduled Campaign Properties ...................................................................................... 49
Scheduled Batches List ...................................................................................................... 49
Scheduled Batches Toolbar .............................................................................................. 49
Scheduled Batches Context Menu ..................................................................................... 49
3.3.15 Batch Entry Window .............................................................................................. 50
Scheduled Batch Properties .............................................................................................. 51
Scheduled Procedures List ............................................................................................... 51
Scheduled Procedures Toolbar .......................................................................................... 51
Scheduled Procedures Context Menu ................................................................................ 52
3.3.16 Scheduled Procedure Entry Window ....................................................................... 52
Scheduled Procedure Properties ....................................................................................... 52
Operation Sequence .......................................................................................................... 52
Operation Sequence Toolbar ............................................................................................. 53
Operation Sequence Context Menu ................................................................................... 53
3.4 SchedulePro Main Menu ............................................................................................ 53
3.4.1 File Menu Item ........................................................................................................ 53
3.4.2 Edit Menu Item ........................................................................................................ 54
3.4.3 Recipe Menu Item .................................................................................................... 55
3.4.4 Resources Menu Item .............................................................................................. 55
3.4.5 Schedule Menu Item ............................................................................................... 56
3.4.6 View Menu Item ...................................................................................................... 57
3.4.7 Reports Menu Item .................................................................................................. 58
3.4.8 Connectivity Menu Item .......................................................................................... 59
3.4.9 Window Menu Item ................................................................................................. 60
3.1 Interface Concepts

SchedulePro is a Windows-based application that makes use of standard Windows components.

3.1.1 The SchedulePro Document

Your SchedulePro project begins with an empty SchedulePro document. SchedulePro creates a new empty document when it launches. You may also create a document by selecting “File/New” from the main menu. SchedulePro saves all the information for the project in a SchedulePro file. SchedulePro files have the extension SCP. SchedulePro allows you to work on multiple documents at once.

You may open a SchedulePro document by:

- Using the File/Open menu in SchedulePro
- Double-clicking on the document
- Dragging and dropping the document to the SchedulePro window
- Using the “Recently Opened” feature in the Windows Start Menu (Windows 7+)

3.1.2 Navigation

Working with SchedulePro entails adding, deleting and modifying various elements or objects including recipes, procedures, operations, equipment etc. Because it would be impractical to display all of a single project’s elements, SchedulePro displays only a few at a time but provides a convenient means of navigating to the desired item. The navigation tree, described in 3.2, displays a structure that reflects the organization of the SchedulePro project.

As a rule, all elements that contain sub-elements, for example unit procedures contain operations, are displayed in the navigation tree. Elements that do not contain sub-elements are listed in a window on the right-hand side. For example, unit procedures are displayed in the tree. Selecting a unit-procedure will cause the right-hand window to display a list of the operations in the procedure.

3.1.3 Context (Right-Click) Menus

Context menus are pop-up menus that appear when the user right-clicks on an element in the interface. The choices in the menu depend on the element that was selected. Most additions, deletions and editing may be done through context menus.

3.1.4 Toolbar Buttons

Main Toolbar

The main SchedulePro Toolbar has the following buttons:
- Create a new SchedulePro project.
- Open an existing SchedulePro document.
- Close an open SchedulePro document.
- Save the current SchedulePro document.
- Cut the selected object to the clipboard.
- Copy the selected object to the clipboard.
- Paste an object from the clipboard.
- Print. There is not general print. Printing should be done from charts or reports.
- Schedule all unscheduled campaigns.
- Unschedule all scheduled campaigns (delete all batches).
- Resolve conflicts.
- Display the Equipment Occupancy chart.
- Display the Schedule Gantt chart.
- Edit the schedule start and current time settings.
  - Select the scheduling mode.
- Edit the selected scheduling mode.
- Launch the help facility.

Many of SchedulePro’s windows and dialogs have a toolbar. Some of the most common buttons are listed below:

- Edit the properties of the selected object.
- Create a new item. This tool appears when order is not important.
- Create a new item and add it at the end of the list.
- Create a new item and insert it in the list above the currently selected item.
- Move the selected item one place nearer to the top of the list.
- Move the selected item one place nearer to the bottom of the list.
- Move the selected item to the top of the list.
- Move the selected item to the bottom of the list.
- Delete the selected item.
- Delete all items from the list.

Most buttons and controls will display a tooltip or short description, if you move the mouse over them.

3.2 SchedulePro Navigation Tree
SchedulePro uses an “Explorer” style navigation to view recipes, resources and schedules. In general, when an object is selected in the tree, the right-hand pane(s) will show the basic properties of the selected object along with a list of its sub-objects.

There are two main “window panes”. The pane on the left contains the explorer. This is a map of all the items in the project. The large window on the right hand side displays details of the item selected in the tree at the left. Each item in the tree has a “context” or “right-click” menu.

If an item in the tree is preceded by a plus (+) sign, then the item may be expanded by clicking on the plus sign. If an item is preceded by a minus (-) sign, then the item may be rolled-up, so that all its sub-items are hidden.

Selecting either the top-level item or the Production Schedule item will display the main scheduling screen.

Selecting an item on the Navigation Tree brings up the appropriate SchedulePro Window.

Note: Certain tree levels may be optionally displayed or hidden. Use the “Edit/Preferences…” option from the main menu to select whether recipe branches or sections are to be shown.
3.3 SchedulePro Windows

The right pane in SchedulePro is automatically updated based on the selection made on the left pane (Navigation Tree).

Many of the right-side windows are grid views in which the contents are displayed in tabular form. The column widths may be adjusted by dragging and dropping the headers. The widths are saved with the document.

3.3.1 Campaign Window

The Campaign Window is displayed when the SchedulePro Project node or the Production Schedule node is selected on the Navigation.

Scheduler Settings

The following information is present on the Scheduler pane of the Campaign Window.

Start Date and Time

The scheduling start date and time. This is the earliest time that SchedulePro can represent. All activities should be scheduled after this time.

Scheduling Horizon

The scheduling horizon duration and time units. The scheduling horizon is used as a default maximum time for entering repeated events, e.g. weekends.
Schedule Start
The start date and time for the scheduling project.

Schedule End
The end date and time of the latest scheduled batch.

Current Time
The SchedulePro current time set by the user.

Display Calendar Times
Check to display absolute (calendar) times.

Display Relative Times
Check to display relative times in the selected units.

Edit Schedule Timing
This brings up the “Scheduler Timing” dialog containing two tabs. From the Scheduling Horizon tab the Start Date and Time and the Scheduling Horizon can be modified. From the Current Time tab the current time can be set. By clicking on the Set to Computer Clock button the SchedulePro current time can be set to the system time.

Campaign Sequence
The Campaign Sequence displays a list of all scheduled or unscheduled campaigns in the active SchedulePro project, and a summary of their most important properties.

Campaign Sequence Toolbar
The Campaign Sequence can be modified from the Campaign Sequence Toolbar. The following operations on campaigns are available.

Edit Campaign
Edit the properties of the selected campaign.

Add New Campaign
Add a new campaign at the bottom of the list.

Insert New Campaign
Insert a new campaign before the selected one.

Promote Campaign
Move the selected campaign one position up on the list. This gives the campaign a higher priority for claiming resources.

Demote Campaign
Move the selected campaign one position down on the list. This gives the campaign a lower priority for claiming resources.

Move to Top
Move the selected campaign to the top of the list. This gives the campaign maximum priority for claiming resources.
Move to End
Move the selected campaign to the bottom of the list. This gives the campaign minimum priority for claiming resources.

Delete Campaign
Delete the selected campaign.

Delete All Campaigns
Delete all campaigns in the production schedule.

Schedule Campaign
Schedule the selected campaign.

Unschedule Campaign
This unschedules the selected campaign by deleting all its batches.

View Conflicts
Display a list of all the conflicts for the selected campaign.

Resolve Conflicts in Campaign
Resolve conflicts in the selected campaign.

Campaign Sequence Context Menu
The Campaign Sequence can also be modified from a context menu. The following operations on campaigns are available.

Properties…
Edit the properties of the selected campaign.

Note: Some campaign properties may only be modified before the campaign is scheduled.

Lock
Lock all batches owned by the selected campaign. Locked batches may not be changed by the user or by the scheduling algorithm.

Schedule
Schedule the selected campaign.

Unschedule
Unschedule the selected campaign.

Reschedule
Reschedule the selected campaign (unschedule and then schedule again)

Insert Campaign Before…
Create a new campaign and insert it before the selected campaign.

Insert Campaign After…
Create a new campaign and insert it after the selected campaign.

Promote
Move the selected campaign one position up in the list.
### Interface

**Demote**
Move the selected campaign one position down in the list.

**Delete**
Delete the selected campaign.

**Export to Database**
Exports the selected campaign to the SQL Server database.

**Table Contents**
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table. The copy option copies only the text in the table.

### 3.3.2 Batch Window

The Batch Window or Batch List is displayed below the Campaign Window when the SchedulePro Project node or Production Schedule node is selected on the Navigation Tree. The Batch Window displays the Batch Sequence. The Batch Sequence can be modified from the Batch Sequence Toolbar or the Batch Sequence Context Menu.

**Batch Sequence**
The Batch Sequence displays a list of all scheduled batches in the active SchedulePro project, and summarizes their key properties.

**Batch Sequence Toolbar**
The Batch Sequence can be modified from the Batch Sequence Toolbar. The following operations on batches are available.

- **Edit Batch**
  Edit the properties of the selected batch.

- **Add New Batch**
  Add a new batch at the bottom of the list.

- **Insert New Batch**
  Insert a new batch before the selected one.

- **Delete Batch**
  Delete the selected batch.

- **Resolve Conflicts**
  Resolve all conflicts in the selected batch.

- **View Conflicts**
  Display a list of all the conflicts for the selected batch.
Batch Color Option
Change how the batch color is displayed in the table.

Batch Sequence Context Menu
The Batch Sequence can also be modified from a context menu. The following operations on batches are available.

Properties…
Edit the properties of the selected batch.

Lock
Lock the selected batch. Locked batches may not be changed by the user or by the scheduling algorithm.

Recalculate Conflicts
Recalculate conflicts for the selected batch.

Conflict View…
Show conflicts with other batches.

Resolve Conflicts
Resolve conflicts for the selected batch.

Reschedule
Reschedule the selected batch.

Insert Batch Before
Insert a new batch of the same campaign before the selected one.

Insert Batch After
Insert a new batch of the same campaign after the selected one.

Delete
Delete the selected batch.

Copy Timing
Copy the timing and resource assignments of the selected batch. Includes user edits.

Paste Timing
Transfer the relative timing previously copied and the resource assignments to the selected batch.

Copy Timing to Recipe
Copy user-defined timing changes in the batch back to the recipe.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.3 Recipe List Window
The Recipe List Window is displayed when the SchedulePro Recipes node is selected on the Navigation Tree.
The Recipes list can be modified from the Recipes Toolbar, or via the Recipes Context Menu.

Recipes List

The recipes list summarizes all available recipes in the active SchedulePro project and their basic properties.

Recipes Toolbar

The Recipes list can be modified from the Recipes Toolbar. The following operations on recipes are available.

- **Import Recipe from DB**
  Import a recipe from the Recipes Database and add it to the list.

- **Create New Recipe**
  Add a new recipe to the bottom of the list.

- **Delete Recipe**
  Delete the selected recipe.

- **Edit Recipe**
  Edit the properties of the selected recipe.

- **Show Recipe Gantt chart**
  Display the Gantt chart for the selected recipe.

- **Promote Recipe**
  Move the selected recipe one position up in the list. This affects only the display of the recipe.

- **Demote Recipe**
  Move the selected recipe one position down in the list. This affects only the display of the recipe.

- **Move to Top**
  Move the selected recipe to the top.

- **Move to Bottom**
  Move the selected recipe to the bottom.

- **Cut Recipe**
  Cut the selected recipe.
Copy Recipe
Copy the selected recipe.

Paste Recipe
Paste the selected recipe to the bottom of the list.

Find Recipe
Finds a given recipe.

Sort Ascending
Put the recipes in alphabetical order.

Sort Descending
Put the recipes in reverse alphabetical order.

Recipe Context Menu
The Recipe list can also be modified from a context menu. The following operations on recipes are available:

Properties…
Edit the properties of the selected recipe.

Gantt Chart…
View a Gantt chart of the selected recipe.

Set Flex-shits (breaks)…
Set flexible time shifts for the selected recipe.

Edit Labor Requirements…
Set/modify labor requirements for the selected recipe.

Scale Recipe…
Modify the batch size of the selected recipe.

Update Cycle Time Estimate
Update a cycle time estimate of the selected recipe.

Check Recipe…
Check the selected recipe for incomplete data, missing specifications, etc.

Cut
Cut the selected recipe and place it on the clipboard.

Copy
Delete the selected recipe to the clipboard.

Paste
Paste the selected utility (appears only when a recipe has been copied or cut).

Delete
Delete the selected recipe.
Write Back to Recipe DB
Write the selected recipe to the Recipe DB.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.4 Recipe Window
The Recipe window is displayed when a SchedulePro individual recipe node is selected on the Navigation Tree.

The Recipe window displays basic recipe properties, scheduling information, and a list of procedures in the recipe. The Procedures list can be modified from the Procedures Toolbar, or via the Procedures Context Menu.

Recipe Properties
A number of basic recipe properties can be viewed or modified from the Recipe window.

Name
View the recipe name. Use “Edit Recipe Data” to modify.

Description
View the recipe description. The description is optional and may be left empty. Use “Edit Recipe Data” to modify.

Batch Size
View the recipe batch size in the selected units. Use “Scale Recipe” to modify.

Edit Recipe Data
Modify the recipe name, description, and batch size properties.
Chart Color
View/modify the current recipe color on the equipment occupancy chart.

Gantt Chart
View the recipe Gantt chart

Edit Labor
Edit labor requirements for the recipe.

Set Operation Types
Set the operation type for all the operations in the recipe. Operation types must be previously defined.

Show Recipe Overview
Display a tabular overview of the recipe’s procedures.

Scale Recipe
Modify the recipe batch size.

Edit Streams
Edit all the streams in the recipe.

Recipe Scheduling Information
Basic scheduling information is shown on the Recipe window.

Estimated Batch Time
View an estimate of the recipe duration (one batch) in the selected time units.

Estimated Cycle Time
View an estimate of the recipe cycle time in the selected time units.

Bottleneck
View the current bottleneck procedure. This is an estimated bottleneck that is determined by longest, most equipment-limited procedure.

Incomplete Recipe
If a recipe cannot be scheduled, the “Incomplete Recipe” button is displayed. Normally this is not visible for a completed recipe. Click on the button to display a description of the problem.

Recipe Procedures
The Procedures list displays all procedures in the selected SchedulePro recipe and summarizes their main properties.

Procedures Toolbar
The Procedures list can be modified from the Procedures Toolbar. The following operations on procedures are available.

Add New Procedure
Add a new procedure to the bottom of the list.
**Insert New Procedure**
Insert a new procedure before the currently selected procedure.

**Delete Procedure**
delete the selected procedure.

**Edit Procedure**
Edit the properties of the selected procedure.

**Promote Procedure**
Move the selected procedure one position up in the list.

**Demote Procedure**
Move the selected procedure one position down in the list.

**Move to Top**
Move the selected procedure to the top.

**Move to Bottom**
Move the selected procedure to the bottom.

**Cut Procedure**
Cut the selected procedure.

**Copy Procedure**
Copy the selected procedure.

**Paste Procedure**
Paste the selected procedure to the bottom of the list.

**Procedures Context Menu**
The Procedures List can also be modified from a context menu. The following operations on procedures are available.

**Properties…**
Edit the properties of the selected procedure.

**Delete**
delete the selected procedure.

**Cut**
Cut the selected procedure.

**Copy**
delete the selected procedure.

**Paste**
Paste the selected utility (available only if a procedure has been cut or copied).
Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.5 Section Window
The Section Window is shown when a SchedulePro section node is selected on the Navigation Tree and the option to show sections on the Navigation Tree is selected (to set this option, select item "Edit/Preferences..." on the main SchedulePro menu).

The Section Window displays basic section properties and a Procedures list for the recipe. The Procedures list can be modified from the Procedures Toolbar, or via the Procedures Context Menu. Use the edit button to edit the section properties.

The Procedure list uses the procedure toolbar described in the previous section.

3.3.6 Procedure Window
The Procedure Window is displayed when a SchedulePro procedure node is selected on the Navigation Tree.

The Procedure Window displays basic procedure information and the procedure’s Operation Sequence. The Operation Sequence can be modified from the Operation Sequence Toolbar, or via the Operation Sequence Context Menu. Use the edit button to edit the procedure properties.

Procedure Properties
A number of unit procedure properties are displayed on the Procedure Window.

Name
The procedure name.

In Recipe
The procedure’s recipe
Interface

Description
The procedure description; this field is optional and may be empty.

Work Area
The work area (if any) that is assigned to the procedure.

Procedure Size
The procedure’s scaling size (if any).

Equipment
Displays the main equipment item for the procedure. If the procedure has a pool of equipment, then the top-priority equipment is followed by an ellipsis (…).

No. of Cycles
The procedure number of cycles in the procedure.

Operation Sequence
The Operation Sequence displays a list of all operations in the procedure, and summarizes their important properties.

Operation Sequence Toolbar
The Operation Sequence can be modified from the Operation Sequence Toolbar. The following actions on operations are available:

Add New Operation
Add a new operation to the bottom of the list.

Insert New Operation
Insert a new operation before the currently selected operation.

Delete Operation
Delete the selected operation.

Edit Operation
Edit the properties of the selected operation.

Promote Operation
Move the selected operation one position up in the list. Note: promoting or demoting operations automatically changes the scheduling to be sequential.

Demote Operation
Move the selected operation one position down in the list.

Move to Top
Move the selected operation to the top.

Move to Bottom
Move the selected operation to the bottom.

Cut Operation
Cut the selected operation.
Copy Operation
Copy the selected operation.

Paste Operation
Paste the cut or copied operation below the selected operation. Note: pasting an operation does not change scheduling links.

Operation Sequence Context Menu
The Operation Sequence can also be modified from a context menu. The following actions on operations are available:

Properties…
Edit the properties of the selected operation.

Scheduling Info…
Set/modify scheduling information for the selected operation.

Resources…
View/modify resource details for the selected operation.

Delete
Delete the selected operation.

Cut
Cut the selected operation.

Copy
Copy the selected operation.

Paste
Paste the selected utility.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

Links
Display a tree diagram of the operations that depend on the selected operation.

3.3.7 Materials List Window
The Materials List Window is displayed when SchedulePro Materials node is selected on the Navigation Tree.
The Materials List Window displays the list of materials in the active SchedulePro project. The Materials list can be modified from the Materials Toolbar, or via the Materials Context Menu.

**Materials List**

The Materials list displays all SchedulePro materials (in alphabetical order) and summarizes some of their important properties. The list can be customized to display Bulk or Discrete materials only.

**Materials Toolbar**

The Materials list can be modified from the Materials Toolbar. The following operations on materials are available.

- **Create New Material**
  Add a new material to the list.

- **Delete Material Button**
  Delete the selected material.

- **Edit Material**
  Edit the properties of the selected material.

- **Used By**
  Display the “Used By” dialog that shows the usages of the selected material.
Cut Material
Cut the selected material.

Copy Material
Copy the selected material.

Paste Material
Paste the selected material to the list.

Materials Context Menu
The Materials list can also be modified from a context menu. The following operations on materials are available.

Properties…
Edit the properties of the selected material.

Used by…
View a list of streams making use of the selected material.

Delete
Delete the selected material.

Cut
Cut the selected material.

Copy
Copy the selected material.

Paste
Paste the selected utility.
**Table Contents**
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

### 3.3.8 Facilities List Window
The Facilities List window is shown when SchedulePro Facilities node is selected on the Navigation Tree.

The Facilities List window displays a list of facilities in the active SchedulePro project. The Facilities list can be modified from the Facilities Toolbar, or via the Facilities Context Menu.

**Facilities List**
The Facilities list displays all facilities (in alphabetical order) and the following key information:

- **Has outages**: Whether there is any scheduled downtime for the facility.
- **Has suites**: Whether there are any suites defined for the facility.
- **Location**: Optional information about the facility location.
- **Description**: Optional description.

**Facilities Toolbar**
The Facilities list can be modified from the Facilities Toolbar. The following operations on facilities are available.

- ![Create New Facility](image) **Create New Facility**
  Add a new facility to the list.

- ![Delete Facility Button](image) **Delete Facility Button**
  Delete the selected facility.

- ![Edit Facility](image) **Edit Facility**
  Edit the properties of the selected facility.

- ![Facility Outages](image) **Facility Outages**
  Edit facility downtimes for the selected facility.

- ![Facility Suites](image) **Facility Suites**
  Edit the facility’s suite information.

- ![Promote Facility](image) **Promote Facility**
  Move the selected facility one position up in the list. This affects display only.

- ![Demote Facility](image) **Demote Facility**
  Move the selected facility one position down in the list. This affects display only.

- ![Cut Facility](image) **Cut Facility**
  Cut the selected facility.
Copy Facility
Copy the selected facility.

Paste Facility
Paste the selected facility to the list.

Facilities Context Menu
The Facilities list can also be modified from a context menu. The following operations on facilities are available.

Properties…
Edit the properties of the selected facility.

Outages…
View/modify downtimes for the selected facility.

Suites…
View/modify suite information for the facility.

Delete
Delete the selected facility.

Write to Database
Update the Recipe DB with the modified facility.

Cut
Cut the selected facility.

Copy
Delete the selected facility.

Paste
Paste the selected utility.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table. Text only is copied.

3.3.9 Labor Window
The Labor Window is displayed when the SchedulePro Labor node is selected on the Navigation Tree.

The Labor Window displays a list of labor items in the active SchedulePro project. The list can be modified from the Labor Toolbar, or via the Labor Context Menu.

Labor List
The Labor list displays all labor items (in alphabetical order) and a summary of their properties.

Labor Toolbar
The Labor list can be modified from the Labor Toolbar. The following operations on labor are available:

Create New Labor
Add a new labor item to the list.
Delete Labor
Delete the selected labor item.

Edit Labor
Edit the properties of the selected labor item.

Used By
Display the operations that use the labor item.

View Labor Profile
Display the labor demand as a function of time for the selected labor resource.

Labor Outages
Edit labor item downtimes for the selected labor item.

Cut Labor
Cut the selected labor item.

Copy Labor
Copy the selected labor item.

Paste Labor
Paste the selected labor item to the list.

Labor Context Menu
The Labor list can also be modified from a context menu. The following operations on labor items are available

Properties…
Edit the properties of the selected labor item.

Used By…
View a list of operations/procedures making use of the selected labor item.

Show Profile
Display the labor demand as a function of time for the selected labor resource.

Delete
Delete the selected labor item.

Cut
Cut the selected labor item.

Copy
Delete the selected labor item.

Paste
Paste the selected utility.
Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.10 Staff Window
The staff resources window displays the staff list.

Staff Toolbar

Create New Staff Resource
Add a new staff resource item to the list.

Delete Staff Resource
Delete the selected staff resource item.

Edit Staff Resource
Edit the properties of the selected staff resource item.

Used By
Display the operations that use the staff resource item.

Staff Resource Outages
Edit availability periods for the selected staff resource item.

Cut Staff Resource
Cut the selected staff resource item.

Copy Staff Resource
Copy the selected staff resource item.

Paste Staff Resource
Paste the selected staff resource item to the list.

Staff Context Menu

Properties…
Edit the properties of the selected staff resource item.

Used By…
Display the operations that use the staff resource item.

Move To…
Move the staff resource to a different facility.

Delete
Delete the selected staff resource item.

Cut
Cut the selected staff resource item to the clip board.

Copy
Copy the selected staff resource item.
**Paste**
Paste the selected utility.

**Table Contents**
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

### 3.3.11 Utilities Window
The Utilities window is shown when the SchedulePro Utilities node is selected on the Navigation Tree.

The Utilities Window displays a list of utilities under a particular facility in the active SchedulePro project. The list can be modified from the Utilities Toolbar, or via the Utilities Context Menu.

**Utilities List**
The Utilities list displays all utilities under a facility (in alphabetical order) and a summary of their properties.

**Utilities Toolbar**
The Utilities list can be modified from the Utilities Toolbar. The following operations on utilities are available.

- **Create New Utility**
  Add a new utility to the list.

- **Delete Utility**
  Delete the selected utility.

- **Edit Utility**
  Edit the properties of the selected utility.

- **Used By**
  Display the operations that use the selected utility.

- **View Utility Profile**
  Display the utility demand as a function of time for the selected labor resource.

- **Cut Utility**
  Cut the selected utility.

- **Copy Utility**
  Copy the selected utility.

- **Paste Utility**
  Paste the selected utility to the list.

**Utilities Context Menu**
The Utilities list can also be modified from a context menu. The following operations on utilities are available.
Properties…
Edit the properties of the selected utility.

Used By…
View a list of operations/procedures making use of the selected utility.

Delete
Delete the selected utility.

Cut
Cut the selected utility.

Copy
Delete the selected utility.

Paste
Paste the selected utility.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.12 Equipment (Work Area / Transfer Panel) Window
The Equipment window is shown when the SchedulePro Equipment node is selected on the Navigation Tree. The Work Area and Transfer Panel windows have the same features although the columns differ for each resource.

The Equipment Window displays a list of equipment items under a facility in the active SchedulePro project. The list can be modified from the Equipment Toolbar, or via the Equipment Context Menu.

Equipment List
The Equipment list displays all equipment items under a facility (in alphabetical order) and a summary of their important properties.

![Equipment Window](image)

Equipment Toolbar
The Equipment list can be modified from the Equipment Toolbar. The following operations on equipment items are available.
Add New Equipment
Add a new equipment item to the list.

Delete Equipment
Delete the selected equipment item.

Edit Equipment
Edit the properties of the selected equipment item.

Used By
Display the procedures and operations that use the selected equipment item.

Equipment Outages
Edit equipment item downtimes for the selected equipment item.

Cut Equipment
Cut the selected equipment item.

Copy Equipment
Copy the selected equipment item.

Paste Equipment
Paste the selected equipment item to the list.

Sort Ascending
Put the equipment in alphabetical order.

Sort Descending
Put the equipment in reverse alphabetical order.

Equipment Context Menu
The Equipment list can also be modified from a context menu. The following operations on equipment items are available.

Properties…
Edit the properties of the selected equipment item.

Used By…
View a list of procedures making use of the selected equipment item.

Cut
Cut the selected equipment item.

Copy
Delete the selected equipment item.

Delete
Delete the selected equipment item.
**Paste**  
Paste the selected equipment item. This item only appears when equipment has been cut or pasted on to the clipboard.

**Table Contents**  
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

### 3.3.13 Storage Unit/Material Supply System Window
The Storage Unit window is displayed when the SchedulePro Storage node is selected on the Navigation Tree.

Material supply systems are special storage units that handle specific materials. The interface is the same for both.

![Storage Unit Window](image)

The Storage Unit Window displays a list of storage units under a facility in the active SchedulePro project. The list can be modified from the Storage Unit Toolbar, or via the Storage Unit Context Menu.

**Storage Unit List**  
The Storage Unit list displays all storage units under a facility (in alphabetical order) and a summary of their properties.

**Storage Unit Toolbar**  
The Storage Unit list can be modified from the Storage Unit Toolbar. The following operations on storage units are available:

- **Add New Storage Unit**  
  Add a new storage unit to the list.

- **Delete Storage Unit**  
  Delete the selected storage unit.

- **Edit Storage Unit**  
  Edit the properties of the selected storage unit.
Used By
View a list of streams making use of the selected storage unit.

View Inventory Profile
View the inventory profile of the storage unit if available.

Cut Storage Unit
Cut the selected storage unit.

Copy Storage Unit
Copy the selected storage unit.

Paste Storage Unit
Paste the selected storage unit to the list.

Storage Unit Context Menu
The Storage Unit list can also be modified from a context menu. The following operations on storage units are available.

Properties…
Edit the properties of the selected storage unit.

Used By…
View a list of streams making use of the selected storage unit.

Show Profile…
View the inventory profile of the storage unit if available.

Delete
Delete the selected storage unit.

Cut
Cut the selected storage unit.

Copy
Delete the selected storage unit.

Paste
Paste the selected storage unit. Displays only when a storage unit has been copied or cut.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.14 Campaign Entry Window
The Campaign Entry Window is displayed when a scheduled campaign node is selected on the SchedulePro Navigation Tree under Production Schedule.
The Campaign Entry Window displays basic properties of a scheduled campaign and the list of Scheduled Batches for the campaign. The list can be modified from the Scheduled Batches Toolbar, or via the Scheduled Batches Context Menu.

**Scheduled Campaign Properties**

A number of important campaign properties are shown on the Campaign Entry Window. These include the campaign and recipe names, the campaign size in the selected units, the start and end time of campaign execution, etc.

**Scheduled Batches List**

The Scheduled Batches list displays all scheduled batches for the selected campaign and a summary of their properties.

**Scheduled Batches Toolbar**

The Scheduled Batches list can be modified from the Scheduled Batches Toolbar. The following operations on batches are available.

- **Edit Batch**
  View/edit the properties of the selected batch.

- **Add New Batch**
  Add a new batch at the end of the list.

- **Insert New Batch**
  Insert a new batch in the campaign before the selected one.

- **Delete Batch**
  Delete the selected batch from the campaign.

- **Resolve Batch Conflicts**
  Resolve all conflicts in the selected batch.

**Scheduled Batches Context Menu**

The Scheduled Batches list can also be modified from a context menu. The following operations on batches are available.

- **Properties…**
  Edit the properties of the selected batch.
**Lock**
Lock the selected batch.

**Recalculate Conflicts**
Recalculate conflicts for the selected batch.

**Conflict View…**
View a list of conflicts with other batches in the campaign.

**Resolve Conflicts**
Resolve conflicts for the selected batch.

**Reschedule**
Unschedule and again schedule the selected batch.

**Insert Batch Before**
Insert a new batch in the campaign before the selected one.

**Insert Batch After**
Insert a new batch in the campaign after the selected one.

**Delete**
Delete the selected batch from the campaign.

**Copy Timing**
Copy the user-defined timing modifications.

**Paste Timing**
Paste timing changes from one campaign to another (recipes must be the same).

**Copy Timing to Recipe**
Translate user-added shifts to fixed shifts in the recipe.

**Table Contents**
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

### 3.3.15 Batch Entry Window
The Batch Entry Window is displayed when a scheduled batch node is selected on the SchedulePro Navigation Tree under Production Schedule.
Scheduled Batch Properties

A number of important batch properties are shown on the Batch Entry Window. These include the batch, campaign, and recipe names, the batch size in selected units, the start and end time of batch execution, etc.

Use the edit button ( ) to view or modify properties of the scheduled batch.

The Batch Entry Window displays basic properties of a scheduled batch and the list of Scheduled Procedures for the batch. The list can be modified from the Scheduled Procedures Toolbar, or via the Scheduled Procedures Context Menu.

Scheduled Procedures List

The Scheduled Batches list displays all scheduled batches for the selected campaign and a summary of their properties.

Scheduled Procedures Toolbar

A Scheduled Procedure can be modified from the Scheduled Procedures Toolbar. The following operations on procedures are available.

Edit Procedure

View/edit the properties of the selected procedure.

View Conflicts

Display a list of all the conflicts for the selected procedure.
Scheduled Procedures Context Menu
A Scheduled Procedure can also be modified from a context menu. The following operations on procedures are available.

Properties…
View/edit the properties of the selected procedure.

Resolve Conflicts
Resolve conflicts for the selected procedure.

Delete Batch Onwards
Delete the selected and all subsequent procedures in the current batch.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.3.16 Scheduled Procedure Entry Window
The Procedure Entry Window is displayed when a scheduled procedure node is selected on the SchedulePro Navigation Tree under Production Schedule.

The Procedure Entry Window displays basic properties of a scheduled procedure and the list of Scheduled Operations for the procedure. The list can be modified from the Operation Sequence Toolbar, or via the Operation Sequence Context Menu.

Scheduled Procedure Properties
A number of important procedure properties are shown on the Procedure Entry Window. These include the procedure, batch, and campaign names, the start and end time of procedure execution, etc.

Use the edit button to view or modify properties of the scheduled procedure.

Operation Sequence
The Operation Sequence displays all scheduled operations for the selected procedure and a summary of their properties.
Operation Sequence Toolbar
A Scheduled Operation can be modified from the Operation Sequence Toolbar. The following actions on scheduled operations are available.

Edit Operation
View/edit the properties of the selected operation.

View Conflicts
Display a list of all the conflicts for the selected operation.

Operation Sequence Context Menu
A Scheduled Procedure can also be modified from a context menu. The following actions on scheduled operations are available.

Properties…
View/edit the properties of the selected operation.

Resolve Conflicts
Resolve conflicts for the selected operation.

Delete Batch Onwards
Delete the selected and all subsequent operations in the current batch.

Table Contents
The Table Contents submenu contains items that allow for copying the selected table region, copying the whole table and selecting the whole table.

3.4 SchedulePro Main Menu

3.4.1 File Menu Item
The File menu item contains entries for manipulating SchedulePro projects. The File menu item contains the Export to MS Project® entry for saving a SchedulePro project into the Microsoft Project® database format, and the Send entry for e-mailing projects to other users.

The File menu item contains the following entries.

New
Start a new SchedulePro project.

Open
Open an existing SchedulePro project.

Close
Close the current active project.

Save
Save the current SchedulePro project.

Save As
Save the current SchedulePro project under a new name.
**Print**
Print the current SchedulePro project (if available).

**Print Preview**
Display the print-preview the current SchedulePro project (if available).

**Print Setup**
Set up the printer properties.

**Send**
E-mail the current project.

**Properties**
View project information for the current SchedulePro project. SchedulePro document properties include the following:

- **Project Name** – a brief name for the file.
- **Last saved version** – the SchedulePro version used to save the file.
- **Description** – an optional description.
- **Base currency** – the currency basis.
- **Display currency** – an optional display currency.
- **Author** – the creator/owner of the file (optional).

**Prior Files**
Open previously saved files.

**Exit**
Exit SchedulePro.

### 3.4.2 Edit Menu Item
The Edit menu item contains entries for manipulating SchedulePro objects (equipment, procedures, etc.). It provides quick links for copying the selected SchedulePro object to and from the local clipboard. This functionality may not be available for all SchedulePro objects.

The Edit menu item contains the following entries.

**Cut**
Cut object from SchedulePro project and save to the local clipboard.

**Copy**
Copy object from SchedulePro project to the local clipboard.

**Paste**
Paste object from the local clipboard to SchedulePro project.

**Paste Special**
Not available.

**Delete**
Delete object from SchedulePro project.
Find
Find and navigate to objects in SchedulePro.

Physical Units Defaults
Set the default display units for common measurement values.

Preferences
Set project preferences. See section 3.7.

3.4.3 Recipe Menu Item
The Recipe menu item contains entries for creating and importing SchedulePro recipes. It provides the following entries:

Create New Recipe
Start a new recipe in the current SchedulePro project.

Import from Database
Import a recipe from the Recipes DB. Recipes created with SuperPro can be imported to a SchedulePro project.

Find
Find a recipe and select it in the tree.

Streams
Launch the recipe stream management dialog.

3.4.4 Resources Menu Item
The Resources menu item contains entries for manipulating SchedulePro resources (materials, facilities, equipment, labor, etc.). It provides quick links for adding resources to the SchedulePro project. Some functionality may not be available depending upon the type of the selected SchedulePro object.

The Resources menu item contains the following entries:

Add Material
Add a new material resource to the SchedulePro project.

Add Facility
Add a new facility to the SchedulePro project.

Delete Facility
Delete the selected facility from the SchedulePro project.
Add Labor
Add a new labor type under the selected facility.

Add Staff
Add a new staff resource to the selected facility.

Add Utility
Add a new utility item to the selected facility.

Add Equipment
Add a new equipment item to the selected facility.

Add Work Area
Add a new work area to the selected facility.

Add Transfer Panel
Add a new transfer panel resource to the selected facility.

Add Storage Unit
Add a new storage unit to the selected facility.

Add Material Supply System
Add a new material supply system to the selected facility.

3.4.5 Schedule Menu Item
The Schedule menu item contains entries for manipulating SchedulePro schedules. It provides quick links for planning campaigns and batches. It provides the following entries:

Plan a Campaign
Plan a new campaign.

Plan a One-Batch Campaign
Plan a campaign with only one batch.

Load Campaigns From File
Load campaigns from a text file that contains campaign descriptions.

Define Campaign Projects
Define projects for campaign grouping. Check “Show Campaign Projects” in the Edit/Preferences dialog.

User Defined Campaign Properties
Define extra properties for campaigns.

Operation Types
Define operation types for charting and reporting.

Recipe Types
Define recipe types for use with the change-over matrix.

Operation Report Text
Set or modify the Daily Activity Report template text.

Set Weekend Hours…
Set off hours to display on the Equipment Occupancy Chart.

Schedule All Campaigns
Schedule all planned campaigns. This action does not reschedule currently scheduled campaigns.

Reset Schedule
Delete all scheduled batches.

View all Conflicts
Display all the conflicts.

Resolve All Conflicts
Resolve all conflicts for the entire schedule.

Export All Campaigns to the Database
Deposit all campaigns in the SQLServer Database.

Scheduler Timing
Set the scheduling horizon and the current time.

Scheduling Options
Edit the options of the currently selected scheduling mode.

Scheduling Dependencies and Order
Manage campaign priorities and dependencies.

Edit Scheduling Modes
Manage the scheduling modes.

Economics
View the overall economic information for the schedule.

3.4.6 View Menu Item
The View menu item contains entries for viewing scheduling results in various chart types. It provides the following entries:

Gantt Chart
Display a Gantt chart of the schedule.

Equipment Occupancy Profile
Display an equipment-oriented Gantt chart for the schedule.

Edit Equipment Chart Style…
Modify the display options before the chart is displayed.

Equipment Time Utilization
Display an equipment time utilization bar chart for the schedule.

Resource Profiles
Display the following material consumption/production charts (rate as a function of time) for the schedule:

Raw Materials
Products
Waste
Labor
Heating/Cooling Utilities
Electric Power

**Inventory Profiles**
Display inventory profiles for storage/equipment items.

**Storage Inventory**
Display the inventory of storage units with inventory tracking

**Material Supply Inventory**
Display the inventory of material supply systems with inventory tracking

**Equipment Capacity**
Display the utilization of multitasking equipment with sizing information.

**Equipment Capacity (Material Based)**
Display the inventory of equipment associated with storage units.

**Toolbar**
Toggle toolbar display.

**Status bar**
Toggle status bar display.

**Refresh**
Update the SchedulePro Navigation View. The ctrl-r key has the same effect.

### 3.4.7 Reports Menu Item
The Reports menu item contains entries for creating and viewing various SchedulePro report types. It provides the following entries:

**Schedule Report**
Create and view the detailed schedule report (operations included).

**Equipment Occupancy Report**
Create and view the equipment occupancy data.

**Staff Occupancy Report**
Create and view the staff data.

**Equipment Utilization Table**
Create and view the equipment utilization table.

**Utilization Trend Report**
Create and view equipment utilization vs time report.

**Materials Report**
Create and view the materials report.

**Daily Activity Report**
Create and view the daily activity report.
**Economic Report**  
Create and view the economic report.

**Activities to DB Format**  
Export activities to a registered database file.

**Gantt Graph**  
Create and view an HTML version of the Gantt Chart.

**Equipment Occupancy Graph**  
Create and view the equipment occupancy graph.

**Recipe Report**  
Create and view the recipe report.

**Transfer Panels**  
Display the layout of transfer panels.

**Report Options**  
Specify common and report-specific options.

**Clipping Options**  
Limit chart or report data by time, campaign or batch.

**Contents and Ordering**  
Select and order resources for reports and charts that display multiple resources, e.g. equipment.

**Saved Options**  
Save the current clipping and reporting options in a named set.

**3.4.8 Connectivity Menu Item**  
The Databanks menu item contains entries for manipulating the Recipes DB. It provides the following entries:

**Recipe Data**  
**Edit Location**  
Enter the location of the database and any other login information.

**DB Search**  
Search the recipe database.

**MS Project Link**  
**Export to MDB File**  
Export to the MS Project Access database format. Use with MS Project 2000 or earlier versions.

**Export to XML file**  
Export to the MS Project XML format. Use with later versions of MS Project.

**ERP Link**  
**Configure Import/Export…**  
Configure the file interface.

**Import…**  
Import campaign data from a text file.
Export…
Export campaign data to a text file.

MDB Link
Configure Import/Export…
Configure the Access interface.

Import Campaign Defaults
Set defaults for imported campaigns.

Import…
Import campaign data from a database file.

Export…
Export campaign data to a database file.

SQL Server
Connection Settings
Set up the connection to the SQL Server database.

Export Schedule
Export all the scheduled campaigns to the database.

Export Document
Export all the document’s data to the database.

Stored Campaigns
View and manage the stored campaigns for the current data set.

Stored Materials
View and manage the stored materials for the current data set.

Stored Facilities
View and manage the stored facilities and associated resources for the current data set.

Stored Recipes
View and manage the stored recipes for the current data set.

Stored Snapshots
View and manage the stored snapshots for the current data set.

Database Management
View and manage all campaigns in the database.

3.4.9 Window Menu Item
The Window menu item contains a list of all open SchedulePro windows. By clicking on an entry the corresponding window is brought on top. A check mark appears in front of the currently active window.

3.4.10 Help Menu Item
The Help menu item provides the following standard entries:

Help Topics
Launch SchedulePro online help facility.
About SchedulePro
View SchedulePro version information.

3.5 Standard Toolbar Buttons
These buttons provide standard functionality.

- **New Button**
  Create a new SchedulePro project. This is equivalent to the “File->New” menu item.

- **Open Button**
  Open an existing SchedulePro project. This is equivalent to the “File->Open…” menu item.

- **Save Button**
  Save the current SchedulePro project. Equivalent to the “File->Save” menu item.

- **Cut Button**
  Cut the selected SchedulePro object and copy it to the local clipboard.

- **Copy Button**
  Copy the selected SchedulePro object to the local clipboard.

- **Paste Button**
  Paste an object from the local clipboard into the current SchedulePro project.

- **Print Button**
  This performs the print function if the currently selected object or view is printable.

- **About Button**
  View standard application information.

3.6 Scheduling Toolbar Buttons
These buttons provide commonly used scheduling functionality:

- **Schedule**
  Schedule all planned campaigns. This is equivalent to the “Schedule->Schedule All Campaigns” menu item.

- **Reset**
  Reset the current schedule. This is equivalent to the “Schedule->Reset Schedule” menu item.

- **Resolve Conflicts**
  Resolve all conflicts for the entire schedule. This is equivalent to the “Schedule->Resolve All Conflicts” menu item.

- **View Equipment Chart Button**
  Display the equipment occupancy chart view of the scheduled batches

- **View Gantt Chart**
  Display the operations Gantt chart for the scheduled batches
Edit Scheduler Timing
Set the scheduling horizon and the current time.

Scheduling Mode Menu
Select a scheduling mode or edit the available scheduling modes.

3.7 Interface Options

3.7.1 Physical Units Defaults
Use the “Edit→Physical Units Defaults…” item to set the default display units for various measurements. These defaults may be overridden for specific items.

![Physical Units Options](image)

For existing files, use the checkboxes to apply the new defaults to existing SchedulePro objects.

3.7.2 General Preferences
Use the “Edit→Preferences…” item in the main menu to set the following interface and display options for the project:

Display Recipe Branches in Tree – if selected, display recipe branch nodes.
Display Recipe Sections in Tree – if selected, display recipe section nodes.
Display Default Equipment – if selected, display default equipment with the procedure names in the tree.
Show Campaign Projects – if selected, the project level of campaign organization becomes available.

Default Time Display – Select calendar (absolute) time or relative time or both.

Report Viewer – Select the web browser used to view reports.

Autosave Settings – Set the auto backup and save settings.

Temporary Directory – A read/write location for temporary files. No user-readable data is saved here.
# Chapter 4: Tutorial

4.1 Introduction ................................................................................................................. 66

4.2 Tutorial Structure ......................................................................................................... 68

4.3 The Tutorials .................................................................................................................. 69

  Tutorial-1a: Creating and Scheduling a Simple Recipe .................................................... 69
    Adding the Facility and its Resources ............................................................................. 70
    Creating the Recipe .......................................................................................................... 71
    Planning and Scheduling Campaigns ............................................................................. 82
    Visualizing the Production Schedule ............................................................................. 86
  Tutorial-1b: Impact of Equipment Pools .......................................................................... 88
  Tutorial-1c: Scheduling with Flexible Shifts ..................................................................... 90
  Tutorial-2a: Multiple Recipes and Equipment Routing .................................................... 93
  Tutorial-2b: Considering Changeover Times .................................................................... 96
  Tutorial-3a: Drag & Drop Schedule Adjustments ............................................................. 99
  Tutorial-3b: Representing Process Delays ....................................................................... 101
  Tutorial-4a: Resource Tracking ......................................................................................... 105
  Tutorial-4b: Inventory Tracking ....................................................................................... 113
  Tutorial-5: Debottlenecking Production Lines ................................................................. 118
  Tutorial-6a: Scheduling with Facility Downtimes ............................................................ 121
  Tutorial 6b: Interruptible Operations ............................................................................. 124
  Tutorial-7: Scaling Recipes and Campaigns .................................................................... 126
4.1 Introduction
This document will guide you through the steps of creating a production schedule with SchedulePro. We start with simple concepts and incrementally introduce more advanced features and capabilities of the tool.

Through a step-by-step process that you can follow as you move along, you will learn how to:

- Declare a facility and its resources.
- Define a recipe with procedures and operations.
- Declare and schedule a campaign.
- Retrieve the scheduling results in the form of Gantt, equipment and resource utilization charts.
- Include facility and equipment downtimes and operation flexible time shifts and investigate their effect on scheduling.
- Declare material usage and generation and track their profiles and inventories.
- Identify and eliminate bottlenecks.
- Scale recipes and investigate their impact on equipment selection and duration of operations.

The tutorial will make use of a simplified version of a batch recipe for the production of a saline solution (for medical applications). The recipe (process) as modeled in SuperPro Designer™ is shown below. The SuperPro case file (Saline-Solution-Recipe.spf) is included in the tutorial directory.

The simplified recipe includes three procedures (processing steps): (a) preparing the solution in a mixing tank, (b) storing the solution in a storage tank and (c) putting the solution in plastic bags using a filling machine.

The following table lists the operations that are included in each of the three procedures along with their duration and information on their relative ordering. The saline solution is prepared from three basic ingredients: water-for-injection (WFI), Sodium Chloride, and API (an Active Pharmaceutical Ingredient).

The recipe will be executed in a facility called “Medical Solutions Plant”. The facility is equipped with a mixing tank (MT-1), a storage tank (ST-101) and a bag filler (Filler-1). Also, a clean-in-place skid (CIP-Skid-1) is available for cleaning the equipment.
<table>
<thead>
<tr>
<th>Procedure</th>
<th>Equipment</th>
<th>Operation</th>
<th>Start Time Relation</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Prepare Solution</td>
<td>MT-1</td>
<td>Charge Water</td>
<td>Batch start</td>
<td>30 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Charge Sodium Chloride</td>
<td>At the end of its previous operation</td>
<td>15 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Charge API</td>
<td>At the end of its previous operation</td>
<td>15 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Mix Thoroughly</td>
<td>At the end of its previous operation</td>
<td>60 min</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Transfer to Storage Tank</td>
<td>At the end of its previous operation</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>30 min</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clean Tank</td>
<td>At the end of its previous operation</td>
<td>90 min</td>
</tr>
<tr>
<td>P-2</td>
<td>ST-101</td>
<td>Receive from Mixing Tank</td>
<td>When “Transfer to Storage …” in P-1 starts</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Feed Filler</td>
<td>10 min after start of its previous operation</td>
<td>Equal to “Fill Bags” in P-3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Clean Tank</td>
<td>At the end of its previous operation</td>
<td>90 min</td>
</tr>
<tr>
<td>P-3</td>
<td>Fill</td>
<td>Filler-1</td>
<td>Fill Bags</td>
<td>When “Feed Filler” in P-2 starts</td>
</tr>
<tr>
<td>-----</td>
<td>------</td>
<td>----------</td>
<td>-----------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Clean Filler</td>
<td>At the end of its previous operation</td>
</tr>
</tbody>
</table>

### 4.2 Tutorial Structure
The tutorial is based on the following incremental structure. Each section is accompanied by a SchedulePro case file that you can open and explore at any time (the names of the SchedulePro files are identical to the tutorial case names). You may also create the same files on your own to solidify your understanding of the tool.

- **Tutorial-1a**  
  Creating and Scheduling a Simple Recipe
  Demonstrates most basic features of SchedulePro. Provides a quick start guide for beginner users who wish to schedule their first case and view scheduling results.

- **Tutorial-1b**  
  Considering the Impact of Equipment Pools
  Demonstrates the impact of equipment pools on cycle time and plant throughput.

- **Tutorial-1c**  
  Scheduling with Flexible Shift Times
  Demonstrates the use of flexible shift times and their impact on equipment utilization and make-span reduction.

- **Tutorial-2a**  
  Multiple Recipes and Equipment Routing
  Explains how to clone recipes and deal with equipment routings.

- **Tutorial-2b**  
  Considering Changeover Times
  Demonstrates the specification and usage of equipment changeovers.

- **Tutorial-3a**  
  Drag & Drop Manual Schedule Adjustments
  Demonstrates how to manually adjust and improve schedules through the Equipment Occupancy chart by dragging and dropping batches, procedures, and operations.

- **Tutorial-3b**  
  Representing Process Delays
  Explains how to represent process delays and specify the state of the scheduled activities.

- **Tutorial-4a**  
  Resource Tracking
  Demonstrates how to declare and track resource demand as a function
of time. Resources include materials, heating/cooling utilities, electrical power, and labor. It also explains how to use material tracking charts for sizing supply units and storage tanks.

Tutorial-4b

Inventory Tracking
Explains the role of storage units and the extra information required for tracking inventories of materials.

Tutorial-5

Debottlenecking Production Lines
Provides information on debottlenecking strategies that involve Flexible Shift times and Equipment Pools.

Tutorial-6

Scheduling with Facility Downtimes
Provides information on how to specify facility and equipment downtimes and their impact on production scheduling. It also explains how to make use of interruptible operations and flexible shift times for accommodating facility outages.

Tutorial-7

Scaling Batches
Explains how batches are scaled and the impact of batch size on equipment selection and calculation of operation durations.

4.3 The Tutorials

Tutorial-1a: Creating and Scheduling a Simple Recipe

The introduction of a recipe in SchedulePro can be done in one of the following two ways:

If SuperPro Designer v7.0 or later is available, you can model the recipe in SuperPro, export it to the SchedulePro database and import it within a SchedulePro project, or you can create the recipe directly in SchedulePro.

Chapter 5 of this manual describes in detail how to import in SchedulePro a recipe created in SuperPro Designer. Please note that you may export the simple SuperPro recipe provided with this tutorial even if you do not own a full license of SuperPro. Simply, visit our website (www.intelligen.com) to download the Evaluation version of SuperPro and use that to browse and export the simple recipe.

In this tutorial, however, we will use the second approach and describe in detail the steps that should be followed in creating the recipe directly in SchedulePro.

Open SchedulePro, use the main menu to open a new scheduling project (select “File → New…” ) and you are ready to follow along the steps described in this tutorial.

Recipes created in SchedulePro make use of facilities and their resources. Recipes, facilities and resources should all be part of the same scheduling project. From a practical point of view, it is more convenient to
declare the facility information first before the declaration of the recipes especially if both are to be entered directly in SchedulePro. The reason for that is that recipes make use of resources declared in the facility.

The key data in SchedulePro are mapped to corresponding nodes in the project tree shown on the left side of the main window. You can navigate the tree to find all the information you have entered in the project. The tree consists of four major data categories: Recipes, Materials, Facilities and the Production Schedule.

Adding the Facility and its Resources

Select the Facilities branch of the tree and click on the Add New Facility button ( ) in the facilities pane on the right side of the window (see figure below). In the New Facility dialog that pops up enter the name of the facility (“Medical Solutions Plant”) and optionally some descriptive information. Click OK.

Using the tree explorer on the left, navigate to the node representing the newly generated facility, select it and expand it to reveal its contents. There are eight different categories of resources that every facility has (see figure below): Labor, Staff, Utilities, Equipment, Work Areas, Transfer Panels, Storage units and Material Supply Systems. With the exception of Equipment, the declaration of all other facility resources is optional.

To declare the mixing tank (MT-1) in the facility, select the Equipment node in the tree (see figure below) and click on the Add New Equipment button ( ) in the Equipment pane on the right side of the window. In the dialog that pops up provide the equipment name (“MT-1”) and optionally overwrite the Type by typing “Blending Tank” and provide descriptive information. Click OK.
Repeat the above step three times to declare the storage tank ST-101 (type: “Receiver Tank”), the filler Filler-1 (type: “Filler”), and the CIP skid CIP-Skid-1 (type: “CIP Skid”). If, after creation, you wish to view or edit the properties of the declared equipment, select the Equipment node on the tree, select the specific equipment item in the equipment table (right side of the window) and click the Edit Equipment button ( ) on the toolbar of the pane.

Creating the Recipe

Select now the Recipes branch of the tree. To add a recipe, right-click on the Recipes node and from the pop-up menu select “Create New Recipe..” or click on the Create New Recipe button ( ) in the Recipes panel on the right-hand side of the window. In the dialog that pops-up, enter the name of the new recipe (“1L-Bag-Recipe”) and optionally a description for the recipe. Move to the Size tab of the dialog to specify the reference material (usually the main product of the recipe) and corresponding batch-size (see figure below). SchedulePro utilizes this optional information for recipe scaling, equipment selection based on batch size, and size-based operation duration calculations. Specify “Saline Solution” for reference material, Volume as the basis for defining batch size and, finally, 10,000 L for batch size. With the above specifications, a nominal batch of this recipe is set to produce 10,000 L of “Saline Solution”. It is not necessary to have a predefined material for the Reference Material, although if there are materials defined, they will appear in the list.
Click **OK** to close the dialog. The new recipe will appear in the Recipes panel on the RHS as shown in the dialog below.

The new recipe will also appear in the tree under the **Recipes** node. Select the node of the recipe on the tree to bring up the Recipe View (see figure below). If further editing of the newly created recipe is needed, click on the **Edit Recipe** button (below) at the top of the panel. Other buttons in the same area of the dialog, allow the editing of the display color for the recipe, viewing of the recipe Gantt chart etc. We will visit these options later.

Towards the bottom of the panel, there is a table where the recipe **procedures** (processing steps) are declared. Click the **Add New Procedure** button (below) above the table to add a procedure to the recipe. Accept the default name (P-1) generated for the procedure. The new procedure P-1 will show in the procedures’ table and also in the left-hand side tree under the “1-L-Bag-Recipe” node as shown in the figure below. Note that a “Main Section” node may appear between the recipe and the procedure node. In declaring a recipe in SchedulePro, **sections** correspond to another hierarchical level grouping procedures that serve a common processing objective (e.g. purification) or share a common resource (e.g. a suite). In this simple tutorial example, there is no need to define sections so, in the displays shown here, we have chosen to hide the sections information (you can do the same by clicking “Edit → Preferences…” from the main menu, and making the appropriate selection at the **Display Preferences** dialog that pops-up). Whether shown or not, at this point it is safe to ignore any section-related information.
Select the node of the new procedure on the tree to bring up its view on the right (see figure below).

In the procedure view, click the **Edit Procedure Data** button. The procedure properties dialog will appear; enter “Prepare Solution” as the description of that step. Select the **Main Equipment Pool** tab to declare the equipment used to execute this procedure (see figure below). Select MT-1 in “Medical Solutions Plant” and click on the **Add** button to bring it to the **Equipment in Pool** list on the right. Click **OK**.
We will now concentrate on the bottom half of the procedure view where the contained operations are displayed. Every declared procedure is automatically assigned a new operation (called "op-1"). Select the name of that operation and click on the Edit Operation button ( ). That brings up the dialog that is shown below. Change the default name to “Charge Water” to represent the first operation of the solution preparation procedure. Visit the Duration tab to set the duration to 30 min. The Scheduling tab correctly displays the start of this operation to coincide with the batch start. Click OK.

At this point, we will ignore consumption of materials and labor associated with the execution of operations. Instead we will concentrate on scheduling-related issues, i.e. the duration of operations and the sequencing of their start times. Later, we will see how resource-related information can be entered through the other tabs of the operation properties dialog.

Two values define the timing of operations in SchedulePro: the start time and the duration. The start-time may be relative to the batch-start or to the start or end of another operation. The duration may be either fixed, calculated based on batch size and processing rate, or, set equal to the duration of another operation or sequence of operations (other advanced options not considered in the Tutorial, include the association of an operation’s duration with the level of some material inventory or its calculation based on a changeover matrix.)
Due to the inter-dependent nature of operation scheduling, it is usually easier to first declare all procedures and operations in the recipe and then visit each operation’s properties dialog to declare the scheduling details.

In P-1 we need to add five more operations: “Charge Sodium Chloride”, ”Charge API”, ”Mix Thoroughly”, ”Transfer to Storage”, and “Clean Tank”. To add a new operation, click on the Add New Operation button ( ) on the toolbar above the Operation Sequence table (right side pane of procedure view); provide a name for the new operation and click OK; the new operation will appear in the list of operations belonging to the edited procedure. Select the second operation (“Charge Sodium Chloride”) in P-1 and, as before, visit
its properties dialog to enter its duration and start time option. Its duration will be fixed at 15 min and its
start time will be set, by default, at the end of the previous operation (“Charge Water”). The default start
option is also the desired so there is no need to make any change.

Follow the same steps for generating two more procedures and their operations. At the end, the recipe
skeleton should contain the following information:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Description</th>
<th>Equipment</th>
<th>Operation (duration)</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-1</td>
<td>Prepare Solution</td>
<td>MT-1</td>
<td>Charge Water (30 min)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Charge Sodium Chloride (15 min)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Charge API (15 min)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Mix Thoroughly (60 min)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Transfer to Storage (30 min)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Clean Tank (90 min)</td>
</tr>
<tr>
<td>P-2</td>
<td>Store</td>
<td>ST-101</td>
<td>Receive from Mix Tank (set by Transfer</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>to Storage)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Feed Filler (set by Fill Bags)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Clean Tank (90 min)</td>
</tr>
<tr>
<td>P-3</td>
<td>Fill</td>
<td>Filler-1</td>
<td>Fill Bags (320 min)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Clean Filler (90 min)</td>
</tr>
</tbody>
</table>

For most operations, the duration should be explicitly set to the values shown in the table above. The only
exceptions are the “P-2/Receive from Mix Tank” and “P-2/Feed Filler” operations whose duration needs to
be set equal to “P-1/Transfer to Storage” and “P-3/Fill Bags”, respectively.

The figure below explains how this is done through the Duration tab of an operation’s dialog. In this case,
the duration of “Receive from Mixing Tank” in P-2 is set equal to the duration of “Transfer to Storage” in
P-1. This is equivalent to the “master-slave relationship” in SuperPro Designer: the operation “Receive
from Mix Tank” in P-2 becomes a “slave” of the operation “Transfer to Storage” in P-1 as far as its duration
is concerned.

The duration of an operation can also be ‘slave’ to the duration of a sequence of operations (instead of a
single one), tied to the inventory level of some material storage unit (operation ends when some material
inventory is above or below a certain level) or determined through a predefined changeover matrix based on
the operation that precedes or follows the edited operation. The use of these advanced duration options is
demonstrated in the case studies installed in the Examples folder in the SchedulePro installation path.
With respect to scheduling of operations, the first operation in every procedure is by default scheduled to start at the batch start and every subsequent operation is scheduled to start at the end of its previous operation in the procedure sequence. The Scheduling tab offers additional options that allow us to relate the start or end of an operation with the start or end of other operations in the same or other procedures.

In our example, the following changes need to be made in the default scheduling:
In P-2, “Receive from Mixing Tank” should start at the beginning of “Transfer to Storage” in P-1 (see figure below). Also, in P-3, “Fill Bags” should start at the beginning of “Feed Filler” in P-2.
Operations can also claim auxiliary equipment for their execution. Main equipment is assigned to procedures and auxiliary equipment is assigned to operations. For instance, a CIP-skid utilized for vessel cleaning is auxiliary equipment associated with the cleaning operation. Auxiliary equipment is assigned to operations through the *Auxiliary Equipment* tab.

The figure below shows the assignment of CIP-Skid-1 to “Clean Tank” in P-1. If several CIP skids are assigned to an operation, then, the scheduling algorithm will select the first one that is available (searching from top to bottom). Next, assign the same CIP skid to “Clean Tank” in P-2. Do not assign a CIP skid to “Clean Filler”. We assume that Filler-1 will be cleaned at the same time as ST-101 utilizing the same skid.
Declaring auxiliary equipment and other operation resources is optional. The only mandatory operation information that SchedulePro needs is the operation duration and start time specification.

When the declaration of the entire recipe is completed, the interface of P-1 should look as follows:
A recipe can be visualized with a Gantt chart that can be brought up by right-clicking on the recipe node in the left-hand-side tree and selecting the menu option “Recipe Gantt Chart…” or by clicking on the View Recipe Gantt Chart… button on the right-hand side recipe panel displayed when the relevant recipe is selected. The figure below corresponds to the “1L-Bag-Recipe” that we created. Note that, in agreement with the above specifications, “Transfer to Storage” in P-1 and “Receive from Mixing Tank” in P-2 operate in parallel and have the same duration. The same is true for “Feed Filler” in P-2 and “Fill Bags” in P-3.

A recipe Gantt chart cannot be displayed unless the recipe is declared in a complete and self-consistent way. If this is not the case, a Recipe Incomplete button will appear in the recipe view; by clicking on that button a message with more detailed information on the recipe status will appear. Make sure that all recipes are fully declared before proceeding at scheduling production campaigns based on these recipes.
Planning and Scheduling Campaigns

After declaring recipes and facilities, we are ready to declare campaigns defined as series of batches of a given recipe. In SchedulePro, each scheduled batch represents the realization of a recipe at a given time and with the use of specific equipment and resources. Unless otherwise stated by the user, the only constraint that SchedulePro takes into account in generating a schedule is the availability of equipment and facilities.

Select the Production Schedule branch on the project tree. On the right-hand side production view and under the Scheduler Settings header, click on the clock button to specify the start of the schedule. On the dialog that pops up, set the Start Date and Time for the schedule at 5/16/07 and 8am (obviously you can set the schedule start at any date and time you wish; however, using the above values guarantees that the results that you will get if you follow the tutorial steps will be consistent with the ones shown in this tutorial.) To plan a campaign, click on the Add New Campaign button (as shown) in the Campaign Sequence pane of the Production Schedule view. That brings up the Campaign Setup dialog (see figure below).
There are several tabs in the Campaign Setup dialog. In the **ID/Amount** tab you can set the campaign name, the associated recipe, and the number of batches. If a reference batch size has been specified for the recipe, the number of batches and the scale factor indirectly determine the order amount (i.e. amount of product produced by the entire campaign.) Alternatively, you can specify directly the order amount and let SchedulePro calculate the required number of batches. Set the number of batches to 4 and click on the **Recalculate** button to refresh the order amount.

In the **Time/Sequencing** tab (shown below) you can set the **Campaign Start Mode**. In other words, you can specify whether the campaign is to start immediately on the specified release date, or after the start/end of another campaign, etc. This case is scheduled with the **Release Date** option.
In the Options tab (shown below) you can specify the Batch Start Options. By default the batches of a campaign are scheduled based on the minimum cycle time of the recipe (determined by the scheduling bottleneck equipment). You have the option to specify another (larger) cycle time or a slack time (i.e., idle time between consecutive batches for the time bottleneck equipment).

In this tab you can also specify the order by which pooled resources are used to resolve conflicts. The default “By Earliest Availability” option means that the available resources are sorted in terms of time availability and the earliest available is given precedence; the “By Priority List” option means that the alternatives are considered in the order they appear in the pool and the first available is used; finally, the “By Rotation” option selects the equipment that is next in the list after the one previously used.
With the campaign definition complete, you are now ready to generate a production schedule. Click on the **Schedule Campaigns** button of the main toolbar. SchedulePro will use the provided information on the campaign and the recipes and attempt to generate a schedule that will satisfy all constraints. When calculations are done, the Production Schedule window should look as follows:
The Production Schedule window displays the campaigns and batches already scheduled with their start and end times along with information on possible conflicts encountered while creating the schedule. Under the Production Schedule branch of the project tree, scheduling information for every campaign, batch, procedure and operation is hierarchically displayed. Each batch is identified by a unique name which is a combination of the associated campaign name and an integer id.

Visualizing the Production Schedule

In addition to the project tree, scheduling results can also be visualized in graphs accessed through the main toolbar. Press the button (or, from the main menu, select the menu option “View⇒Equipment Occupancy Chart⇒Equipment Occupancy Profile…” ) to display the equipment occupancy chart shown below. The legend on the right designates batches by distinct colors. This is the default color-coding option. The top line corresponds to CIP-Skid-1. Notice how its use is displayed. The first yellow bar corresponds to the cleaning of the mixing tank (MT-1). The second yellow bar corresponds to the simultaneous cleaning of the storage tank (ST-101) and the filler (Filler-1). The storage tank (ST-101) is the overall bottleneck (has the longest cycle time). However, the utilization of the filler is pretty close to that of the storage tank.

The style of the chart can be modified by right-clicking on it (in an open area) and selecting “Edit Style”. Details on style editing can be found in Chapter 8 of this manual. Chapter 8 also explains how to print and copy the chart. In the Equipment Occupancy Chart Style dialog, go to the Time Scale tab and set the Major Units (units of major axis) to “day” instead of “h”. After clicking OK on the dialog, click “Yes” when prompted to propagate the time style changes to all charts. Your equipment occupancy chart should now look as shown below. If you wish to change the color used for a batch, double click on the name of that batch in the chart Legend and pick a different color from the palette that pops up.
Close the Equipment occupancy Chart and, from the main toolbar, click on (or, from the main menu, select the menu option “View/Equipment ➔ Gantt Chart…” ) SchedulePro generates an Operations Gantt chart (similar to the recipe Gantt chart that we saw earlier) where all scheduled activities are shown both in a hierarchical tree as well as in a bar graph. That chart also can be exported to MS Project (see Chapter 8).

Again from the main toolbar, select the menu option “View ➔ Equipment Time Utilization…” to visualize the percent time utilization of each equipment item during the campaign (see figure below). The storage tank (ST-101) with the longest time utilization is identified as the most likely bottleneck.
Tutorial-1b: Impact of Equipment Pools

In this version of the tutorial we will investigate the impact of equipment pools on cycle times. This example case is based on the following equipment configuration. Three identical equipment items are available for each procedure as shown in the following sketch:

The extra equipment items can be quickly added through the Equipment view (see figure below) displayed when you select the Equipment node on the tree. To add a new equipment which is identical to one of the existing, simply select the existing, click on the Copy Equipment button ( ) and then click on the Paste Equipment button ( ). Then select the new equipment and click on the Edit Equipment button ( ) to change its name and optionally other properties.

Next, make the new equipment items available to the appropriate procedures. For instance, select P-1 and click the Edit... button in the procedure view to bring up the Procedure Details dialog shown below. Add MT-2 and MT-3 to the equipment pool utilized by P-1. Next, assign ST-102 and ST-103 to P-2 and Filler-2 & Filler-3 to P-3. When a pool of equipment items are available to a procedure, the procedure node in the tree displays the full name of the equipment at the top followed by a comma and three dots that denote availability of multiple equipment items.
Next, plan and schedule a campaign of six batches. Make sure that on the Campaign Setup dialog and the Options tab you select the Set Slack Time option and specify a slack time of 0 h. Then bring up the Equipment Occupancy chart by clicking on \( \) on the main toolbar (the chart is shown below). Notice that a new filler is used for each batch. This reduces the cycle time of the process and increases the plant throughput. However, the added equipment can not be fully utilized because now the bottleneck is the CIP-Skid.
Tutorial-1c: Scheduling with Flexible Shifts

The performance of the previous case can be improved (i.e., the total time or make-span of the campaign can be reduced) by introducing some flexibility in the scheduling of the cleaning operations that utilize the single CIP skid (which is the current bottleneck).

Scheduling flexibility can be introduced through the Scheduling tab of an Operation’s dialog (see figure below) by making use of the flexible shift variable. Flexible Shifts are maximum permissible delays in the start of an operation’s execution; used properly, they can help reduce idle times.
To bring up the dialog of “Clean Tank in P-1”, select the node of P-1, select operation “Clean Tank”, and click on the Edit Operation button ( ). Then, switch to the Scheduling tab of the operation’s dialog, check the Use Flexible Shift box, specify a value of 6 h, and also check the Can delay/break for equipment availability check box. Click OK to close the dialog.
Specify a similar Flexible Shift for “Clean Tank” in P-2. There is no need for the specification of flexible shift in P-3, as the cleaning operation of P-3 takes place simultaneously with the cleaning operation in P-2 and it is using the same CIP skid item.

Next, plan and schedule a campaign of six batches. Make sure that on the Campaign Setup dialog and the Options tab you select the Set Slack Time option and specify a slack time of 0 h. Then bring up the Equipment Occupancy chart by clicking on on the main toolbar (the chart is shown below).

Clearly, the use of flexible time shifts in cleaning operations has reduced the idle time between batches as well as the make-span of the entire campaign (total make-span dropped from approximately 30 hrs to less than 24hrs.)
Tutorial-2a: Multiple Recipes and Equipment Routing

In this version of the tutorial you will learn how to make a copy of a recipe, generate production schedules that involve multiple recipes, and deal with equipment routing issues.

This example case is based on the following equipment configuration. Filler-1 and Filler-2 handle the filling of 1-L bags, whereas Filler-3 handles the filling of 0.5-L bags. The filling rates are different as well; filling the 0.5-L size takes twice as much time for the same overall recipe batch size of 10,000 L. Fillers-1 and Filler-2 are fed by storage tanks ST-101 and ST-102, whereas Filler-3 is fed by tank ST-103 only.

A new recipe is required to represent the manufacturing of 0.5 L bags. Since the manufacturing of 0.5 L bags is quite similar to the 1 L bags, we can save time by copying and modifying the existing recipe. Switch to the Recipes view by selecting the Recipes branch in the tree. Select the current recipe, click on the Copy Recipe button ( ) and then click on the Paste Recipe button ( ). Then select the new recipe and click the Edit Recipe button ( ) to change its name to “0.5L-Bag-Recipe”.

Next remove ST-103 and Filler-3 from the 1L recipe and assign ST-103 to P-2 and Filler-3 to P-3 of the 0.5L-Bag recipe. Please note that ST-101 and ST-102 must be removed from P-2 of the 0.5L-Bag recipe since only ST-103 is available for storing batches that are filled in 0.5 L bags. Similarly, Filler-1 and Filler-2 must be removed from P-3 of the 0.5L-Bag recipe.

The duration of the filling operation in the previous versions of the tutorial was specified by the user. The value of that variable, however, can also be calculated based on the batch size and the processing rates of the fillers. To specify the processing rate of Filler-1, select the Equipment node in the tree, then select “Filler-1” in the Equipment table (right side of Equipment view), click on the Edit Equipment button ( ), and switch to the Size tab (see figure below). Check the box titled Imposes limit on processing rate and specify a Nominal Rate of 30 entities/min, a Maximum Rate of 40 entities/min and a Minimum Rate of 10 entities/min. In other words, Filler-1 under normal conditions fills 30 1-L bags per min but that rate can vary from 10 to 40 entities/min. Specify the same information for Filler-2 and Filler-3.
Next, visit the “Fill Bags” operation in P-3 of the 1L-Bag recipe, move to the Duration tab, zero the Constant component of the Duration variable, check the Rate-based term box and click on the Set Parameters… button to launch the Rate Parameters dialog shown below.

On the Rate Parameters dialog, set the Rate Basis as “Entities Flow” (entities represent bags in this case) and specify the appropriate amount. In this case enter 10,000 entities since the batch size is 10,000 L and we use 1 L bags. The processing rate is either specified by the user or retrieved from the equipment utilized for this step. Select the latter option in this case. This way, if the main equipment pool for filling in P-3 contains more than one equipment items of different processing rates, the rate will be updated automatically at runtime based on the selected main equipment item.

Repeat the same steps for “Fill Bags” in P-3 of “0.5L-Bag-Recipe”, but specify 20,000 entities for amount processed since we use 0.5 L bags to fill the same amount of bulk material (10,000 L).
Please note that one could use a similar approach for calculating the durations of the charge and transfer operations by specifying appropriate amounts and processing (pumping) rates.

Next, plan two campaigns. 4 batches of the 0.5L-Bag recipe followed by 8 batches of the 1L-Bag recipe and schedule. The Equipment Occupancy profile for this case is shown below. The legend on the right designates campaigns by distinct colors. You can customize the appearance of the Equipment Occupancy chart by right-clicking on it (in an empty area, not on a procedure bar) and selecting Edit Style from the popup menu. The dialog allows you to select the coloring scheme of your preference (Color by campaign in this case).

Notice how CIP-Skid-1 is the main equipment bottleneck for the 1L-Bag campaign, whereas storage tank ST-3 is the bottleneck for the 0.5L-Bag campaign. Also, notice the wait times (white spaces within
procedure bars) that the scheduling algorithm has generated using the flexible shift times of the cleaning operations in order to reduce the make-span of the two campaigns.

**Tutorial-2b: Considering Changeover Times**

This tutorial demonstrates handling of equipment changeovers in SchedulePro. Delays due to changeover times are common in multi-product manufacturing facilities and occur particularly often in packaging/filling processing steps. For instance, they may account for the time required to adjust a filling machine for handling a container of a different size.

Please create another recipe (called 2L-Bag-Recipe) to represent manufacturing of 2L bags by copying the 1L-Bag recipe. The previous section of the tutorial explains how to create a new recipe by copying an existing one. Also, assume that the 2L-Bag recipe utilizes exactly the same equipment as the 1L-Bag recipe. However, you would still need to visit the Duration tab and Rate Parameters dialog (as shown above) of the “Fill Bags” operation in P-3 of the 2L-Bag recipe to change the batch amount to 5000 entities (corresponding to 10,000 L filled in 2-L bags). We are assuming that the filling time is not a function of bag size. If that is not the case, a fraction of the nominal capacity can be specified (by changing the “Use x % of the Nominal Rate” variable).

Changeover times can be specified at the campaign or equipment level. In this case we will make use of equipment-specific changeover times for Filler-1 and Filler-2. Launch the Equipment Properties dialog of Filler-1 (see figure below) by selecting Filler-1 in the table of the Equipment view and clicking on the Edit Equipment button ( ). Visit the Cleanout/Changeover tab (shown below) and specify a 2-h changeover time in the proper field. The durations of pre-processing or post-processing cleanings or changeovers can be specified in this tab either as fixed (nominal) values or through changeover matrices; in this latter case, the changeover duration is variable and depends on the sequence of executed tasks. In this example, we will use the simplest (nominal) option.

Repeat the same specification of 2 h changeover for Filler-2. There is no need to specify a changeover time for Filler-3 since it is dedicated to 0.5L bags.
Changeover times are applied at the campaign level. You can select any campaign and click on the Edit Campaign button to bring up the Campaign Setup dialog. The same dialog is launched during the planning of a new campaign (e.g., when you click on the Plan a Campaign button of the campaign toolbar).

On the Campaign Setup dialog, select the Advanced tab (see figure below) to view the Advanced Campaign Sequencing options. Cleaning or changeover times can be specified either at the start (“Pre-production Options”) or the end (“Post-production Options”) of a campaign. Here, you will have to define some post-production changeover time. Activate the Include box for Equipment Changeover and select the Duration Based on Equipment Changeover Time option. If the Fixed Changeover Time option is selected, the same changeover time will be applied to all equipment utilized by that campaign. Also select the Run At Last Equipment Use option. With the above specifications, an equipment-dependent changeover time will be applied to all equipment as soon as they are done executing the last task related to this campaign.
Next, plan and schedule a campaign of 4 batches of the 0.5L-Bag recipe, followed by a campaign of 8 batches of the 1L-Bag recipe, followed by a campaign of 4 batches of the 2L-Bag recipe. Changeover times should be applied to the second campaign (8 batches of the 1L-Bag recipe) because at the end of that campaign Filler-1 and Filler-2 must be adjusted to handle 2L bags. There is no need to apply changeover times to the first campaign because Filler-3 is dedicated to 0.5L bags.

The results of the production schedule are shown below. The changeover times for Filler-1 and Filler-2 at the end of the second campaign are represented by the light orange bars (circled in red for emphasis). Note
that there is no changeover bar for all equipment other than Filler-1 and Filler-2 because their nominal changeover duration is zero.

Tutorial-3a: Drag & Drop Schedule Adjustments

SchedulePro provides drag & drop functionality on the Equipment Occupancy charts. Operations, procedures, and even whole batches can be dragged and dropped to facilitate manual schedule adjustments. The type of scheduled item to be moved manually on the Equipment Occupancy chart can be specified on the Equipment Occupancy chart toolbar (see figure below). The drag-drop type selection may also be made from the chart’s Edit Style dialog.

The following Equipment Occupancy chart corresponds to the case of Tutorial-2b but without Flexible Shift times in the 2L-Bag recipe. Under these conditions, the scheduling algorithm delays the start of the second batch of the 2L-Bag recipe to avoid conflicts with the use of the single CIP skid and that leads to an increased make-span of the campaign.
An improved solution can be found manually by dragging the second batch of the 2L-Bag-Recipe (blue bars) to the left. First, make sure that you have selected the “Batch” Drag/Drop mode (see figure above), then drag the batch to the left approximately at the position indicated by the grey rectangle above.

When you drop the dragged batch at its new location, SchedulePro will display the new conflicts. The conflicts are with CIP-Skid-1. The conflicts can be resolved manually by delaying the cleaning. Switch to drag-drop “Operation” mode and move the conflicted CIP operations to right to delay them as indicated by the red arrows below.
The figure below displays a solution that can be achieved quite easily.

![Equipment Occupancy](image)

The drag/drop functionality of SchedulePro offers you the flexibility to interactively generate solutions that better suit your specific needs.

**Tutorial-3b: Representing Process Delays**

For this example, start with results from Tutorial 3a, and click on the **Reset Schedule** button in the main toolbar. Answer **Yes** to allow SchedulePro to completely reset the schedule. At this point, all user modifications on the schedule (such as setting the start of scheduled tasks through drag/drop) are lost. Then reschedule by pressing the **Schedule Campaigns** button.

In manufacturing environments the execution of certain operations may be delayed due to equipment failures and other unexpected events. Such delays may lead to scheduling conflicts with future activities. SchedulePro allows you to follow the schedule in real time and modify scheduled activities to represent process delays and other deviations from the original production schedule. In this context, it is useful to use the concept of **current time** to distinguish between past and future activities.

Scheduled activities can be modified through the navigation tree and its views as well as through the Gantt and Equipment Occupancy charts. In this tutorial the latter will be demonstrated. Initially, you can select to implement the current time option by clicking the **Edit Schedule Timing** button on the equipment occupancy chart toolbar and checking the corresponding flag in the **Current Time** tab. Set the current time to a random day and time within the scheduling horizon (e.g. 15:19 on May 17, 2007 as shown below) and click **OK** on the dialog. A red line representing the current time will appear on the equipment occupancy chart. The slider bar on top of the line allows you to change the current time by dragging the slider.

The current time line results in the division of operation in three categories: completed (indicated by a crossed hatch pattern), in-progress (diagonal hatch) and not-started (filled pattern). The classification of operations is automatically updated if the current time is changed. The use of current time facilitates the monitoring of the production progress. Completed batches and campaigns can be deleted from the schedule.
through the right-click context menu. In this way, only the relevant campaigns and batches are part of the production schedule at all times.

For any scheduled operation but especially for those that have started and are in-progress, it makes sense to be able to change its duration or end time if its actual execution diverted from planning. To view this feature, let’s pick operation “Feed Filler” of the third batch of the 0.5L-Bag campaign executed in ST-103. Under the above current time setting, this operation is classified as being in-progress. Right click on the bar corresponding to this operation and select “Operation→Properties…”

The dialog that pops up shows the identity of this scheduled operation (the recipe operation it corresponds to, its scheduling and duration links etc.) as well as its scheduling information (start time, duration, end time, breaks etc.) This latter information can be changed to represent scheduling diversions. To practice that, change the duration of this operation to 16 hrs (to represent a process delay) and click OK.

The delay in that operation obviously creates conflicts with future operations that were planned based on the nominal duration of that operation. As indicated above, SchedulePro will display the conflicts but will not automatically attempt to resolve them. You can either try to manually resolve the conflicts using the drag and drop functionality (demonstrated in Tutorial 3a) or you can engage SchedulePro to do that. To do the latter you must right-click on the conflicting entity and use the context menu options or use the Resolve Conflicts button on the chart toolbar. Note that when there is a conflict between two batches, it is in the latter in hierarchy (and, in time) batch that the conflict is assigned to. Also note that conflict resolution can be performed in a stepwise fashion with the user controlling the extent to which SchedulePro will resolve the scheduling conflicts. So, if you right-click on a conflicting entity, the menu that pops-up shows options to resolve conflicts for the corresponding operation, procedure, batch, campaign or for the entire schedule. For better control of the schedule and to avoid big changes, make sure that you resolve conflicts at a local level (e.g. a single batch) and proceed gradually until all conflicts are resolved.
In this example, we will use a non-conservative approach and try to resolve all conflicts simultaneously. As shown below, click on the **Resolve Conflicts** button on the chart toolbar and select “Resolve Conflicts”
From Campaign to End.” Alternatively, you can right-click on any operation of the conflicting batch (the 4th batch of campaign 2L bag-Recipe-1), and select “Campaign→Resolve Conflicts→To End of Schedule.”

The new schedule follows. As expected, subsequent batches had to be delayed to resolve the conflicts introduced by the longer duration of the “Feed Filler” operation.
For scheduled operations and procedures that use pooled resources (such as main or auxiliary equipment, staff etc.) you can change the assigned resource by visiting that scheduled entity’s property dialog (as we did before for the Feed Filler operation) and visiting the Resources tab. If the reassignment of a resource leads to scheduling conflicts, those conflicts can be resolved using any of the techniques indicated above.

**Tutorial-4a: Resource Tracking**

SchedulePro keeps track of the demand for materials (consumption and generation) as well as the demand for heating/cooling utilities, electrical power, and labor.

Materials whose consumption (or generation) is to be tracked by SchedulePro must first be registered with the project. SuperPro recipes exported to SchedulePro carry over the registered component and stock mixture information within SchedulePro. In our example, we will need to declare the following materials with their corresponding types:

<table>
<thead>
<tr>
<th>Material</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>WFI</td>
<td>Pure component</td>
</tr>
<tr>
<td>Sodium Chloride</td>
<td>Pure component</td>
</tr>
<tr>
<td>API-A</td>
<td>Pure component</td>
</tr>
<tr>
<td>1L-Bag</td>
<td>Discrete</td>
</tr>
<tr>
<td>2L-Bag</td>
<td>Discrete</td>
</tr>
<tr>
<td>0.5L-Bag</td>
<td>Discrete</td>
</tr>
</tbody>
</table>

To enter the first material, select the **Materials** node in the tree. Click the **Add New Material** button to launch the **Material Properties** dialog (see figure below).
Type the material name “WFI” and select the default material type (Bulk / Pure Component). Repeat the above process for “Sodium Chloride”, “API-A”, “1L-Bag”, “2L-Bag”, and “0.5L-Bag”. Please note that the bags must be specified as discrete materials (objects). If a material is specified as a Stock Mixture (e.g., 10% w/w Sodium Chloride solution in WFI), you must also specify its composition (by clicking on the Composition button) so that SchedulePro can track the demand of its constituents.

Raw material consumption is linked to recipes via input streams. Input streams are specified at the Operation level. Now select the “Charge Water” operation in P-1 of the 1L-Bag recipe, launch its properties by clicking on the Edit Operation button, and switch to the Material Inputs tab.

Click on the Add button to launch the Stream Information dialog (shown below.) Specify the name of the stream (e.g., “Water Charge”), its amount (10000 L), and its composition (WFI 100%). These specifications simply mean that a batch of this recipe requires 10,000 L of WFI to be supplied during the “Charge Water” operation of P-1. Instead of specifying an amount, one could specify the flowrate by which the material in this stream gets consumed. In this case, the total amount used by the operation will be calculated by the product of the flowrate times the operation duration. In either case (Specify Amount or Specify Flowrate) the corresponding quantity can be declared as scaleable with batch size using the relevant flag in the dialog. Also note that since the amount in this case has been defined in volumetric terms, the stream density in the bottom of the dialog should be specified so that SchedulePro can convert volume to mass (if needed).
Next associate input streams with the “Charge Sodium Chloride” and “Charge API” operations to represent supply of 90 kg of Sodium Chloride and 1 kg of API-A per batch, respectively. Repeat the above for the other two recipes (2L-Bag and 0.5L-Bag).

If you also wish to track the generation of 1L-Bags, you may associate an output stream with the “Fill Bags” operation of P-3 (1L-Bag recipe) and specify a production of 10,000 entities (i.e., bags) per batch. The type of this stream must be “Discrete” because it represents flow of discrete entities (1L bags).

Please note that SchedulePro does not attempt to close material balances the way SuperPro Designer does. It simply keeps track of input and output flows without balancing them.

Now schedule a campaign with 8 batches of the 1L-bag recipe.

SchedulePro generates graphs that display the consumption of raw (input) materials and the generation of products and wastes. To visualize the profile of a material resource, select from the main menu “View→Resource Profiles→Raw Materials…” if you wish to see input material consumption; similar options exist for products or wastes generated by the scheduled processes. The dialog that pops-up (see figure below) allows you to select the material resource to be plotted.
The following graph shows the raw material profile for WFI. The red line denotes instantaneous demand in mass flow units (kg/hr). The blue line denotes time-averaged demand (kg/hr) for sequential 8-hour periods. The time averaging period can be modified by right-clicking on the chart and selecting “Edit Style” from the popup menu. Finally, the green line (that corresponds to the y-axis on the right side) denotes cumulative demand in mass units (kg) over the entire period. Also notice that the x-axis now displays calendar time and not relative time as before. You can make this change by opening the dialog that comes up if you select “Edit Style” from the pop-up menu, visiting the Time Scale tab and selecting the Absolute (Calendar-based) option.
SchedulePro keeps tracks of the demand for heating/cooling utilities and electrical power in a similar way. Those resources must be first declared under a facility before they can be utilized by operations of recipes. For utilities and electrical power the user may also specify a limit on the supply rate, which can be used to visualize violations of supply. The user may also associate a “Material” with a heating/cooling utility to capture the contribution of that utility to material consumption. For instance, you may specify that 1 kg of clean steam requires 1.1 kg of WFI for its generation. Then, the demand for WFI may (optionally) also include the amount of WFI utilized for clean steam generation (this is activated by checking the Include utilities that contain material(s) in their composition box on the Select Raw Material Resource dialog shown above).

Labor resources can also be declared at the facility level and used by recipes. To insert a new labor type, select the Labor node under the facility branch and click on the Add New Labor button. In the dialog that comes up (shown below), enter the name of the new labor type (“Operator”), uncheck the Unlimited box and
enter “5” in the persons box to denote that the facility has a limit of 5 operators. This is the base availability of this labor resource in the corresponding facility. Deviations from the base availability (e.g., 5 operators during the morning and afternoon shifts but only 2 operators during the night shift) can be specified through the Availability Calendar of the labor properties dialog.

Demand for labor in an operation is specified through the Labor tab of that operation’s dialog. You may do this quickly (for all operations in a recipe) by selecting “Edit Labor Requirements…” from the recipe context menu. The dialog that comes up (shown below) allows you to enter the number of labor-hrs/hr for each recipe operation and each labor type defined in the facility.
After completing the labor specifications as shown above, reschedule the 12-batch 1L bag campaign. The figure below displays the labor demand chart for this case. The blue lines represent the instantaneous demand expressed in persons (un-rounded). The red line represents the availability limit (5 persons). For short periods of time the demand exceeds the availability limit.

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Operation</th>
<th>Operator (in Medical Solutions Plant)</th>
</tr>
</thead>
<tbody>
<tr>
<td>P-1 Prepare Soln (MT-1,...)</td>
<td>Charge Water</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Charge Sodium Chloride</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Charge API</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Mix</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Transfer to Storage</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Clean Tank</td>
<td>1.00</td>
</tr>
<tr>
<td>P-2 Store (ST-101,...)</td>
<td>Receive From Mix Tank</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Feed Filler</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Clean Tank</td>
<td>1.00</td>
</tr>
<tr>
<td>P-3 Fill (Filler-1,...)</td>
<td>Fill Bags</td>
<td>1.00</td>
</tr>
<tr>
<td></td>
<td>Clean Filler</td>
<td>1.00</td>
</tr>
</tbody>
</table>
If the above labor constraint violation cannot be accommodated (e.g., with floating operators from another facility), then the execution of some operations must be delayed so that the demand never exceeds the limit. Such a solution can actually be generated automatically by SchedulePro by visiting the Constraints tab (shown below) of the Scheduling Mode Options dialog (accessed though the menu option “Schedule→Scheduling Options…”). In this tab, specify “Labor” as an optional constraint, close the dialog and reschedule.

Notice that the labor violations are eliminated, but the make-span of the entire campaign increases.
Conflict resolution can also be performed manually by the user through the Equipment Occupancy Chart (EOC) as shown earlier. In that case, it would be useful to be able to see both the EOC chart and the labor chart simultaneously so that changes in the schedule can be reflected immediately on the labor demand chart. It is possible to do that by generating the labor chart (or any other resource chart) through the EOC and link them together. Open the EOC, click on the Open Resource Chart menu button ( ), and select the option “Labor”. The steps to generate the labor chart are the same as indicated before through the main toolbar. On the labor chart that gets displayed when you select the resource to plot, click on the Link to EOC button ( ). The labor chart will be anchored at the bottom of the EOC chart and its time axis will follow the time axis of the EOC. When changes are made in the EOC, the labor chart will be automatically updated. If you wish to unlink the charts, click on the Manage Linked Charts button ( ) of the EOC and select “Unlink Charts”. Through this mechanism you can link all the resource consumption and inventory charts you wish to be able to observe while modifying the schedule.

**Tutorial-4b: Inventory Tracking**

SchedulePro keeps track of inventories of input, output, and intermediate materials in storage units. Storage units can supply input streams, or receive material from output streams. They can also function as intermediate containers that both receive and supply materials. Inventories of single raw material ingredients can also be tracked through Material Supply Systems whose definition and functionality parallels that of the storage units.

A storage unit can be added to a project by selecting the Storage node under Facilities and clicking the Add New Storage Unit button ( ) in the Storage Units view. On the dialog that pops-up, type the name of the storage unit (e.g., “Aqueous Storage Tank”) and click OK. The Storage Units view should look as follows.
Select the new storage unit and click on the **Edit Storage** button to launch the **Storage Unit Properties** dialog (shown below). Classify its type as “Receiving Unit\Waste\Aqueous”.

![Storage Unit Properties dialog](image)

Now, switch to the **Inventory Data** tab. Check the **Track Inventory** box and specify its capacity to 20,000 kg as shown below. The material that accumulates in output storage units, such as waste tanks, must be discharged from time-to-time. SchedulePro offers two options for handling discharge of materials from output units.

![Inventory Data tab](image)
If you select the Continuous Receipt/Discharge option and click on the ON/OFF button (that looks like a full tank), SchedulePro launches the following dialog that allows you to specify the “Discharge Rate” and the “On/Off” level. This simply means that when the level of material in the output storage reaches 80% of the unit’s capacity, the system will start pumping out material at a rate of 20,000 kg/h until the Off level is reached (0 % in this case). Note that if you set both levels to 100%, material will be discharged from the storage unit at a constant rate with no consideration to the on-off levels.
If you select the **Periodic Receipts/Discharges** option, you can specify removal of certain amounts on specific dates and times.

To calculate inventories in storage units, SchedulePro requires a link between output streams of operations and valid storage units. This link must be specified on the **Stream Information** dialog through the **Material Outputs** tab of an **Operation’s** dialog. The figure below, for instance, shows a waste stream generated during the cleaning of a mixing tank. Click on the **Is Deposited to Storage Unit** box and select “Aqueous Storage Tank” from the list to indicate that this stream is deposited to the above storage unit.

**NOTE:** If a recipe is imported from SuperPro Designer, all output materials of CIP (cleaning) operations are sent by default to a WASTE-AQUEOUS storage unit.

Specify 2000kg of WFI used for each cleaning operation in the 1L Bag recipe. Then reschedule the 12 batch campaign without the labor constraint.

To view the inventory of a storage unit, select “View → Inventory Profiles/Storage Inventory…” from the main menu and select the storage unit from the dialog that appears. Alternatively, bring up the Storage Units...
view on the right hand side (by selecting the **Storage** node under the **Facilities** branch), select the storage unit of interest and click on the **View Storage Unit Inventory Profile** button.

The figure below displays the inventory of the “Aqueous Storage Tank”. The bold line represents the capacity of the tank. The thin line represents the level of material in the tank. Notice that as soon as the level reaches 16,000 kg (i.e., 80% of the tank’s capacity), the discharge operation is initiated until the level drops down to zero.

You can modify the inventory profile appearance by right clicking on the chart and selecting “Edit Style” from the popup menu.

**NOTE**: Intermediate storage units can be used to represent flow of material from one recipe into another. For instance, in complex synthesis routes of pharmaceuticals an active intermediate of a chemical step (which is represented with a unique recipe) may become an input to another chemical step (represented by another recipe). SchedulePro can handle inventories of intermediates that must be taken into account during the generation of production schedules.

Like resource profiles, inventory profiles can be also be displayed and linked to the EOC. Inventory profiles can be generated through the EOC by clicking on the **Open Inventory Profile** menu button ( ).
Tutorial-5: Debottlenecking Production Lines

The figure below displays the Equipment Occupancy chart for a campaign of 8 batches of the 2L-Bag recipe without Flexible Shift times in the cleaning operations (it corresponds to file Tutorial-5a.scp).

The figure below corresponds to the same 8 batches of the 2L-Bag recipe but with flexible shift times in the cleaning operations (file Tutorial-5b.scp).

The use of flexible shift times reduces the make-span of the campaign. To reduce the make-span further and increase the number of batches that can be processed within a certain period of time, we must eliminate the
current bottleneck, which is the single CIP skid (CIP-Skid-1). The bottleneck can be eliminated by installing another CIP skid.

To add a new CIP skid, select the **Equipment** node on the tree. Then, select the existing skid, copy it (by clicking on the **Copy Equipment** button), paste it (by clicking on the **Paste Equipment** button) and rename it to “CIP-Skid-2”. The equipment view should look as follows.

![Equipment view](image)

Make CIP-Skid-2 available to the cleaning operations in P-1 and P-2 procedures of the 2L-Bag recipe through the **Auxiliary Equipment** tab of their properties dialog (see figure below).
Reset the current production schedule by clicking on the **Reset Schedule** button of the main toolbar or by selecting “Schedule→Reset Schedule” from the main menu bar.

Delete all planned campaigns by clicking on the **Delete Campaign** button in the Production Schedule view. Now, plan a new campaign of 8 batches of the 2L-Bag recipe. Make sure you set the slack time to zero.

The figure below displays the Equipment Occupancy chart for the new situation (it corresponds to file Tutorial-5c.scp). The use of the second skid removes the bottleneck and reduces the campaign make-span.

Using SchedulePro one can readily perform this type of analysis for multi-product facilities. Bottlenecks imposed by resource constraints can be evaluated as well.
Tutorial-6a: Scheduling with Facility Downtimes

This case demonstrates the use of SchedulePro’s calendar capabilities for representing downtime of facilities. You can specify facility downtimes (outages) by selecting the Facilities node on the tree to display the existing facilities in the Facilities view (see figure below).

Select the facility of interest (“Medical Solutions Plant” in this case) and click on the Facility Outages button (DataFrame) to launch the calendar window (see figure below).
Right-click on the box that corresponds to first Friday (May 18) after the schedule start and select “Add New Entry…” to launch the Resource Calendar Entry dialog. On this dialog, you can specify a start date and duration, or a start date and end-date during which the facility remains down. You can also set the repeat pattern (“Weekly” in this case) for this down period until a specified end date is reached.

In this tutorial example, we set weekend breaks starting at 18:00 on Fridays and completing at 10:00 on Monday mornings (64 h downtime). After you close the Resource Calendar Entry dialog, you will see the downtimes displayed graphically on the calendar window by grey bars.

Now schedule a campaign of 5 batches of the 0.5L-Bag recipe. The figure below shows the equipment occupancy chart for such a campaign (it corresponds to file Tutorial-6a.scp). The gray column corresponds
to a weekend break. Notice that MT-2 is never utilized during this campaign. MT-1 (the first equipment item on the equipment pool list) can accommodate the needs of this campaign.

If you wish to utilize MT-2 in a specific batch of the above campaign (e.g., the fourth batch that is represented by the magenta bars), right click on the bar of that procedure and select “Procedure ➔ Properties” to launch the Edit Scheduled Procedure dialog (see figure below). The equipment can be selected via the Resources tab.
Click on the **Equipment** drop-down menu, select “MT-2”, and click **OK**. Similarly, if you wish to change an auxiliary equipment item associated with a scheduled operation (e.g., a CIP skid associated with a cleaning operation), visit its dialog (by right-clicking on it and selecting Operation) and select an alternative equipment item (that is on its **Auxiliary Equipment** list).

Downtimes can also be specified for particular equipment items to account for scheduled maintenance, periodic cleaning, etc. Equipment downtimes are specified through the Equipment view by selecting a specific equipment item and clicking on the **Equipment Outages** button. The interface is identical to that of facility downtimes. We do not make use of equipment-specific downtimes in this tutorial case.

For labor resources the user can specify deviations from a base availability. For instance, the user may specify that a facility employs 10 operators during the night shift whereas the base availability (for the morning and afternoon shifts) is 20 people. Under such conditions fewer tasks can be performed during the night shift. For more information on the impact of labor constraints on scheduling, please revisit Tutorial-4a.

**Tutorial 6b: Interruptible Operations**

Notice that Friday is underutilized in the previous scenario. The start of the next batch is delayed until the following Monday morning because there is not enough time to complete it by 18:00 (the start of the weekend break). However, if the product is stable and can remain in the storage tank during a weekend break without any deterioration in its quality, one could initiate another batch on Friday and simply interrupt it for the weekend break at 16:00. Such a solution is shown below (it corresponds to file Tutorial-6b.scp). The fifth (magenta) batch is interrupted for the weekend and completed on Monday morning.

For this solution to be generated automatically, the user must specify that the operation “Fill Bags” in P-3 of the 0.5L-Bag recipe is interruptible. This is done through the **Scheduling** tab of the operation’s dialog (see figure below). “Fill Bags” in this case can be interrupted for up to 4 days due to facility closure. Note that the operation “Feed Filler” in P-2 has been declared as ‘slave’ to “Fill Bags” with respect to its duration. In
other words, its duration is set by the duration of “Fill Bags”. For this reason, the “Feed Filler” operation also breaks during the weekend (as shown in the chart above) without having to define it also as interruptible.

Note that in order to avoid undesirable frequent interruptions in an operation, a limit on the number of breaks can be declared and/or a maximum operation duration between breaks can be set.
The combination of flexible shift times and the concept of “Interruptible” operations are powerful tools for generating flexible solutions in multi-product facilities with downtimes.

Tutorial-7: Scaling Recipes and Campaigns

Batches in SchedulePro can be scaled at the campaign and at the recipe level. To scale the batches of an unscheduled campaign (please note that the batches of scheduled campaigns cannot be scaled) start with the file from tutorial 6a. Reset the schedule and add a campaign of 8 batches of the 1L bag recipe as shown below. Set the Scale Factor of the campaign to 1.5 and click on the Recalculate button. The scale factor is defined with respect to the nominal batch size defined at the recipe level. In this case, the nominal size is 10000L so with a scale factor of 1.5 the batch size of this campaign is 15000L. That, in turn, means that all procedure and operation-related amounts or rates set to be scaleable with the batch size will also be scaled by the same factor.
The batch size of a procedure is specified through the Scaling tab of the Procedure Details dialog (see figure below). This is optional information that only plays a role in equipment selection (see later). For instance, it may represent the liquid volume in a mixing vessel. Please note that during batch scale up/down the batch size of a procedure will be adjusted only if the Scales (linearly) with batch size box is checked.

Edit the scaling for procedures P-1 and P-2. Check the box entitled Consider Equipment Size Limits, select “Volume” as the Size Basis and set the size to 10,000L.
Similar variables are available at the operation level to estimate, for instance, the duration of an operation based on the amount of material processed per batch (see figure below). Please note that the batch size of an operation is not necessarily equal to the batch size of its procedure or recipe. For instance, the batch size of a charge operation is simply the amount of material charged by that specific operation. The same procedure may include several other charge operations and therefore the procedure batch size can be quite different from that of one of its operations. The figure below applies to the “Charge Water” operation in P-1.
Scaling recipes during campaign planning is a convenient way of modifying the recipe batch size temporarily without making any permanent changes in the nominal (master) recipe. This method may be preferred when it is required to schedule a large number of campaigns with variable batch sizes.

You can also scale batch sizes at the recipe level in which case this is equivalent to changing the nominal size of that recipe. To do this, it is recommended that you make a copy of the recipe first (otherwise you will lose information on your original recipe). The easiest way to copy a recipe is by selecting it (on the Recipes view) and clicking on the Copy Recipe and Paste Recipe buttons (see figure below). Name the new recipe “1L-Bag-15kL”. Visit the Procedure Detail dialog for its P-1 and P-3 procedures, specify a batch size of 10000 L and check the Scales (linearly) with batch size check box.

Next, scale the new recipe by a factor of 1.5 so that its batch size becomes 15000 L. This is done by selecting the node of the new recipe on the tree to bring up its view and then clicking on the Scale Recipe… button to bring up the Scale Recipe dialog (shown below). Type 1.5 for Scale Factor or 15000 L for Target Batch Size and click OK.

Creating multiple recipes differing in batch size only is generally a good idea when working with a few predefined batch sizes.
Next visit the Size tab of the Equipment Properties dialog (see figure below) of MT-1, MT-2 and two storage tanks (ST-101 & ST102) and specify that they can handle batch sizes between 3000 and 12000 L.

Also, edit the sizes of mixing tank (MT-3) and storage tank (ST-103) that both can handle batches of sizes between 5000 and 20000 L. Finally, make all the tanks available to all the recipes.

If you visit the Main Equipment Pool tab of the Procedure Details dialog of P-1 in the new 15kL recipe, the dialog should look as shown below. Tanks MT-1 and MT-2 are grayed out because they are too small to handle the batch size of the new recipe. When a batch is scaled at the campaign level, these types of decisions (for equipment screening) are made during the scheduling of the batches of that campaign.
The Equipment Occupancy chart below (corresponding to file Tutorial-7 scp) shows a campaign of four batches of the original (10000 L) 1L-Bag recipe (yellow color) followed by four batches of the new (15000 L) 1L-Bag recipe (blue color). Notice that the batches of the new (larger) recipe are restricted to the new tanks (MT-3 and ST-103). Also, notice that the filling of a batch of the new recipe takes longer because the filling time is calculated based on the new batch size (50% larger). Actually, the charging of water in P-1 also takes 50% longer because in this case, the charge time is calculated based on the batch size and charge rate (20 m3/h).
Chapter 5: Creating Recipes

5.2.1 SuperPro Recipe Export ................................................................. 134
5.2.2 SchedulePro Recipe Import ............................................................ 135
5.2.3 Managing the Recipe Database ....................................................... 136
5.3.1 Recipe Classifications and Types .................................................... 136
5.3.2 Adding a Recipe ............................................................................. 137
5.3.3 Recipe Sections ............................................................................ 140
5.3.4 Procedures .................................................................................. 141
5.3.5 Operations .................................................................................. 144
5.4.1 Assigning Operation Types ............................................................ 161
5.4.2 Assigning Flexible Shifts ............................................................... 162
5.4.3 Managing Streams ......................................................................... 163
5.4.4 Editing Labor Requirements .......................................................... 164
5.4.5 Editing Procedure Data ................................................................. 165
5.4.6 Scaling Recipes ............................................................................ 166
5.4.7 Operation Report Text ................................................................. 167
5.5.1 Recipe Check Function ................................................................. 167
5.5.2 Recipe Gantt Chart .................................................................... 168
5.1 Introduction

A recipe in SchedulePro is a description of a batch process to be scheduled. A SchedulePro project may contain any number of recipes. A recipe defines how to execute a series of procedures that utilize various resources (equipment, labor, materials etc.). A batch is a single execution of the procedures defined by a recipe at a specific time with specific resources.

Creating recipes can be performed by either importing existing recipes from SuperPro, or by building them directly in SchedulePro.

5.2 Importing Recipes from SuperPro

A process in SuperPro corresponds to a recipe in SchedulePro.

The simplest way to enter a recipe in SchedulePro is to import one from SuperPro. This is done in the following two-step process.

5.2.1 SuperPro Recipe Export

In SuperPro Designer, open the file containing the recipe to be exported. Be sure that the flowsheet is solved and that the scheduling is correct. Select “File→Export to SchedulePro Recipe DB…”

On the Recipe Export dialog, the following options are available:

**Recipe Name**
This is the name that will be assigned to the exported recipe in the Recipe DB.

**User Name**
This is the name of the recipe’s author/maintainer (optional). This may be changed by selecting menu item “File→Application Settings…” in SuperPro.

**Omit Unscheduled Items**
Check this option to omit unscheduled SuperPro items from exporting. Unscheduled SuperPro equipment is marked with the **Omit from Scheduling** option, which may be modified by right clicking on the desired equipment item in SuperPro and by selecting the “Equipment Data…” item from the popup menu.

**Modified by**
This is the name of the last user to save the recipe.

**On**
This is the date of the last recipe modification.

**Default site for skids and unallocated equipment**
SchedulePro always places equipment items under a facility (site). If none of the equipment items in the SuperPro project is allocated to a site from a user database, SchedulePro will use the supplied site name to generate a default site for this equipment. For equipment items already allocated to a site in SuperPro, the export function will use their existing site name(s). Equipment allocation in SuperPro will not be changed.

**Description**
This field may hold a brief description of the process (optional).

**Keywords**
This is a set of keywords for searching the recipe DB for this recipe. Keywords may be added and deleted on the interface.

### 5.2.2 SchedulePro Recipe Import

Open SchedulePro and select “Recipe ➔ Import from Database…” from the menu. Alternatively, select the **Recipes** node in the tree and click the **Import** button in the recipe list toolbar.

In the dialog that comes up (shown below), select the desired recipe from the list. If there are many recipes, use the search features to narrow the selection.

Multiple selections are allowed. Select **OK** to complete the import.
The recipe will appear in the SchedulePro Navigation Tree on the left hand side of the screen. Selecting the recipe will update the Recipe view on the right pane.

5.2.3 Managing the Recipe Database

The Recipe database is invoked by selecting “Connectivity→Recipe Data/DB Search…” from the main SchedulePro menu. The database can be searched with a variety of options.

- **Name is Any of**
  Search for one or more recipe names.

- **Modified by Any of**
  Search for one or more maintainer names.

- **Main Product is Any of**
  Search for one or more main product names.

- **Has Any of the Selected Keywords**
  Search for one or more keywords.

Unused or obsolete recipes can be deleted from the database by selecting them in the table and clicking on the **Delete Selected Records from Database** button.

5.3 Building Recipes in SchedulePro

Recipes may be created directly in SchedulePro. The sections below outline the basics of creating and editing a recipe manually in SchedulePro.

5.3.1 Recipe Classifications and Types

Recipe types are labels used to label recipes. Recipes may have may be classified in more than one way, for example “vanilla,” “32 oz.” The types and sizes are text labels and do not have any effect on scaling, materials or inventory. They are used with the sequence dependent duration feature that allows an operation’s duration to depend upon the recipe type of the preceding or following activity.

To create a new recipe type, select “Schedule → Recipe Types…” from the main menu. The Recipe Types dialog will appear. There are two default classifications: Product Type and Packing Size. Any number of classification categories may be added. For each classification category, any number of types may be defined.
5.3.2 Adding a Recipe

Recipes may be added in one of the following ways:

Right-click on the Recipes node in the tree and select “Create New Recipe…” from the context menu.

Select “Recipe ➔ Create New…” from the main menu.

Click the Add New button in the Recipe view toolbar.

The following dialog appears.
Creating Recipes

General Tab

The following options are available:

Name
The recipe name must be unique.

Description
A brief description is optional.

Product Type/Packing Size
(Optional) Select a product type option and a Packing Size option. This is only needed for sequence–dependent duration calculations.

Operating Mode
The operating mode is either batch or continuous. This setting controls how SchedulePro manages the default behavior for campaign order amounts. For campaigns of batch recipes, the order amount is used to calculate the number of batches. For a campaign of a continuous recipe, the number of batches is assumed to be equal to 1, and the campaign order amount is used to determine the batch scaling.

Display Color
Select a color that can be used to display the recipe in charts and tables.
Size Tab
Batch size is optional but should be entered if you plan to make different sized batches based on the recipe or if you plan to scale the recipe up or down.

The following options may be entered:

Reference Material
Select a material from the materials list as a main product or type in a material name.

Size Basis
Enter the measurement basis (mass, volume, discrete entities) for the batch size.

Nominal Size and Units
Enter the nominal batch size for the recipe and the corresponding units.

Limiting Equipment (Read Only)
This value is displayed only if equipment sizes and procedure size limits are used. The equipment displayed is the equipment that limits the recipe batch size.

Limiting Procedure (Read Only)
This value is displayed only if equipment sizes and procedure size limits are used. The procedure displayed is batch-size limiting procedure when the largest available equipment is selected.

Main Input/Output Tab
This tab allows the designation of main input or output streams. These values do not affect scheduling in the current version. They are used only for reporting purposes.

Editing Recipe Properties
To access recipe properties select the recipe and choose “Properties…” from the right-click menu. If you select the recipe from the recipe list window, click the Edit Properties button. The dialog that opens is the same as the one used for declaring a new recipe (as described above.)

Deleting a Recipe
To delete a recipe:

Select the Delete button from the Recipe List toolbar.

Select “Delete” from the recipe context (right-click) menu.

Recipe Cut, Copy and Paste
Use the Edit menu or the editing tools from the Recipe List toolbar to cut or copy a recipe. Recipes may be pasted into the same SchedulePro document or into a separate document.

Recipe Sorting
Use the arrow buttons in the Recipe List toolbar to move recipes up or down in the list. Recipe order does not affect scheduling and is provided for convenience.

Recipe Folders
Recipes may optionally be organized into folders. Recipe folders do not affect scheduling and are merely provided for organization.
To create a folder, select the **Recipes** node in the navigation tree and right-click. Select “Add Folder” and enter a folder name. Move recipes to the folder by dragging and dropping the recipe to the desired folder. Right-click on the folder to move it or delete it.

**Recipe Branches**

Branches are a level of recipe organization that is supported in SuperPro Designer. For this reason branches may be optionally viewed in SchedulePro. Select “Edit → Preferences…” from the main menu to toggle the branch view. Branches are a level of organization above sections, but branches do not have any special functionality in SchedulePro.

**5.3.3 Recipe Sections**

**Adding Sections**

Sections provide a way to organize a recipe into logical segments. Equipment suites are defined for the section level.

In order to work with sections, be sure that sections are displayed in SchedulePro. Select “Edit → Preferences…” from the main menu to toggle the section view. Sections are required for recipes that will use suites.

To add a section, right-click on the recipe in the Navigation Tree and select item “Add Section…” from the popup menu.

Enter a name for the section and click the **OK** button to finalize the operation. The new section will be added after the last section and will appear under the SchedulePro Navigation Tree. Selecting the new section item will display the Section Window on the right pane.

To insert a new section, select an existing section, right-click and select “Insert New Section Before…”

**Deleting a Section**

Sections may only be deleted when the recipe has no scheduled batches. To delete a section, right-click on the section node (△) and select “Delete” from the menu. If the section contains procedures, a dialog will appear with the following options:

- **Delete Procedures**
  All the procedures in the section will be deleted along with the section.

- **Move Procedures**
  All the procedures in the section will be moved to the desired section.

**Editing a Section**

Select “Properties…” from the section’s context (right-click) menu.

The **Identification tab** has the following entries:

- **Name**
  The section name.

- **Description**
  A brief description of the section.

The **Suite Allocation tab** has the following entries:
All Procedures Must Use Equipment from the Same Suite
If checked the section runs in a suite. Procedures in the section will only be assigned to equipment that belongs to the same suite.

Selected Suite Must Be Compatible with Suite for Section
If checked, the suite chosen for the section must be compatible with or connected to the suite that is used for the listed section.

Section Copy and Paste
The editing options in the main Edit menu and the section context menu allow for section copying and pasting. A section may be copied and pasted into the same recipe or into a new recipe. When a section is pasted into a new recipe, the procedures in the section are also copied.

Suites
Sections may optionally be assigned to run in a suite. A suite in SchedulePro is a group of equipment items which are used together. Suites are defined for facilities (see chapter 6). When a section is set to run in a suite, all the main equipment for all the section’s procedures will be selected from a single suite. If no single suite can be found with all the necessary equipment, scheduling will fail.

A section may also be set to run in a suite that is connected to or compatible with the suite from some other section. If this option is chosen, SchedulePro narrows the list of possible suites to those that are connected.

The suites, associated equipment, and suite compatibility are defined at the facility level. See section 6.3.12.

5.3.4 Procedures
Procedures represent a major step in a process, e.g. a reaction. Each procedure requires at least one choice for main equipment.

Adding a Procedure
A procedure may be added in a selected recipe in one of the following ways:

Click the Add New Procedure button ( ) or the Insert Procedure button ( ) in the Procedure List view shown on the right-hand side after a recipe is selected from the Navigation Tree.

Select “Add Procedure” from the recipe context (right-click) menu (option available only if recipe has a single section and sections are not shown on the recipe tree).

Select “Insert New Procedure Before Selected...” from the procedure context (right-click) menu accessed by right-clicking on a procedure in the navigation tree.

Adding a procedure, puts the procedure at the end of the list, while inserting a procedure puts it before the currently selected procedure.

Enter a name for the procedure and click on OK to finalize the operation. Procedure names must be unique for the entire recipe.

The new procedure will appear in the tree. Selecting the new procedure item from the navigation tree will display the Procedure view on the right.

While a procedure’s scheduling is dependent on its operations. It is usually convenient to arrange procedures roughly in chronological order.
In the procedure list that appears when you click a recipe or section node in the navigation tree, you may move procedures with the sorting buttons:

Move Up (↑), Move Down (↓), Move to Top (↑), Move to Bottom (↓).

**Editing Procedures**

To edit a procedure, do one of the following:

- Right-click on the procedure and select “Properties” from the context menu.
- Double-click on the procedure in the procedure list.
- Click the Edit Procedure (_modify) button in the procedure list.

The procedure dialog has the following tabs: *Properties, Main Equipment, Work Area* and *Scaling*.

**Properties Tab**

This tab allows the editing of the following data:

- **Name**
  Enter a name that is unique for the recipe. Spaces are allowed.

- **Description**
  Descriptive text used in reports (optional).

- **Number of Cycles**
  This sets the number of cycles in the procedure. This function adds and removes operations to match the desired number of cycles. It will also modify scheduling. Be sure to review the operation scheduling after changing the number of cycles.

- **Include in Activity Report**
  If checked, this operation may be included in the daily activity report.

- **Highlight in Activity Report**
  If checked, this operation may be highlighted in the daily activity report.

**Main Equipment Pool Tab**

SchedulePro requires every unit procedure to have an equipment pool of at least one main equipment item required for the execution of the procedure. If multiple equipment items are assigned, they are treated as alternative units. Equipment is defined within a facility. See Chapter 6 for details.

This tab has the following entries:

- **Facility**
  Select the facility from which to assign equipment.

- **Match Type Check box**
  If checked, only equipment of the selected type will be shown in the available equipment list.

- **Available Equipment List**
  This lists the available equipment in the selected facility. If Match Type is checked, only equipment of the selected type will appear.
Add Button
Adds the equipment selected in the available list to the equipment pool.

Add All Button
Add all the equipment to the pool.

Sorting Buttons
Move Up, Move Down, Move to Top, Move to Bottom. The equipment list is priority ordered, with the first equipment used first when the campaign is scheduled with priority ordering.

Delete Button
The selected equipment is removed from the equipment pool.

Equipment in Pool List
Display the equipment in the main equipment pool.

Shares Equipment Pool with Procedure
If checked, the main equipment pool is set to be equivalent to that of the procedure selected in the pull-down menu to the right. The procedure selection box will be enabled, and the equipment selection tools are disabled.

Must Use the Same Equipment as Procedure
If checked, this procedure is always executed with the same equipment as the procedure selected in the pull-down menu to the right. The selection tools are disabled.

Do not Share Equipment with Other Procedures
If checked, SchedulePro will not assign the main equipment that is selected for this procedure to any other procedure in the batch. A vessel used for reaction, for example, would not be used for a later separation procedure.

Require Staggered Use of All Equipment
If checked, SchedulePro will use all the assigned equipment in turn (staggered mode).

Require Same Equipment for Entire Campaign
If checked, the equipment assigned to the procedure in the first batch will be kept for that procedure in the entire campaign.

Work Area Pool Tab
A work area in SchedulePro represents a building, room, or area where a limited number of unit procedures might take place. Like equipment, work areas are defined within a facility. See Chapter 6 for details. Unlike equipment, the declaration of a work area for a procedure is optional.

The work area tab has the following entries:

Facility
Select the facility from which to assign a work area.

Available Work Area List
The list of available work areas in the selected facility

Add Button
Adds the work area selected in the available list to the pool.
Add All Button
Add all the available work areas to the pool.

Delete Button
Remove the selected work area from the pool.

Sorting Buttons
Move Up, Move Down, Move to Top, Move to Bottom. The work area list is priority ordered with the first work area used first when the campaign is scheduled with priority ordering.

Scaling Tab
SchedulePro can select main equipment based on procedure batch size. The following options are available:

Consider Equipment Size Limits
If checked, SchedulePro will use the procedure batch size to filter the available equipment.

Procedure Size Basis
Select the basis for measuring the procedure batch size (mass, volume or discrete entities).

Procedure Batch Size and Units
Enter the batch size and units.

Set to Recipe Batch Size
The procedure batch size is updated and set automatically to the recipe batch size.

Scales Linearly with Batch Size
If checked, the procedure batch size is set to be proportional to the overall batch size.

5.3.5 Operations
Operations represent processing activities within a procedure. All time duration and scheduling relationships for a recipe are defined in the operations. Resources including materials (in and out), labor, utilities, staff and auxiliary equipment are also specified at the operation level.

Operation Types
Operation types are used to display activities by color in the equipment occupancy chart. Types consist of a name and a color. The following operation types are provided automatically:

Setup
SIP
Process
CIP
Changeover
In addition, user-defined types may be added.

Select “Schedule→Operation Types…” from the main menu to view and manage operation types.

Adding an Operation
An operation may be added in any of the following ways:
Select a procedure to update the Procedure Window on the right. Click the Add New Operation button.

Select “Add Operation…” from the procedure’s context (right-click) menu.

Enter a name for the new operation and click OK to accept it.

**Editing an Operation**

To edit an operation do one of the following:

In the procedure view, select the desired operation from the operation list and click the Edit Operation button.

Double-click on the desired operation.

Right-click on the desired operation and select “Properties…”

The operation properties dialog has multiple tabs for scheduling and resource assignment.

The following buttons navigate among the operations within a procedure:

- **OK Next**. Saves the data and advances to the next operation.
- **OK Previous**. Saves the data and moves to the previous operation.
- **OK Next, same tab**. Saves the data and advances to same tab in the next operation.
- **OK Previous, same tab**. Saves the data and moves to the same tab in the previous operation.

The OK button saves the data and dismisses the entire dialog. The Cancel button dismisses the dialog and discards unsaved changes.

**General Tab**

This tab includes the following entries:

**Operation Name**

The name of the operation should be unique within the procedure.

**Procedure, Section, Branch, and Recipe**

Listed for information only.

**Operation Type**

An optional type designation for reporting and charting purposes.

**Description**

An optional description of the operation.

**Include in Activity Report**

If checked the operation will be included in the daily activity report.

**Highlight in Activity Report**

If checked the operation will be highlighted in the daily activity report.
Activity Report Text and Tags
The edit-box allows a user-defined text string to appear in the Daily Activity Report entry for the scheduled operation. The following substitution tags are replaced with the actual values in the report:

- `<batch>` The batch ID
- `<batchTag>` the batch sequence number. Normally the last part of the batch ID
- `<procedure>` the procedure name
- `<operation>` the operation name
- `<main equip>` the main equipment for the procedure
- `<aux equip>` the auxiliary equipment for the operation
- `<staff>` a list of the staff assigned to the operation
- `<description>` the operation description
- `<comments>` User-entered comments for the scheduled operation

Duration Tab
The duration of the operation is defined through this tab (shown below). It includes the following options:
**Duration Calculated**

The operation has a fixed or variable duration that does not depend on the duration of other operations.

**Constant**

The operation duration includes a fixed term in the specified time units.

**Rate-based Term**

The operation duration includes a variable term based on a processing rate. See below.
Scales with Batch Size
The operation has duration proportional to the recipe batch size.

Setup… Button
If the Rate-based Term checkbox is selected, the duration term is calculated as the ratio of the amount processed by the operation and the processing rate. You should click the Setup… button to open the Rate Parameters dialog and enter the following data related to the duration expression:

Rate Basis
This is the basis on which the rate is measured (mass flow, volume flow, discrete entity rate)

Amount and Units
The amount processed by the operation (numerator in the duration expression). Click on Set to Recipe Amount to set it equal to the recipe batch size.

Amount Scales with Batch Size
If checked the operation amount will be scaled up or down with the batch size.

Rate and Units
The processing rate (denominator in the duration expression)

Rate is Equipment Dependent
If checked, the processing rate is not fixed but determined by the equipment used (provided that the equipment has a rate defined). This allows an operation’s duration to depend on the selected equipment.

Main/Auxiliary Equipment
This entry specifies whether it is the main or the auxiliary equipment that sets the rate.

Rate Percentage
Allows an operation’s actual rate to be less than (or more than) the base equipment rate.

Maximum/Minimum/Nominal Rate
Equipment may have up to three different rate values, so different operations may choose different values.

Duration Equal to Another Operation or Sequence of Operations
The duration of the operation is equal to that of another operation or series of operations.

Single Operation
Duration is set equal to that of another ‘master’ operation.

Sequence of Operations
Duration is calculated from the start of the first operation to the end of the last (defined in the corresponding lists).

Duration Includes Breaks in Master Operation(s)
If selected, the operation duration matches the entire duration of the master operation(s) including any possible processing breaks.

Duration Based on Inventory in Storage Unit
This option allows the operation’s duration to depend on the inventory level in a specified storage unit. You should click the Setup… button to open the Inventory Rate Setup dialog (shown below) and enter the following data.
Storage Unit
Select the storage unit on which the duration should depend.

Hold Until Inventory
Select the comparison operator (≥ or ≤) and the inventory level expressed either as a percentage or as an absolute amount with the corresponding units. When the specified inventory level is reached, the operation ends.

Expiration Period and time units
This value corresponds to the maximum duration of the operation regardless of inventory.

Duration Based on Main Equipment Changeover Matrix
Operations such as cleanout activities may depend on the previous (or next) usages of the equipment. For example, a cleaning step may take longer if the equipment was previously used to make a different product.

Changeover matrices are defined at the equipment level (see Chapter 6). Changeover times are defined for changes from one recipe-type to another. (See 5.3.5) for operation types. Equipment may have multiple changeover matrices. The following data should be entered for this option:

Changeover Matrix
Select the changeover matrix. To be able to use this option, the main equipment pool for the procedure should have been assigned and all the equipment in the pool should have at least one matrix name in common.

Based on Task Before/Based on Task After
Defines whether the operation’s duration should be set equal to the entry in the changeover matrix that corresponds to the previous operation and this operation or this operation and the next operation executed in the same equipment.

Scheduling Tab
An operation’s scheduling options specify when the operation takes place with respect to other operations in the recipe. There are four basic scheduling options (as shown in the figure below):
Relative to Batch Start
The operation starts when the batch starts (plus or minus any time shift). This is the default for the first operation in any procedure.

Operation Starts with Respect to Another Operation in This Procedure
This option requires a selection of an operation from within the same procedure as well as the selection of relationship link. The possible links are:

(SS) The operation starts at the start of the selected operation, i.e. start-to-start.
(FS) The operation starts at the end of the selected operation, i.e. finish-to-start or sequential. This is the default for operations after the first operation.

(FS) The operation finishes at the start of the selected operation, i.e. start-to-finish or backward scheduling.

(FF) The operation finishes at the end of the selected operation, i.e. finish-to-finish.

Operation Starts with Respect to Another Operation in Another Procedure.
This option requires the selection of an operation in any procedure except the current procedure. A tree selection appears to allow selection of operations in other procedures. The relationship links are the same as those listed above.
Creating Recipes

Time Shifting/Interruptibility

Fixed Time Shift
This sets a time delay from the link. A positive shift is a delay and a negative shift is a lead regardless of link type.

Flexible Time Shift
A flexible time shift is a delay or lead that is applied only if a resource is unavailable. The value is the maximum shift to apply. At least one resource category must be selected.

Is Interruptible
If checked, breaks could be introduced within an operation’s duration when any of the required resources is not available. The provided duration and units define the maximum allowable duration of all breaks. Options to also limit the number of breaks and the minimum operation duration between breaks are also provided.

Can Delay/Break for Facility Closure or Equipment Availability or …
When a flexible shift is allowed or an operation is declared as interruptible, these options control the reasons (unavailability of what resources) for which a flexible shift or break may be applied. At least one of these options must be checked if flexible shift or interruptibility is allowed.

Advanced Scheduling Options
Aside from the above four basic scheduling options, SchedulePro allows for multiple scheduling links within the same batch or between two different batches. When SchedulePro calculates the batch timing, the latest scheduling link is applied. There are two parts to an advanced scheduling link: the “usual” operation links and information about the reference batch.

To add advanced scheduling links, click on the Advanced… button to open the Additional Scheduling Constraints dialog which displays the additional link list will. If there are existing additional scheduling links, the number of links is displayed.

Click the Add New button to add a new link through the Additional Scheduling Reference dialog (shown below). The following data should be declared in this dialog.
Creating Recipes

Within this Batch
This option indicates that the scheduling link should reference an operation within the same batch.

Previous Batch with Recipe
This option creates a link to the previously scheduled batch of the specified recipe.

Previous Batch with Recipe and ID
This option creates a link to the batch with the specified batch ID.

Append Sequence Number/Increment Every/Increment By/Start At
These options together allow the reference batch to depend on the current batch. The ID of the reference batch for the link is ID-N, where ID is the specified batch ID and

\[ N = \text{start-at} + (\text{increment-by}) \times (\text{Batch Index} / \text{Increment Every}) \]

Only the whole number quotient of (Batch Index/ Increment Every) is considered. Batch Index is a zero-based batch count.

Examples:
For ID = “My Product”, increment every = 1, increment –by = 2, Start At = 0

Note: The increment-every and increment-by values must be at least 1.
Reference Procedure
This is the procedure for the scheduling link.

Reference Operation
This specifies the linked operation.

Start Type
This specifies the type of scheduling link (start-to-start, start-to-finish, finish-to-start).

Outages
These are options that control the scheduling of an operation within periods of facility or equipment outages. As a rule, no processing task can be scheduled while the relevant facility or equipment are not available. The following options are exceptions to this rule to accommodate tasks such as equipment cleaning that could happen after normal operating hours.

Operation Can Be Scheduled within Periods of Facility/Equipment Outages
If checked, the operation can still be executed even when the facility or equipment are unavailable.

Ignore Outages Only If Operation Is Started During Normal Operating Hours
This option becomes active only when the previous option is selected. If checked, it allows the operation to be executed during outages but only if it has already started during non-outage times. In other words, the operation cannot be executed entirely within an outage period.

Auxiliary Equipment Tab
An operation may be assigned an auxiliary equipment unit that is used only for the duration of that operation, e.g. a cleaning skid. SchedulePro allows a pool of auxiliary equipment to be declared. In SchedulePro, any equipment may be assigned as auxiliary equipment (even while being used as main equipment by some other procedure). An operation, however, cannot claim some equipment for auxiliary use while the same equipment is used by its own procedure.

The following data are set within this tab.

Any Equipment/Specify Type
Select the “Any Equipment” option to see all the equipment in the selected facility. Select the “Specify Type” option to view only equipment of the type selected from the list.

Available Equipment
Select from the list a facility to see all its equipment in the available equipment list.

Add ( ) button
Once one or more equipment are selected in the available list, click on this button to add them to the pool of candidate equipment.

Add All ( ) button
Click on this button to add all the available equipment to the pool.

Included Equipment
This is the pool of candidate equipment. Use the buttons in the list toolbar to delete equipment from the pool or reorder the list. SchedulePro assigns auxiliary equipment to operations based on their priority in the equipment list so the order is important.
Use All Compatible
If checked, all the auxiliary equipment in the pool will have to be assigned to the operation so they all have to be available during the operation duration. In this case, the ordering of the pool is immaterial.

Material Inputs Tab
Material inputs may be used to track materials that enter the process. SchedulePro does not attempt to balance material inputs and outputs. A material input is represented by a stream. Materials should be defined before adding a material input stream. See Chapter 6 for more information about materials.

Each operation may have multiple material input streams, and each stream may bring into the process a single material or a mixture of materials.

Material input streams may be added, deleted, copied, pasted and edited through the Material Inputs tab. To add a material input, click the Add New button. The stream dialog shown below will appear.

The following options are available:

Name
Enter the name of the process input stream.

Type of Material
Specify the stream contents as bulk or discrete.

Amount
Specify the exact amount in the specified units.
Flowrate
Instead of an absolute amount, enter a rate. The amount is calculated as \((\text{duration} \times \text{Flowrate})\).

Scales with Batch Size
If checked, the provided amount or flowrate will be scaled with the implemented recipe batch size.

Is Drawn from Storage Unit
Specify whether the stream source is a storage unit. If a storage unit is chosen the stream composition will be set to that of the storage unit. See Chapter 6 for more information about storage units.

Storage Unit
An input or intermediate storage unit must be specified if the Is Drawn from Storage Unit box is checked. Storage units allow SchedulePro to track the amount of material over time. See Chapter 6 for more information about storage units.

Specify Final Storage Amount — (Available only if a storage unit with inventory tracking is defined for the stream.) This is a third option for defining the stream amount; in this case, the amount is the difference between the volume of the specified storage unit and the specified final amount.

Composition
Material streams require a composition. To specify the composition, select a component and click the Add button. The first component is added at 100 mass %. Subsequent components will be added at 0 mass %. Fill out the values in the percentage column to change the percentages. The user must ensure that they sum to 100%. Composition is not editable if the input stream is drawn from a storage unit.

Density
The stream density in the specified units.

Material Outputs Tab
Material outputs in SchedulePro are only used for materials that exit the process. Materials should be defined before adding a material output stream. See Chapter 6 for more information about materials. A material output may be classified as a waste, a product or an intermediate. The classification affects the type of storage unit that may be used with the stream. An operation may have several output streams and each stream may contain multiple materials or components.

Material output streams may be added, deleted, copied, pasted and edited through the Material Outputs tab.

To add a material output to an operation, click on the Add New  button. The following options are available in the output stream dialog that comes up:

Name
The name of the output stream

Type of Material
Specify the stream contents as bulk or discrete.

Amount
Specify the exact amount in the specified units.

Flowrate
Specify the Flowrate instead of the amount. The amount is calculated as \((\text{Flowrate} \times \text{duration})\).

Scales with Batch Size
If checked, the provided amount or flowrate will be scaled with the implemented recipe batch size.
Is Deposited to Storage Unit
If checked, the stream destination is a storage unit.

Storage Unit
A storage unit must be specified if the Is Deposited to Storage Unit box is checked. Storage units are listed by facility. Only storage unit whose type is consistent with the stream class (see below) will be listed.

Stream Classification

Specify Final Storage Amount—(Available only if a storage unit with inventory tracking is defined for the stream.) The amount is the difference between the volume of the specified storage unit and the specified final amount.

Composition
Material streams require a composition. To specify the composition, select a component and click the Add button. The first component is added with at 100 mass %. Subsequent components will be added at 0 mass %. Fill out the values in the percentage column to change the percentages. The user must ensure that they sum to 100%.

Density
The stream density in the specified units

Labor Tab
Labor resources in SchedulePro represent pools of a specific labor type. Labor resources are defined for a facility. See Chapter 6 for details. To assign labor resources to an operation, select the Labor tab from the operation resources dialog.

Available Labor
Select a facility. The labor in the Available list is limited to the labor types in that facility.

Add Button
Use this button to assign the labor resource selected in the Available list. The Resource Amount dialog will pop up so that the desired labor rate (labor-hrs/oper-hr or number of persons) can be specified. This rate can be declared as scalable with the batch size using the corresponding check box.

Included Labor
Once a labor resource is selected in the Included list, use the Remove Labor button to delete that labor resource. Use the Edit Amount button to edit the labor use rate.

Staff Tab
Staff Labor resources refer to specific individuals who may be assigned to an operation. Staff resources must be defined within a facility. See Chapter 6 for details.

The staff tab contains the following elements:

Available Staff
Select a facility. The staff members in the Available list are limited to those in that facility.

**Add ( ) Button**
Use this button to assign the staff resource selected in the Available list.

**Add All ( ) Button**
Use this button to assign all the staff resources shown in the Available list.

**Included Staff**
This is the list of staff members who may perform the operation. The list is in order of scheduling priority. The toolbar allows deletion and re-ordering.

**Number Required (“Use Persons”)**
This is the number of individuals required to perform the operation. The number must be less than or equal to the number of individuals available.

**Use All**
If this is checked, all the staff members in the Included Staff list will be assigned to the operation.

**Heating / Cooling Tab**
Heating and cooling utilities are specified in terms of a flow rate of a heating or cooling agent. If multiple heating or cooling entries are specified, SchedulePro assumes that all of them are used each time the operation is executed. Heating or cooling utilities must first be defined in a facility before they can be added to an operation. See Chapter 6 for details.

The following entries appear on the tab:

**Available Utilities**
Select a facility. The utilities in the Available list are limited to the heating and cooling agents in that facility.

**Add ( ) Button**
Use this button to assign the utility selected in the Available list. The Resource Amount dialog will pop up so that the desired utility rate can be specified. This rate can be declared as scalable with the batch size using the corresponding check box.

**Included Utilities**
Once a utility is selected in the Included list, use the Remove Utility ( ) button to delete that utility resource. Use the Edit Amount ( ) button to edit the utility rate.

**Power Tab**
Multiple types of electrical power draws may be specified for an operation. SchedulePro assumes that all of them are used each time the operation is executed. In order to add a power utility usage to an operation, the power utility must first be defined in a facility. See Chapter 6 for details.

The following entries appear on the tab:

**Available Power**
Select a facility. The power resources in the Available list is limited to the power types in that facility.

**Add ( ) Button**
Use this button to assign the power resource selected in the Available list. The Resource Amount dialog will pop up so that the desired power rate can be specified. This rate can be declared as scalable with the batch size using the corresponding check box.

**Included Power**

Once a power resource is selected in the Included list, use the Remove Power (_remove_) button to delete that power resource. Use the Edit Amount (edit amount) button to edit the power rate.

**Transfer Panels Tab**

Transfer Panels are specialized devices used in certain plants (see Chapter 6 for details). They work like material “switchboards” to allow material to be transferred from one equipment unit to another. Each such transfer may involve one or more transfer panels.

The execution of a material transfer through a transfer panel involves two ports (physically the fittings to which pipes or tubes are connected) and a bridge (the piping between the ports). Additional secondary ports and bridges may also be specified.

The definition of the transfer panel usage by an operation involves the specification of both the transfer panels that will be used as well as the alternative ‘paths’ (i.e. combinations of ports and bridges) that this operation could use. SchedulePro will schedule one path for each panel used.

The following options are available in the Transfer Panels Tab (shown below):

**Available Transfer Panels**

Select a facility. The transfer panels in the Available list are limited to those declared in that facility.

**Add (add) Button**

Use this button to assign the transfer panel selected in the Available list.

**Utilized In Sequence Transfer Panels**

Display the list of all transfer panels to be scheduled. Once a transfer panel is selected, use the Remove Transfer Panel (remove) button to delete that transfer panel.

**Alternative Pathways List**

Display the allowed transfer paths (combination of ports and bridges) for the selected transfer panel. SchedulePro will schedule one of the pathways for each execution of the operation. SchedulePro considers pathways in the order they appear in the dialog, i.e. priority is given to the paths that appear at the top.

**New Path (new path) Button**

Add a new transfer path for the selected panel. A default path (consistent with the transfer panel’s connectivity) will be inserted in the table. Every declared path can include up to two components from each topological group (Port1, Port2 and Bridges). To edit a path, first select the primary bridge to be used and then the connected ports. Note that only the ports that can be connected to the selected bridge will show up in the ports list so that the path is consistent with the transfer panel’s declared connectivity. With the exception of the primary bridge column, all other columns can be left blank in a path. The secondary bridge selection does not pose any constraint on the admissible ports list. These are defined by the primary bridge.
Creating Recipes

160

Add All Valid Paths ( ) Button
Introduce all possible paths for the selected transfer panel based on its connectivity.

Delete ( ) Button
Delete the selected pathway from the alternative pathways list.

Delete All ( ) Button
Delete all the alternative pathways.

Move up and Move down ( , ) Buttons
Change the priority order of the selected path.

**Operation Links**

Right-click an Operation and select “Links” to view a diagram showing all the operations that have scheduling links that depend on the selected operation.

### 5.4 Editing Data for the Entire Recipe

As documented in the previous sections, all processing specifications are done at the procedure and the operation level. However, for the user’s convenience, SchedulePro offers functionality that allows certain types of data to be defined or edited globally at the recipe level. The following subsections present the related functionality.

To access the presented dialogs, first select a recipe in the Navigation Tree and either right-click on it to invoke the recipe pop-up (context) menu or, (for some of the options) use the toolbar buttons shown on the right-hand side recipe view that corresponds to the selected recipe.

#### 5.4.1 Assigning Operation Types

Operation types can be used to group operations for viewing or reporting purposes. Types can be assigned to operations for the entire recipe through the *Operation Types for Recipe* dialog (shown below). To access this dialog, select item “Assign Operation Types…” from the recipe popup menu or click the relevant button in the recipe view.
The recipe operation types dialog lists in a table all operations of the recipe per procedure and allows the specification of the type for each operation separately through a list of predefined types shown under the Type column. Multiple simultaneous assignments can also be done using the toolbar buttons at the top of the table. You can make multiple selections by checking the buttons in the Select column and click the Tag Selected Operations button to specify a common type for all. Alternatively you can click on the Tag Multiple Operations button and in the dialog that comes up set globally the type for recipe operations that use the same equipment or have a common string in their names (both criteria are indications that the relevant operations are of the same type).

5.4.2 Assigning Flexible Shifts
For recipes with potential flexible shifts on many or all operations, it may be more convenient to schedule the flexible shifts for the entire recipe.

To assign flexible shifts for a recipe, select item “Set Flex-shifts (Breaks) for Recipe” from the popup menu.
Creating Recipes

The recipe flex-shift dialog has the following options.

**Max Duration**
This is the maximum duration of the flexible shift in specified units. The value must be greater than zero.

**Delay for Facilities**
If checked, operations will break for facility down time.

**Delay for Equipment**
If checked, operations will break for equipment availability.

**Selected Procedures**
Select the procedures whose operations will be assigned the flexible shift. The buttons at the top of the list allow quick selection and de-selection of all displayed procedures.

**Operations Criteria**
Select whether the flexible shift will be assigned to all operations in the selected procedures or only to operations that use a certain type of auxiliary equipment (such as “CIP-skid”).

5.4.3 Managing Streams
Even though material inputs and outputs are specified at the operation level, it can sometimes be advantageous to manage them at the recipe or the project level. The stream manager through the **Recipe Input/Output Material Streams** dialog provides such an overall view of all streams.

To access this dialog, select “Recipe→Streams…” from the main menu or “Edit Streams…” from the recipe context menu.
The following options are available in the stream manager dialog:

**In Recipe/All Recipes**
Limit the streams displayed to a selected recipe or view all streams for all recipes.

**Input/Output/Intermediate**
The stream manager will display only streams of the type(s) checked.

**Edit/Delete Button**
Select a stream from the table to either edit its data or delete it from the owner operation.

### 5.4.4 Editing Labor Requirements
Labor assignments for the entire recipe can be displayed in a single table in the *Labor Assignments for Recipe* dialog.

Select “Edit Labor Requirements…” from the recipe context (right-click) menu or click on the relevant button in the recipe view.
The recipe labor table displays a row for every operation and a column for every labor type defined in the facilities. The amount of each labor type required per operation may be entered directly in the table.

### 5.4.5 Editing Procedure Data

The *Recipes Procedures Overview* dialog allows the display and editing of the data for all procedures in a recipe.

To access this dialog, select “Procedures Overview...” from the recipe context (right-click) menu or click on the relevant button in the recipe view.

The dialog (shown below) displays in a table all recipe procedures along with some key data. The “Equipment Pool” column shows all equipment assigned in each procedure’s pool.

Select a table row corresponding to a procedure and click on the **Edit** button to view or modify the properties of that procedure.
5.4.6 Scaling Recipes

A recipe may be scaled up or down. Scaling affects the following items in a recipe:

Stream amounts that have the **Scales with Batch Size** box checked

Durations for rate-based operations if the amount is scalable

Equipment selection for procedures with a scalable procedure batch size

To scale a recipe select “Scale Recipe…” from the recipe context (right-click) menu or click on the relevant button in the recipe view.
The following options are available:

**Scale Factor**
If selected, the recipe will be scaled by the specified factor.

**Target Batch Size**
If selected, the scaling factor is the ratio of the specified new batch size to the previous batch size. This option is only available if the recipe has a main product and batch size already defined.

5.4.7 Operation Report Text
To modify or set text string for all the operations in a recipe select “Edit Operation Report Text…” from the recipe context menu. The dialog provides the choice of setting a new value for the text everywhere or globally replacing text.

5.5 Validating a Recipe
Before a recipe can be successfully scheduled, it must be complete. In particular, the following items should be checked:

- All procedures must be assigned at least one piece of primary equipment
- Each procedure must have at least one operation
- The duration and start time specifications for all operations must have been defined
- All scheduling links should be traceable to the start of the batch – no circular references.

5.5.1 Recipe Check Function
Select “Check Recipe…” from the recipe context menu. If the recipe has problems, the **Recipe Incomplete** button will appear in the recipe view. Click on this button to get an explanation of the problem.

Note that SchedulePro can not estimate the cycle time for incomplete recipes. Any problems should be fixed before a recipe can be scheduled.
5.5.2 Recipe Gantt Chart

SchedulePro can display a Gantt chart for a recipe before it is actually scheduled. Select “Recipe Gantt Chart…” from the recipe context menu or select the Gantt chart button from the recipe view. The Gantt chart displays even if some procedures are missing equipment assignments. However, it will not show if there are scheduling specification missing or there exist circular references in operation timing.
Chapter 6: Declaring Resources

Chapter 6: Declaring Resources ............................................................... 170

6.1 Introduction ......................................................................................... 171

  6.1.1 Used-By Feature for Resources .................................................... 171

6.2. Material Resources ........................................................................... 171

  6.2.1. Adding Material ................................................................. 172

  6.2.2 Editing Material ..................................................................... 173

6.3. Facility Resources ............................................................................ 173

  6.3.1 Adding a Facility .................................................................... 173

  6.3.2. Editing a Facility ............................................................... 173

  6.3.3 Facility Resource Calendar .................................................... 173

  6.3.4 Labor Resources .................................................................. 176

  6.3.5 Staff Resources ..................................................................... 177

  6.3.6 Utility Resources .................................................................. 178

  6.3.7 Equipment .............................................................................. 180

  6.3.8 Work Areas ........................................................................... 185

  6.3.9 Transfer Panels ................................................................. 186

  6.3.10 Storage Units ....................................................................... 190

  6.3.11 Material Supply Systems ..................................................... 196

  6.3.12 Suites ................................................................................. 198
6.1 Introduction

Scheduling tasks in SchedulePro make use of resources. Procedures use equipment and work areas, operations use material, labor, utility, equipment and storage resources.

All resources except materials are organized into facilities. A SchedulePro project may contain any number or facilities. Facilities contain labor, utilities (heating, cooling and power), equipment, work areas, transfer panels and storage units.

Procedures must use equipment resources for their execution. The use of all other resources for the execution of recipes is optional. SchedulePro tracks occupancy, consumption and/or inventory for all declared resources used in the schedule. Limits on the availability of selected resources can optionally be used as constraints in scheduling the tasks that use them.

Resources exist independently of the recipes that use them, so it is advantageous to declare them before creating recipes in a scheduling project.

6.1.1 Used-By Feature for Resources

Resources used in recipes cannot be deleted and some of their data may also be non-editable. Only after the resource is disengaged by all its users, it can be deleted. It is therefore useful to be able to see all recipe tasks that use a resource. This is possible by using the “Used-By” feature. In all resource lists views shown in the remainder of this chapter, there is a Used By ( ) button; when clicked, it will display a dialog (like the one shown below) listing all users of a selected resource. The same dialog can also be accessed through the context (right-click) menu using the “Used By…” menu item.

The list of resource users may be narrowed by selecting a recipe, section or procedure.

6.2. Material Resources

In SchedulePro, materials are used for the definition of streams consumed or generated by operations. Material resources may be used to represent the following:
Declaring Resources

Bulk materials consumed or generated
Discrete items, e.g. bottles, consumed or generated
Materials consumed to generate utilities, e.g. water for steam

Click on the Materials node in the left-hand side Navigation Tree. The Materials list view will show on the right-hand side window allowing you to add, edit or delete materials.

6.2.1. Adding Material

Materials are added from the main SchedulePro menu using the item “Resources→Add Material…”, from the material context menu by right-clicking on the Materials node, or by clicking the Add New Material (S) button from the toolbar in the Materials list view.

The Material Properties dialog has the following options:

Material Name
Material names must be unique. A material may be renamed at any time.

Trade Name
This field is optional and is not used in scheduling.

Supplier
This field is optional and is not used in scheduling.

Bulk/Discrete
Indicates whether the material is bulk material (measured in mass or volume) or discrete (measured in number of items.)

Pure Component/Stock Mixture
Applies to bulk materials only; specifies whether the material is a pure substance or a mixture of other materials.

Mixture Composition Button
Applies only to stock mixtures; allow the user to set the composition for the mixture.

Density
Sets the density of bulk materials.

Purchase Cost
The price of the material if used in an input stream.

Sales Price
The selling price of the material if it appears in a product stream.

Basis
Sets the measurement basis by which the material is purchased or sold. The basis is consistent with the material type specification (bulk or discrete).

Unit
Sets the reference unit (appropriate for the basis) for the pricing.
6.2.2 Editing Material

To edit a material, select the **Materials** node in the Navigation Tree to enable the Materials list view and select the material from the list (the whole row should show selected on the table). Click the **Edit Material** button to bring up the **Material Properties** dialog. (See “Adding a Material”.)

Alternatively, double-click on the table row for the desired material.

The toolbar on the Materials view has also buttons for deleting, cutting, copying and pasting a material resource. Some of these options can also be accessed in the material context (right-click) menu.

Materials may be cut copied and pasted between projects. A material can be deleted only if it is not used in any streams.

6.3. Facility Resources

All resources other than materials are organized in **facilities**. The sections below outline the basics of creating and editing a facility and its resources.

6.3.1 Adding a Facility

Facilities are added from the “Resources→Add Facility…” item in the SchedulePro main menu or by clicking the **Add New Facility** button in the toolbar on the Facilities list view.

The following options are available on the dialog that pops up:

- **Name**
  Facility names must be unique in a project.

- **Description**
  (Optional) Descriptive text.

- **Location**
  (Optional) The physical location, e.g. city. This is only used for reporting purposes.

6.3.2. Editing a Facility

To edit a facility, select the **Facilities** node in Navigation Tree to enable the Facilities list view and select the facility from the list (the whole row should show selected on the table). Click on the **Edit Facility** button to bring up the **Facility Properties** dialog (the same dialog used for adding a facility).

Alternatively, double-click on the table row for the desired facility.

The toolbar on the Facilities view has also buttons for deleting, cutting, copying and pasting a facility. Note that a facility can be deleted only if its resources are not used in any recipes. Some of these options can also be accessed in the context menu that pops-up if you right-click on the desired facility. The facilities toolbar and context menu also contain options for editing facility calendar outages and specifying facility suites. These options are explained in following sections.

6.3.3 Facility Resource Calendar

In SchedulePro, facilities and all resources (except utilities) may be declared to be unavailable at certain times. Each of these resources has an **availability calendar**.

Labor resources are assumed always available at the amount specified per labor type. The calendar can be used to declare deviations from standard availability (to declare, for example, a reduced number of workers in the night shift, over the week-ends etc.)
The calendar for storage units can be used to declare external (i.e. non-related to scheduled tasks) receipts or discharges of material to or from these units.

Facility downtimes prevail over all other resource downtimes, i.e. if a facility is declared unavailable for a period, all its resources are also assumed unavailable so no tasks using this facility or any of its resources can be scheduled during this period (unless an operation is declared as being able to be executed over periods of outages – see Chapter 5.)

**Accessing the Calendar**

To access the calendar of a facility or resource, first enable the relevant window where the resource is listed (e.g. the Labor Window), select from the table the resource of interest (the entire table row should show selected) and then click on the calendar button. Alternatively, click on the same button that typically shows on the first tab of each resource’s property dialog (see relevant section for each resource on this chapter).

The dialog that comes up contains a real-time calendar displaying one month at a time. Use the << and >> buttons at the top of the calendar to navigate forward or backward in time.

**Declaring Calendar Events**

To declare an event (e.g. outage, receipt of material) that is scheduled to occur on a specific day, right-click on this day on the calendar dialog and select the option “Add a new entry…” from the pop-up menu. Note that calendar events can be declared only at dates after the schedule’s start time.

The following options are available at the *Resource Calendar Entry* dialog:

**Description**
A name for the type of entry. A default is provided.

**Start Date and Time**
The start time of the event.

**Duration**
The duration of the event.
Declaring Resources

End-Time of First Occurrence
Alternative way to enter the duration.

Repeat Pattern
The base repeat units for the event. Use “One Time” for one-time events; otherwise the event will be repeated at the button frequency (daily, weekly, monthly or annually.)

Every
The repeat interval in terms of the base repeat pattern units.

Repeat Until
The end time for a repeating event. By default, this is set to the end of the scheduling horizon.

The displayed gray bars in the calendar window represent the specified events (outages etc.). Click OK on the calendar dialog to save the definition of outages for the edited facility or resource.
Editing and Deleting Calendar Events

From the Context Menu
Access the appropriate calendar view.

Right-click on the event’s gray bar. Select “Properties…” to edit the event. Select “Delete All Instances of this Entry” to delete the event and all its occurrences throughout the scheduling horizon.

From the Day One Menu
This method is easier to use if there are many overlapping events.

Access the appropriate calendar view.

Select the first day of the event and right-click in a clear area to bring up the context menu. If there are multiple events for this day, the menu that pops-up will contain the options "Edit Entries" and “Delete Entries”; select the former to modify an existing entry or select the latter to delete an entry.

A dialog will appear with a selection of entries to edit or delete.

6.3.4 Labor Resources
To add a labor resource, select the Labor node for the facility of interest to activate on the right-hand side the Labor list view associated with that facility. Right-click on the node and select the “Add Labor…” option or click the Add New Labor button in the Labor view toolbar.

To edit a labor resource, select it from the list in the facility’s Labor view (the whole row should show selected on the table). Click the Edit Labor button. Alternatively, double-click on the table row for the desired labor resource.

The Labor Properties dialog that will show up contains the following options:

Name
The labor resource name should be unique within the hosting facility.

Facility
This is the name of the facility where the labor resource belongs (non-editable).

Description
(Optional) Provide some descriptive information about this labor resource.

Unlimited
If checked, the labor is assumed to have unlimited availability.

Base Availability
If not unlimited, this is the number of workers of this type that are typically available in the parent facility. This number will be used by the scheduler as an optional constraint when scheduling tasks. See Chapter 7 on how to activate/deactivate the optional labor constraints.

Base Hourly Rate
The hourly rate is the labor rate used for cost calculations. This value should include overhead.

The toolbar on the Labor list view has also buttons for setting calendar availability, displaying the labor use profile, deleting, cutting, copying and pasting a labor resource. Some of these options can also be accessed in the context menu that pops-up by right-clicking on the desired labor resource. Select the “Used by…”
option from this menu to view all operations that make use of this labor resource. Note that a labor resource

can be deleted only if it is not used by any operations.

Labor Availability

Calendar-based labor availability is entered in terms of deviations from base availability. Click the calendar

button on the Labor view toolbar or through the Labor Properties dialog to enter labor availability
deviations. Select the starting date for the deviation, and select “Add a New Entry” from the context menu.
The Resource Calendar Entry dialog (explained earlier) will come up. Enter the duration and repeat
information (if any), and the amount of persons of the relevant labor type for the specified period. The
amount may be less than or greater than the base availability.

6.3.5 Staff Resources

Staff resources in SchedulePro represent individuals who might be assigned to an operation. Staff resources
are distinct items, like equipment and unlike the pooled labor resources. Each staff resource has a calendar
that may be used to enter the work schedule.

To add a staff resource, navigate to the desired facility in the navigation tree and select the Staff node.
Right-click on the node and select the “Add Staff…” option or click the Add New Staff button in the
Staff view toolbar. Specify a unique name for the new staff resource.

To edit a staff resource, select it from the list in the facility’s Staff view (the whole row should show
selected on the table). Click the Edit Staff button. Alternatively, double-click on the table row for the
desired staff resource.

The Staff Properties dialog that will show up contains the following options:

Name
This is the name of the staff resource. The name must be unique in the facility. To avoid confusion in charts
and reports, the name should be unique for the entire project.

Description
This is an optional brief description of the staff resource.
Declaring Resources

**Resource Calendar**
Click on this button to enter the dates and times when this staff resource is not available.

**Hourly Usage Rate**
The staff hourly usage rate is the staff cost used for economic calculations. This figure should include overhead.

**Can Execute Multiple Parallel Operations**
Indicates that the staff member may be assigned to multiple activities simultaneously. The number of concurrent activities is set by the **Maximum Number of Parallel Tasks**.

**Display in Charts**
If checked, the staff resource will be displayed in charts.

6.3.6 Utility Resources
Utilities in SchedulePro are heating/cooling agents and electrical power. All utility usages are specified at the operation level in a recipe.

Heating and cooling resources may be optionally associated with a material resource. The association may be in terms of raw material consumption and/or waste material generation. For example, steam generation may require the consumption of purified water and the generation of waste water.

To add a utility resource, navigate to the desired facility in the navigation tree and select the **Utilities** node. Right-click on the node and select the “Add Utility…” option or click the **Add New Utility** button in the Utilities view toolbar. Specify a unique utility name, the utility type and the availability rate (see below).

To edit a utility resource, select it from the list in the facility’s Utilities view (the whole row should show selected on the table). Click the **Edit Utility** button. Alternatively, double-click on the table row for the desired utility resource.

The **Utility Properties** dialog that will show up contains the following options:
Properties Tab

Name
The utility resource name should be unique within the parent facility.

Facility
This is the name of the parent facility where the utility resource belongs (non-editable).

Description
(Optional) Provide some descriptive information about this utility resource.

Utility Type
The option buttons select the type of utility (heating, cooling or electrical power).

Unlimited
If checked, the utility is assumed to have unlimited availability.

Rate Limit
If not unlimited, this is the limiting rate by which this utility is available in the facility. This number will be used by the scheduler as an optional constraint when scheduling tasks. See Chapter 7 on how to activate/deactivate the optional utility constraints.

Cost
The utility cost in the specified units.
Material Tab

Associate Utility with Composition Material
If selected, a material can be specified to associate with this utility.

Material Name
Select the associated material from the list of declared bulk materials (pure components or mixtures).

Utility Generation Contributes to Raw Material Consumption
Select this option to specify the amount of material needed for every mass unit of utility generated. Optionally, also select a Material Supply System where the associated material is drawn from.

Material Drawn from Supply System
Optionally, select a Material Supply System where the associated material is drawn from.

Utility Consumption Contributes to Waste Generation
Select this option to specify the amount of material that ends up as waste for every unit of utility used by scheduled operations.

Waste Type
Specify the type of waste that this utility generates.

Waste Deposited to Storage
Optionally, select this option to specify the Storage Unit where the generated waste is deposited.

The toolbar on the Utilities list has also buttons for displaying the utility use profile, deleting, cutting, copying and pasting a utility resource. Some of these options can also be accessed in the context menu that pops-up by right-clicking on the desired utility resource. Select the “Used by…” option from this menu to view all operations that make use of this utility resource. Note that a utility resource can be deleted only if it is not used by any operations.

6.3.7 Equipment

Equipment resources represent the physical objects that are required to execute procedures and/or operations. Every procedure must have a main equipment unit. Individual operations may require additional auxiliary equipment. By default, equipment may be used for only one task at a time.

To add an equipment resource, navigate to the desired facility in the navigation tree and select the Equipment node. Right-click on the node and select the “Add Equipment…” option or click the Add New Equipment (.addButton) button in the Equipment view toolbar. Specify a unique equipment name, and optionally the equipment type and a short description.

To edit an equipment resource, select it from the list in the facility’s Equipment view (the whole row should show selected on the table). Click the Edit Equipment (editEquipmentBarButton) button. Alternatively, double-click on the table row for the desired equipment resource.

The Equipment Properties dialog that will show up contains the following options:

Properties Tab

Name
The equipment name should be unique within the parent facility.
Declaring Resources

Type
(Optional) Equipment types may be defined as needed. This list displays the previously defined types. Alternatively the list allows editing so new types can be defined as needed.

Description
(Optional) Provide some descriptive information about this equipment.

Facility
This entry displays name of the parent facility where the equipment belongs (non-editable).

Suite
If suites have been defined for the facility, the equipment suite assignment may be edited here.

Availability Calendar Button
Press this button to specify equipment outages and downtimes.

Parallel Task Execution
Select this option to specify if the equipment can handle multiple parallel tasks simultaneously (by default, all equipment are assumed to be able to handle only one task at a time). If the equipment has a size limitation (see Size Tab later in this section), its size will be used as a constraint to limit the number of parallel tasks that can be executed in this equipment. This number can also be set explicitly, if the option Has Limit on Number of Parallel Uses is checked. Both limits (size-based and the user-specified maximum number of parallel uses) will be respected by the scheduler.

Display in charts
If checked, this equipment will be shown in the equipment occupancy and utilization charts.

Cleanout/Changeover Tab
Declaring Resources

Setup/Precleaning Time
This time may be used for pre-campaign equipment cleaning and/or setup.

Cleanout Time
This time may be used for post-campaign equipment cleaning.

Changeover Time
This time may be used for post-campaign equipment changeover.

Initial States
For each changeover classification, enter the initial state for the equipment.

Cleaning/Changeover Matrices
A matrix of changeover duration values should be defined if the duration of cleaning or changeover is not constant but dependent upon the previous or following task. Multiple changeover matrices can be defined per equipment. This feature is used in conjunction with the changeover duration option in an operation (see Chapter 5.)

Add New Cleaning/Changeover Matrix (>>) Button
Click this button to add a new matrix. In the New Changeover Matrix dialog that comes up, specify a new name for the matrix or use an existing one. Specify whether the matrix is based on Product Type or Packing Size. Note: the basis cannot be changed after the matrix is saved. Equipment used in a procedure’s pool must share at least one matrix with the same name before the changeover duration option can be used for an operation inside that procedure; so, sharing of changeover matrix names is a prerequisite for similar equipment used for the same tasks. For easy referencing, the matrix name should reflect the purpose for which the relevant operation will be used, e.g. “Precleaning.”

The following entries are available:

Name
The changeover matrix name.

Basis
The changeover category. This is set when the matrix is created.

Nominal Duration
The operation’s duration if no appropriate matrix entry is found. The units for the nominal duration also apply to the matrix entries.

Min. Time for “Idle” State
If the equipment is not scheduled for use for the specified duration, it is considered idle.

Matrix Entries
Each entry specifies the duration for the operation when changing from the row state to the column state.
Declaring Resources

Edit Cleaning/Changeover Matrix (button) Button
Click this button to edit a changeover matrix. In the Changeover Matrix dialog that comes up, edit the matrix name, specify a nominal value for the duration (this duration will be used if value can’t be looked up in the matrix) and the matrix values.

Size Tab
Imposes Limit on Batch Size
Select this option to specify a size-related constraint in the use of this equipment. This constraint will be used to determine the type and number of procedures and operations that can be executed in this equipment.

Limit Basis
Specify the basis (mass, volume or number of discrete entities) for the size limit.

Has Maximum
Select this option to specify an upper limit in the amount of material that this equipment can handle in the selected basis.

Has Minimum
Select this option to specify a lower limit in the amount of material that this equipment can handle in the selected basis.

Imposes Limit on Processing Rate
Select this option to specify limits in the rate that this equipment can execute its assigned tasks. This rate will be used to determine the duration of operations that are declared as rate-dependent and are assigned to this equipment. Operations can be executed at the nominal equipment rate or any percentage of the nominal rate that falls between the minimum and maximum processing rates.

**Rate Basis**
Specify the basis (mass flow, volumetric flow or flow of discrete entities) for the rate limit.

**Nominal Rate**
Specify the nominal processing rate of this equipment.

**Has Maximum**
Select this option to specify an upper limit on the equipment’s processing rate.

**Has Minimum**
Select this option to specify a lower limit on the equipment’s processing rate.

**Cost Tab**

**Hourly Usage Rate**
The hourly usage rate is the hourly cost of maintaining the equipment when it is in use.

**Hourly Availability Rate**
The hourly availability is the hourly cost of maintaining the equipment at any time.

**Auxiliary/Main Compatibility Tab**
This selection limits the set of equipment that may be used as auxiliary by an operation when the edited equipment is used as main by the operation’s procedure. If no limitations are entered, then the entire auxiliary pool is always considered.

**Facility**
Select the facility from which to choose the main equipment.

**Match Type**
Narrow the equipment list to only the selected type.

**Add Button**
Adds the equipment selected in the available list to the compatible equipment pool.

**Transfer Panel Compatibility Tab**
This selection limits the set of transfer panels (see below for a definition of transfer panels) that may be used by an operation when the edited equipment is used as main by the operation’s procedure. Compatibility limitations can also be defined at the panel’s components level (ports and bridges). If no limitations are entered, then the entire transfer panel pool is always considered.
Declaring Resources

Select the facility to which the compatible transfer panels belong.

Compatible Transfer Panels
Use the add and delete buttons to add or remove compatible transfer panels.

Ports & Bridges
For the selected panel in the compatible panels list, select the compatible elements. Click the Save Selections for Transfer Panel button before choosing a new panel.

6.3.8 Work Areas
A work area represents a room or building where procedures take place. Work areas may allow multiple simultaneous activities according to their usage policy.

To add a work area resource, navigate to the desired facility in the navigation tree and select the Work Areas node. Right-click on the node and select the “Add Work Area…” option or click the Add New Work Area button in the Work Areas view toolbar. Specify a unique work area name, and optionally a short description.

To edit a work area resource, select it from the list in the facility’s Work Areas view (the whole row should show selected on the table). Click the Edit Work Area button. Alternatively, double-click on the table row for the desired work area resource.

The Work Area Properties dialog that will show up contains the following options:

Properties Tab
Name
The work area name should be unique within the parent facility.

**Description**  
(Optional) Provide some descriptive information about this work area.

**Facility**  
This entry displays name of the parent facility where the work area belongs (non-editable).

**Availability Calendar Button**  
Press this button to specify work area outages and downtimes.

**Parallel Task Execution**  
Select this option to specify if the work area can handle multiple parallel tasks simultaneously (by default, all work areas are assumed to be able to handle only one task at a time). Unlike equipment, work areas cannot have a size, so size limitations cannot constrain the number of parallel executed tasks. This can only be done explicitly by the user if the button **Has Limit on Number of Parallel Uses** is checked and an upper bound on parallel tasks is provided.

**Work Area Usage Policy**  
Specify the policy for using this work area. The options are:

- **By any Activity**  
  No limitations in the usage policy.

- **By Activities in the Same Batch**  
  The work area is reserved for activities within the same batch.

- **By Activities in the Same Campaign**  
  The work area is reserved for activities within the same campaign.

- **By Activities with the Same Recipe**  
  The work area is reserved for activities related to batches of the same template recipe.

**Display in charts**  
If checked, this work area will be shown in the occupancy chart.

The toolbar on the Work Areas list view has also buttons for setting calendar availability, deleting, cutting, copying and pasting a work area and reordering the list. Some of these options can also be accessed in the context menu that pops-up by right-clicking on the desired work area. Select the button from the Work Areas list view toolbar or the “Used by…” option from the context menu to view all recipes and procedures that make use of this work area. Note that a work area can be deleted only if it is not used by any recipes or procedures.

### 6.3.9 Transfer Panels

Transfer Panels are specialized devices that operate like material “switchboards” to allow material to be transferred from one equipment unit to another equipment unit. Each such transfer may involve one or more transfer panels.

A transfer panel is composed of a set of *ports* (or fittings, or nozzles) and a set of *bridges* (or jumpers, or connectors.) Ports may be divided into two sets, e.g. input and output. In SchedulePro, a transfer panel contains the definitions of the ports, the bridges and their connectivity.
From a scheduling standpoint, a transfer panel is a collection of equipment. A transfer operation employs a series of ports and bridges. A panel may support multiple simultaneous transfers as long as there exist available ports and bridges. So, by definition, a transfer panel is a multitask equipment.

To add a transfer panel, navigate to the desired facility in the navigation tree and select the **Transfer Panels** node. Right-click on the node and select the "Add Transfer Panel..." option or click the **Add New Transfer Panel** button in the Transfer Panels view toolbar. Specify a unique transfer panel name, and optionally a short description.

To edit a transfer panel resource, select it from the list in the facility's Transfer Panels view (the whole row should show selected on the table). Click the **Edit Transfer Panel** button. Alternatively, double-click on the table row for the desired transfer panel resource.

The **Transfer Panel Properties** dialog that will show up contains the following options:

**Properties Tab**
This tab is identical to the **Properties** tab of the equipment resource (explained above) with only two exceptions: the Type cannot be edited (is set to “Transfer Panel”) and the multiple parallel uses option is not displayed (it is implied to be true.)

**Cleanout/Changeover Tab**
This tab is identical to the **Cleanout/Changeover** tab of the equipment resource (explained above.)

**Topology Tab**
Topologically, transfer panels in SchedulePro consist of up to two sets of ports (“Ports-Set1” and “Ports-Set2” in the first and third column) and one set of “Bridges” (middle column). The names of these component groups can be edited by the user.
A transfer of material through a transfer panel should involve at minimum the use of a bridge so the topology of a transfer panel should include at least one bridge. The declaration of ports is optional. In every group, the following options are available.

**Add Button**
Click on this button to add a new component (port or a bridge) in the relevant group. Provide a name for the new component; the component name should be unique within that group. Although not enforced, it is highly recommended that the names of components are unique in the entire topological structure of a transfer panel so that the components are easily identifiable when the transfer paths are shown or reported.

**Add List Button**
Click on this button to add a list of indexed components that use the same root in their name. The components will be named with the formula `prefix-i`, where `prefix` is the text for the first part of the name and `i` is an integer index.

The *Create Name Series* dialog has the following entries:

**Name Prefix**
The first part (prefix) of the name.

**Starting Index**
The integer value for the first index of the series.

**Ending Index**
The integer value for the last index of the series.

**Delete/Rename Buttons**
Select any component from a list to change its name or delete it. If a component is renamed or deleted then the connectivity paths or the exclusive-use sets in which it participates are also deleted. See following section for an explanation on connectivity or exclusive use sets.

**Connectivity Tab**
Ports from both sides of a transfer panel are connected through bridges. Use the Connectivity Tab to specify which ports are connected to which bridge.

Select a bridge from the middle column and use the check boxes next to each port to declare whether that port can be connected to the selected bridge.

Click on the Connect All button to declare full connectivity, i.e. all ports can be connected to all bridges.

**Exclusive-Use Components Tab**

Sometimes, the simultaneous use of ports is not allowed if, for example, they share the use of common devices such as valves. Use the Exclusive-Use Components Tab to declare mutually exclusive sets of ports. If exclusive sets are defined, the scheduler at any instance can use only one port from the set of exclusive ports since the use of one port blocks the use of any other port in the sets that it participates.

To declare a new set of mutually exclusive ports, click on the Add New Mutually Exclusive Set button on the relevant group. In the dialog that pops-up, use the check-boxes to declare the ports that belong to this set.

When an exclusive set is selected in the relevant list, use the Delete Mutually Exclusive Set button or the Edit Mutually Exclusive Set button to delete or edit this set respectively.

The toolbar on the Transfer Panels list view has also buttons for setting calendar availability, deleting, cutting, copying and pasting a transfer panel and reordering the list. Some of these options can also be accessed in the context menu that pops-up by right-clicking on the desired transfer panel. Select the button from the Transfer Panels list view toolbar or the “Used by…” option from the context menu to view
Declaring Resources

all recipes and operations that make use of this transfer panel. Note that a transfer panel can be deleted only if it is not used by any recipes or operations.

6.3.10 Storage Units

A storage unit in SchedulePro is a collection point for tracking bulk or discrete material inventories. Storage units track materials associated with streams; a stream may be drawn from or deposited to a storage unit. A storage unit may be used to limit the maximum rate at which material may be drawn or deposited. A storage unit may also track and potentially limit the total amount of material drawn. The resource and inventory charts display the fill/empty rates and the inventory profiles for storage units. Storage unit inventories may also be used to control the durations of operations and signal the initiation of certain campaigns and batches.

The actual physical equipment used for storage and its occupancy is not normally considered as part of the storage unit. A storage unit might represent a single tank, a tank farm, or a warehouse. Physical storage equipment can optionally be associated with storage units so that their occupancy can be captured and their inventory be separately tracked.

To add a storage unit, navigate to the desired facility in the navigation tree and select the Storage node. Right-click on the node and select the “Add Storage Unit...” option or click the Add New Storage Unit ( ) button in the Storage Units view toolbar. Specify a unique storage unit name in the dialog that pops up.

To edit a storage unit, select it from the list in the facility’s Storage Units view (the whole row should show selected on the table). Click the Edit Storage Unit ( ) button. Alternatively, double-click on the table row for the desired storage unit.

The Storage Units Properties dialog that will show up contains the following options:

Properties Tab

Name
The storage unit name should be unique within the parent facility.

Facility
The name of the parent facility is displayed (non-editable).

Bulk/Discrete
The type (bulk or discrete) of material that this unit stores. If the material is bulk, then the basis (mass or volume) for measuring the material amounts and the unit’s capacity should be also defined.

Type
The storage unit type has the following options:

Supply
If selected, the storage unit supplies raw materials to the processes. Click on the Edit Composition ( ) button to specify the supplied material from the registered materials list. Any input stream that draws from a supply unit has the same composition as the unit’s stored material.

Receiving
If selected, the storage unit receives material from the process. The deposited materials can be either products or waste. In the case of waste deposit, the unit can further be classified as an emission, aqueous, organic, solid or unspecified waste receiving unit. An unspecified waste unit can receive any type of waste streams. In all other cases, only waste streams of equivalent type can deposit their material in the storage unit.

Intermediate
The storage unit both receives and supplies. The supplied material may be specified by selecting the Edit Composition button.

Because of the required matching between storage unit and stream types, the stored material type (bulk or discrete) and the storage unit type (supply etc.) cannot be changed in this tab if there exist recipe streams already associated with that storage unit.

Supply/Reception Limits Tab
Use this tab to specify the maximum rate at which a supply unit can supply material to the process or a receiving unit can receive material from the process. These limits are not applicable for Intermediate storage units.

Limit Units
This sets the units of measurement for the supply or reception rate limit.

Maximum Supply
This sets the maximum rate at which material may be drawn.

Maximum Reception
This sets the maximum rate at which material may be deposited.

Unlimited Checkbox
Check this box to denote that setting the corresponding limit is of no interest.

Inventory Data Tab
**Track Inventory**
Check this option to allow SchedulePro to perform inventory calculations on this unit. Inventory graphs can only be shown for storage units that have this option set.

**Constraint Inventory**
If checked and the optional scheduling constraint on inventories has been activated (see Chapter 7), this storage unit will be considered for inventory constraints. Otherwise, scheduling will not take into account any inventory violations in this storage unit.

**Capacity**
The provided capacity and its units are set according to the type (bulk or discrete) and the basis (mass or volume) set at the *Properties Tab* of the same dialog. If the storage unit is associated with storage equipment (see description of *Equipment Tab*), the overall storage capacity is calculated as the sum of the individual equipment capacities and this field is not editable.

**Opening Inventory**
Sets the amount of material present in the storage unit at the beginning of the schedule.

**Inventory Limits**
Specify the upper and lower capacity limits of the storage unit. Inventory violations will be calculated based on these limits.

**Replenish/Discharge Data**
For supply units, specify the raw material replenishing policy. For receiving units, specify the discharge policy. In both cases, the policy can be defined as Continuous or Periodic.

**Continuous Receipt/Discharge**
Receipt or discharge of material is done at a constant rate triggered by the level of material in the storage unit. Click on the *On/Off* button to access the Supply/Discharge Rate dialog.

**Supply/Discharge Rate**
Specify the constant rate and units at which material is received or discharged.

**On Level**
For a supply unit, the ‘On’ trigger is the fill level at which replenishing of material should start. For a receiving unit, the ‘On’ trigger is the fill level at which discharge of stored material should start.

**Off Level**
For a supply unit, the ‘Off’ trigger is the level at which filling the unit should stop. For a receiving unit, the ‘Off’ trigger is the level at which emptying the unit should stop.

A constant supply or discharge rate independently of on/off triggers is assumed if both levels are set at 0% for supply or 100% for discharge.

**Periodic Receipts/Discharges**
Receipts or discharges of material are calendar based events. Click on the *Tank with Calendar* button to access the storage unit’s calendar. You can use the calendar to add, edit or delete scheduled receipts or discharges of material the same way that you would use it to specify facility and resource outages (as explained in section 6.3.3.) When specifying a material receipt or discharge event, the Resource Calendar Entry dialog has the following options in addition to those already presented in section 6.3.3:

**Amount**
This entry determines the amount supplied or discharged. If the **Fixed Amount** option is selected (see below), the amount is a fixed absolute value with the corresponding units. If the Fill or Empty option is selected, the amount field corresponds to a percentage of the storage unit’s capacity.

**Receipt/Discharge Options**
These options select whether material is charged or withdrawn.

**Fixed Amount**
If selected, the exact amount provided in the **Amount** field will be charged or withdrawn.

**Fill or Empty**
If selected, the storage unit will be filled or emptied to the percentage of its capacity indicated in the **Amount** field.

**Duration**
This sets the duration of the receipt/discharge event.

**QA Time**
This sets a delay in the start of the actual receipt/discharge event with respect to its nominal start for quality assurance (QA) purposes.

**Equipment Tab**
A storage unit may be associated with one or more storage equipment items. The equipment must have a size limit that is compatible with the storage unit’s capacity. For example, if the storage unit is volume based, the associated equipment should have volume based capacities. In this case, the storage unit’s overall capacity is calculated as the sum of the individual equipment capacities.

The association of storage units with physical equipment allows for the actual occupancy of this equipment to be taken into account and also for the inventory of each equipment unit to be tracked independently. In this way, the availability of actual storage equipment to carry the stored material can be followed during scheduling.
Declaring Resources

194

Associate Storage Unit with Material Holding Equipment
Check this box to enable the storage unit to equipment association.

Facility
Select the facility from which to choose the equipment.

Match Type
Optionally select the equipment type.

Available Holding Equipment
Displays all the equipment in the selected facility and of the selected type (if applicable) that have holding capacities compatible with the storage unit. Use the Add or Add All buttons to add equipment to the pool.

Equipment in Pool
Lists all the equipment associated with the storage unit. The total inventory capacity is the sum of all capacities in the pool. Use the buttons in the toolbar above the list to remove equipment from the pool or
reorder the pool. The order in which equipment are shown in the pool determines the assignment order when scheduling. The **Total Capacity** is the sum of the maximum capacities of the selected equipment.

**Maintain Batch Integrity**
If checked, every new deposit to storage must be directed to an unused piece of holding equipment.

**Allow Only Material Discharges After Equipment Gets Filled Up**
Filling operations must be completed before discharge. The holding vessel does not need to be filled to capacity.

**Disallow Simultaneous Material Deposit and Discharge**
If checked, material withdrawing cannot happen while material is charged into the equipment and vice versa. Priority in execution is given to the earliest event.

**Material is Processed**
If checked, material supplied in the storage equipment cannot become available for withdrawing until the specified processing time (and units) elapses. The **Processing** button allows the specification of resources during the processing.

**Apply Material Drop**
If checked, stored material in some equipment will be removed and the inventory will be set to zero under when the vessel reaches a low inventory level or when the material expiration time is elapsed.

**Material Expires**
If checked, material will be dropped if the storage time exceeds the specified expiration time. If the stored material is the result of multiple deposits, the earliest deposit is used to calculate the storage time.

**Continue Material Draw after Expiration Until Empty**
Ignore the expiration until the holding equipment is empty.

**Drop if Level Goes Below**
If checked, material will be dropped if the inventory level in the equipment drops below the specified level of the equipment’s holding capacity.

**Material Drop Time**
In the event of material dropping, this specifies the time required to remove the material until the storage equipment is emptied. Use the **Fixed** option to specify a constant time and units or **Rate-Based** to specify a drop flow rate.

**Clean Equipment Before / After Use**
If checked, some cleanout time will be allocated during scheduling before the equipment is filled or after the equipment is emptied. Use the Fixed Duration for All Equipment to specify a cleaning time equal for all storage equipment or the Duration based on Equipment Cleanout Time to indicate that this cleaning time will be taken by each equipment’s cleanout time (see description of equipment’s Cleanout/Changeover Tab in section 6.3.7) The **Cleaning** button allows the specification of resources and materials during the equipment cleaning.

The toolbar on the Storage Unit Window has also buttons for charting the inventory, deleting, cutting, copying and pasting a storage unit. Some of these options can also be accessed in the context menu that pops-up by right-clicking on the desired storage unit. Select the **used by…** option from the right-click context menu to view all operation streams or facility utilities that make use of this storage unit. Note that a storage unit can be deleted only if it is not used by any streams or utilities.
6.3.11 Material Supply Systems

Material supply systems (MSS) are a specific case of storage units that supply and track the inventory of a single substance (component or mixture). For example, if a process uses purified water in some streams and solutions made from purified water in other streams, a material supply system can provide usage and inventory information for just the purified water usage.

The consumption of the substance supplied by the MSS is declared through association with recipe streams. Unlike the storage unit case, however, this association is not done at the stream definition dialog; it is done exclusively through the “Used by” interface.

To add a MSS, navigate to the desired facility in the navigation tree and select the Material Supply Systems node. Right-click on the node and select the “Add Material Supply System…” option or click the Add New Material Supply System button in the Material Supply Systems view toolbar. Specify a unique MSS name in the dialog that pops up.

To edit a MSS, select it from the list in the facility’s Material Supply Systems view (the whole row should show selected on the table). Click the Edit Material Supply System button. Alternatively, double-click on the table row for the desired MSS.

The Material Supply System Properties dialog that will show up contains the following options:

Properties Tab

Name
The name of the MSS should be unique within the parent facility.

Facility
The name of the parent facility is displayed (non-editable).

Bulk/Discrete
The type (bulk or discrete) of material that this MSS stores. If the material is bulk, then the basis (mass or volume) for measuring the material amounts and the unit’s capacity should be also defined.

Select Material
From the list of registered components and mixtures, select the one supplied by the MSS.

Can Serve Multiple Parallel Material Drawings
If checked (true by default), multiple material drawings from the MSS are possible. Otherwise, only one drawing can be executed at a time. If multitasking is possible, a limit on the maximum number of parallel drawings can be set if the box Has Limit on Parallel Material Drawings is checked.

Outage Calendar
The outage calendar specifies times during which the material supply system is unavailable and cannot supply material to the process. Such outages are treated like auxiliary equipment outages.

Display in Charts
If checked, the MSS will be shown in occupancy charts. A MSS is considered occupied in every period during which an operation draws material from the MSS through a stream or a utility.

Supply Limit Tab

Maximum Supply
This sets the maximum rate at which material may be supplied.

Unlimited Checkbox
Check this box to denote that setting a supply limit is of no interest.

**Inventory Data Tab**

**Capacity**
The provided capacity and its units are set according to the type (bulk or discrete) and the basis (mass or volume) set at the *Properties Tab* of the same dialog.

**Opening Inventory**
Sets the amount of material present in the MSS at the beginning of the schedule.

**Inventory Limits**
Specify the upper and lower capacity limits of the MSS. Inventory violations will be calculated based on these limits.

**Replenish Data**
Specify the material replenishing policy. Options are identical to the storage unit (see relevant description of the storage unit *Inventory Data Tab* in section 6.3.10.)

**Draw From Material Supply System**
This option allows the input material to be drawn from another Supply System. Such cascaded supply systems can be used to model break tanks and purified water systems. The supply system menu offers other material supply systems, and the scale factor is used to increase or decrease the amount drawn to account for product loss.

The toolbar on the Material Supply Systems list view has also buttons for charting the inventory, declaring calendar availability, deleting, cutting, copying and pasting a MSS. Some of these options can also be accessed in the context menu that pops-up by right-clicking on the desired MSS. Select the button or the “Used by…” option from the right-click context menu to view and edit all operation streams or facility utilities that make use of this MSS. The *Used By* dialog that pops up can be used to edit the list of streams and utilities that are associated with the selected MSS. Note that by default, a MSS tracks the consumption of all streams and utilities that utilize the material that it supplies. Also note that a storage unit can be deleted only if it is not used by any streams or utilities.

The *Used By* dialog has the following options:
Declaring Resources

Streams Tab

Show Streams Options
Select the proper option to view all streams or narrow down the display to those streams drawing material from the MSS or to those not drawing material.

Recipes/Sections/Procedures Columns
Select the appropriate item in each column to narrow the set of streams. Click in the prior column to deselect all the items. Deselecting all the items means that all the items will be included, i.e. no narrowing is done.

Streams Column
This is the list of streams corresponding to the selected recipe/section/procedure and the selected Show option and which make use of the material supplied by the MSS. Check the streams to be linked with the MSS or uncheck to dissociate. Use the Include All/Exclude All buttons for quick association/dissociation of all listed streams.

Utilities Tab
By default, all heating or cooling utilities whose composition material (if defined) is the one supplied by an MSS is associated with that MSS. In a way similar to the Streams Tab, use this tab to customize the list of utilities that will be linked with the MSS.

6.3.12 Suites
Suites are defined within facilities. Suites represent sets of equipment that may be used together to execute a part of a recipe (identified in SchedulePro as a recipe section.) If a section is set to run in a suite, all unit procedures in the section will be assigned to equipment from the same suite. Suite assignment restrictions apply only to main equipment and not any other resource.

Equipment may belong to only one suite. Equipment that does not belong to any suite may be assigned to procedures in unassigned sections.
Suites may also be connected to one-another. If two sections are set to run in suites and the two sections are also set to require compatible suites, the unit procedures will be assigned to equipment from compatible suites. If no appropriate set of equipment can be found, scheduling fails.

To edit the list of suites in a facility, navigate to the desired facility in the navigation tree, select it to activate the Facility view on the right-hand side and click the **Edit Suites** button. The dialog that pops up lists all declared suites in that facility.

To add a suite, click the **Add New Suite** button and enter a unique name for the new suite.

To edit a suite, select it from the list and click the **Edit Suite** button. The Suite Properties dialog that comes up has the following options:

**Identification Tab**
Edit the name of the suite and optionally provide a short description. Suite names should be unique within a facility.

**Equipment Tab**
Select the equipment that belong to this suite. Equipment may belong to only one suite. When equipment is assigned to a suite, it is removed from any other suite.

**Compatibility Tab**
Select the suites that are compatible with the suite being edited.

The toolbar on the Suites dialog offers options to delete a suite and reorder the suite list; however, suite order has no bearing on scheduling.
Chapter 7: Scheduling Campaigns

7.1 Introduction .......................................................................................................................... 203

7.2 Scheduling Modes ................................................................................................................. 203

7.2.1 Built-In Scheduling Modes .............................................................................................. 203

7.2.2 Defining and Selecting Scheduling Modes ...................................................................... 203

7.2.3 Editing a Scheduling Mode ............................................................................................... 204

Mode Options ID Tab .................................................................................................................. 205
Batch Timing Tab ....................................................................................................................... 205
Constraints Tab .......................................................................................................................... 206
Conflict Resolution Tab ............................................................................................................. 207
Miscellaneous (Misc) Tab .......................................................................................................... 208

7.3 Planning a Campaign ............................................................................................................ 209

7.3.1 Campaigns ....................................................................................................................... 209

7.3.2 Campaign Setup Options .................................................................................................. 209

Id/Amount Tab ............................................................................................................................ 210
Timing/Sequencing Tab .............................................................................................................. 211
Options Tab ................................................................................................................................ 213
Advanced Tab ............................................................................................................................ 213
Campaign Comments Tab ......................................................................................................... 215
Campaign Messages Tab (Scheduled Campaigns) ................................................................... 216
Economics Tab (Scheduled Campaigns) .................................................................................... 217

7.3.3 Campaign Scaling ............................................................................................................. 218

7.3.4 User-Defined Campaign Properties .................................................................................. 218

7.3.5 Campaign Projects ............................................................................................................ 219

7.4 Scheduling Campaigns .......................................................................................................... 219

7.4.1 Scheduling and Unscheduling ......................................................................................... 219

7.4.2 Scheduled Entities ............................................................................................................. 219
7.4.3 Viewing Conflicts................................................................. 221
7.4.4 Resolving Conflicts............................................................. 222
7.4.5 Campaign Scheduling Dependencies..................................... 222
  Dependencies Tab....................................................................... 222
  Order Tab ................................................................................. 222
7.5 Modifying the Schedule ......................................................... 224
  7.5.1 Modifying Scheduled Campaigns ....................................... 224
    Accessing Campaign Properties............................................... 224
  7.5.2 Modifying Scheduled Batches ........................................... 225
    Batch Schedule Tab ................................................................... 226
    Batch Resources Tab ............................................................... 227
    Batch Messages Tab ............................................................... 227
    Batch Comments Tab ............................................................. 227
    Batch Status Tab ................................................................... 228
    User Messages Tab .................................................................. 228
    Batch Economics Tab ............................................................. 228
    Batch Locking ........................................................................ 228
  7.5.3 Modifying Scheduled Procedures ....................................... 229
    Procedure Schedule Tab ......................................................... 229
    Procedure Resources Tab ....................................................... 229
    Procedure Status Tab ............................................................ 229
    Operations Tab ....................................................................... 229
    Comments Tab ...................................................................... 229
  7.5.4 Modifying Scheduled Operations ...................................... 229
    Schedule Tab .......................................................................... 230
    Resources Tab ........................................................................ 230
    Status Tab ............................................................................. 231
    Comments Tab ...................................................................... 231
  7.5.5 Modifying the Completion Status ....................................... 231
7.1 Introduction
Generating a schedule in SchedulePro involves selecting a scheduling mode, defining one or more campaigns, and running the scheduling algorithm. The default scheduling mode is automatic, meaning that SchedulePro will attempt to schedule the batches and resolve conflicts automatically. There are two other built-in modes: layout and ASAP, as well as user-defined modes.

7.2 Scheduling Modes
A scheduling mode is a group of settings that tell SchedulePro how to layout the batch starts, which constraints to respect, and how batches may be modified to avoid over-allocation of a constrained resource, i.e. a conflict.

7.2.1 Built-In Scheduling Modes
SchedulePro has the following built-in Scheduling modes:

- **Automatic** – this mode schedules batches and resolves hard constraints in an intuitive fashion.
- **Layout** – this mode schedules batches with a strict adherence to the cycle-time and attempts to avoid resource over-allocation.
- **ASAP** – this mode schedules batches as soon after one another as possible regardless of the cycle time settings.

The table below summarizes the built-in settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Automatic</th>
<th>Layout</th>
<th>ASAP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Batch-Timing</td>
<td>Cycle-Time - may be delayed</td>
<td>Cycle-Time – locked</td>
<td>Constraint-driven ignores cycle-time</td>
</tr>
<tr>
<td>Outages</td>
<td>Respected</td>
<td>Respected</td>
<td>Respected</td>
</tr>
<tr>
<td>Hard Constraints (equipment, work areas, staff)</td>
<td>Respected</td>
<td>Respected</td>
<td>Respected</td>
</tr>
<tr>
<td>Use alternate equipment</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Use flexibility</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Delay batch start</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>

The above settings are defaults and may be modified by the user with the exception of the Batch-Timing.

7.2.2 Defining and Selecting Scheduling Modes
The scheduling modes above may be modified and new modes created. Select “Schedule/Edit Scheduling Modes...” from the main menu or select “Edit Scheduling Modes...” from the mode pull-down menu in the main toolbar. The mode dialog will appear.
The dialog contains a list of the defined modes. The current scheduling mode is displayed in red. The dialog has a toolbar with the following buttons:

- Add a new user-defined mode.
- Delete a user-defined mode. Built-in modes cannot be deleted.
- Edit a mode.
- Set as the current scheduling mode.

### 7.2.3 Editing a Scheduling Mode

Access the mode dialog by selecting “Schedule/Edit Scheduling Modes…” from the main menu or by selecting “Edit Scheduling Modes…” from the mode pull-down menu in the main toolbar. Use the Edit button ( ) to edit the selected mode. The Scheduling Mode Options dialog has four tabs: ID, Batch Timing, Constraints and Conflict Resolution.
Mode Options ID Tab

Name
This field may only be modified for user-defined modes.

Comments
This is optional and may only be modified for user-defined modes.

Batch Timing Tab
This defines how the batch start times are calculated. The option may be edited for user-defined batches. There are three options:

Cycle Time Based
The batch starts are initially calculated according to cycle time. Each batch starts one cycle-time later than the prior batch. Batch starts may be delayed to resolve resource conflicts.

Locked
The batch starts are calculated according to cycle time. Each batch starts one cycle-time later than the prior batch. Batch starts are not modified to resolve conflicts.

ASAP
The batches are started as soon as resources are available. Cycle-time settings are ignored.
Constraints Tab
This defines which conflicts will be identified and which will be resolved.

Hard Constraints

Hard constraints represent resource allocation conflicts. All conflicts will be reported, but only the checked constraints will be subject to conflict resolution.

All Outages (facilities, equipment, staff)
If checked, all downtime entered for facilities, equipment, or staff will be subject to conflict resolution.

Within Batches of Same Campaign
If checked, conflicts among batches of the same campaign will be considered for conflict resolution.

Between Campaigns
If checked, conflicts among batches of different campaigns will be considered for resolution.

Main Equipment
If checked, over-allocated main equipment conflicts will be considered for resolution.
**Work Areas**
If checked, over-allocated work area conflicts will be considered for resolution. See chapter 6 for more about work areas.

**Auxiliary Equipment**
If checked auxiliary equipment conflicts will be considered for resolution.

**Staff Conflicts**
If checked, staff conflicts will be considered for resolution.

**Soft Constraints**
Soft Constraints will not generate any conflicts unless they are checked. If they are checked, SchedulePro will check for constrain violations and attempt to resolve them. The following rate constraints are available:

- Labor
- Utilities
- Raw Materials
- Products
- Waste

The following inventory amount constraints are available:

- Raw Materials
- Wastes
- Products
- Intermediates

**Conflict Resolution Tab**
The options in this tab control the types of adjustments SchedulePro may make to resolve resource conflicts.
The following options are available:

Allow scheduler to resolve conflicts when scheduling/rescheduling: this option turns conflict resolution on or off.

Alternative pooled resources: this option allows SchedulePro to change equipment, work areas or staff to resolve conflicts.

Operation timing flexibility: this option allows SchedulePro to make use of flexible shifts to resolve conflicts.

Move start times of conflicting batches. This option allows SchedulePro to delay batches up to the specified time, in order to resolve conflicts. **Important:** the default value of 30 days is appropriate for short-term scheduling, but a longer period, e.g. 180 days, may be more appropriate for long-term planning applications.

**Miscellaneous (Misc) Tab**

This tab contains some settings that adjust the scheduling algorithm. The user may set the following options:

Scheduling Tolerance: This is in seconds. Resource over-allocations that last for less than the specified duration are ignored.

Conflict Resolution Attempts: This is the number of conflict resolution attempts per batch. For very long recipes, this number may need to be increased.
Full Conflict Calculation: With full conflict calculation on, all the conflict information is updated for a given batch. With full conflict calculation off, only the earliest calculations are found. This accelerates the execution of the schedule, but may sometimes lead to poorer schedules.

7.3 Planning a Campaign

7.3.1 Campaigns
A schedule in SchedulePro starts with one or more campaigns, each of which defines a number of batches of a particular recipe. Planning a campaign involves defining the recipe, number of batches, and various scheduling options. Scheduling a campaign invokes the scheduling algorithm to create and schedule the campaign’s batches. Unscheduling a campaign deletes all the batches without deleting the campaign.

A schedule may have any number of campaigns. The order of campaigns in the list reflects campaign priority for resource assignments. Campaigns do not need to be listed in chronological order. The order of campaign planning may be modified on the Campaign Window by making use of the Campaign toolbar. The Promote Campaign button moves a selected campaign one position up in the list. The Demote Campaign button moves a selected campaign one position down in the list. Campaigns may also be arranged by drag-and-drop.

7.3.2 Campaign Setup Options
To create a new campaign, select the add button or the insert button from the campaign toolbar.
Id/Amount Tab

The following options are available:

**ID**
Set a recipe identification tag. The default recipe ID is formed by the recipe name and an automatically generated numeric index.

**Recipe**
Select a recipe from the list of available recipes in the active SchedulePro project.
Nominal Batch Size
This displays the nominal batch size for the recipe.

Display Color
This is the campaign color that is displayed in table and charts. Use the Set from Recipe button to use the recipe color for the campaign.

Batch Name Base
This is the root for each batch name. A sequence number is appended the root.

Batch Starting Sequence Number
This is the starting sequence number for batch names.

Use Names from File
Enter a file containing a list of batch names, one name per line. The file should contain enough names for all the batches in the campaign.

Number of Production Batches
Set the number of batches for the campaign. This must be a positive integer value. If this value is set, the order amount may be updated with the recalculate button.

Set Order Amount
Set the total amount for the batch. This is based on the recipe batch size. The recipe must have a defined batch size to enable this option. If the batch size or scale factor is fixed, the number of production batches will be updated.

Specify Batch Size for Campaign
If this option is chosen, the number of batches is defined as the order amount divided by the batch size. If this box is not selected, the campaign is in continuous mode, and the batch size is determined by the order amount.

Batch Size
This is an alternative for the scale factor and is available if the recipe has a nominal batch size.

Scale Factor
Click the “Scaling...” button to set the campaign batch size in terms of a scale factor or absolute batch size. If no option is chosen, the default (recipe) batch size will apply.

Set to Maximum
Set the batch-size to the maximum amount achievable with the equipment. This option will only be available if at least one procedure is sized limited.

Recalculate
This button updates all the values in the dialog.

Timing/Sequencing Tab

Release Date
This is the earliest start date for the campaign. The “Set to Schedule Start” button sets the release date to the schedule start.

Campaign Start/End/Duration
The actual start, end and duration are for information only.

Campaign Start Mode Options:
Select one of the following options.

**On or After Release Date**
The campaign will start as soon as possible, after the release date.

**Set Due Date**
The campaign start will be determined automatically to meet the specified due date as close as possible.

**Due Date Options:**

**Tolerance**
Assuming that the campaign can be scheduled before the due date, this parameter sets how close SchedulePro must come to meeting the exact time and hour of the due date.

**Maximum # of Trials for Convergence**
This tells SchedulePro how many times to refine the schedule in order to get within tolerance of the due date.

**On or After the Start of a Previous Campaign**
Start concurrently the specified prior campaign.

**On or After the End of a Previous Campaign**
Start after the end of the specified prior campaign.

**Tightly Following a Previous Campaign**
Start as soon as resources from a specified prior campaign are available.

**Time Shift**
Adjust the campaign start. Use a positive value to make the start later or a negative value to make the start earlier.

**Event Options**
This option allows the campaign to wait for an inventory condition to be satisfied before it can start. The Setup button displays the inventory event options dialog.

![Campaign Initialization Event](image)

The following options are available:

**Storage Unit:** The storage unit for the inventory condition. Inventory tracking must be enabled.

**Condition:** The comparison (≥ or ≤) and the amount (specify % or units).
Shift Back Campaign Start...: Shift the campaign start, if necessary, to avoid violating the condition before the start of the campaign.

Options Tab
This sets the following options for batch start calculations and for resource allocation.

Cycle-Time Based
Attempt to start batches with the specified cycle time.

Set Slack Time
When Slack Time is specified, SchedulePro automatically calculates a cycle time and adds the specified slack time to it. The specified slack time may be negative.

Set Cycle Time
The target cycle time is initial value for the time between consecutive batch starts. It is, by definition, the sum of the minimum cycle time (based on the longest procedure in the recipe) and the slack time. SchedulePro uses the target cycle time to estimate the earliest start for a batch. The actual start may be delayed to meet constraints.

Event-Based
There are two options provided for event-based batch scheduling:

- Batch-Start Determined by the Same Event as the Campaign Start and
- Different Event Triggers Start of all Batches Except the First

If the second option is chosen, a separate inventory event may be specified for batch starts.

Order Pooled Resources for Selection
Pooled resources are equipment, work areas, and staff. If multiple units are available, and “By Priority List” is selected, the equipment that is closest to the top of the pool list is selected. If “Earliest Availability” is selected, the equipment that is available soonest is used.

Advanced Tab
The advanced options tab specifies once-per-campaign tasks such as setup or cleaning. These tasks behave like extra operations that take place at the beginning of procedures in the first batch or at the end of procedures in the last batch. Like standard operations, pre and post production tasks may require resources such as auxiliary equipment, staff labor and materials.

The following options are available for all preprocessing or post-processing steps:

Include
Include this step in the campaign.

Run Before Start of First (End of Last) Batch
Perform the task on all equipment at once before the first batch starts or after the final batch ends as appropriate.

Run at Before first Equipment Use (at Last Equipment Use)
Perform the tasks separately for each equipment item, just before the first use or just after the last use as appropriate.
Setup – Use this button to set the duration and resource options.
The duration options the following:

- Specified Fixed Duration
- Duration Based on Equipment setup or cleaning time
- Duration Based on the equipment changeover matrix (based on prior or next equipment usage).

The auxiliary equipment may be included or excluded.

**Setup Options**
The following setup options apply:

*Staff*—Specify staff requirements.

*Labor*—Specify labor requirements.

*Heating/Cooling*—Specify heat transfer resources.

*Power*—Specify electrical power requirements.

*Material Inputs*—Specify material requirements, e.g. water and cleaning materials.

*Material Outputs*—Specify waste or product output.

**Campaign Comments Tab**
This tab displays both general campaign comments and user-defined campaign properties.
Campaign Messages Tab (Scheduled Campaigns)
This is an information-only pane that provides a history of batch additions and deletions. The comments tab also has a section for user-defined properties. See 7.3.4 for more details.
**Economics Tab (Scheduled Campaigns)**

The economics tab only appears for Scheduled campaigns. It provides a breakdown of costs for the campaign.
7.3.3 Campaign Scaling

Use the ID/Amount tab to scale the campaign batch size.

7.3.4 User-Defined Campaign Properties

In addition to the properties listed in this section, SchedulePro allows for user-defined campaign properties. These properties are defined for the document, and will not be copied if the campaign is copied from one document to another. All the user-defined campaign properties are text values.

Select “Schedule→User Defined Campaign Properties…” from the main menu. Use the wand button to add a new user defined value. Values have a name and an optional default value.

Setting User-Defined Values for a Campaign
The Comments tab in the campaign properties dialog has a lower table for user-defined properties. Click the value to type a new entry.

7.3.5 Campaign Projects
Campaigns may be organized into projects for the purposes of viewing and reporting. Campaign projects do not have any effect on scheduling and are entirely optional.

A campaign project has very simple properties including a name, description, and display color.

Enabling Project View
Select “Edit/Preferences…” from the main menu and check the Show Campaign Projects box.

Defining Campaign Projects
By default, all campaigns belong to the Main Project which is part of every SchedulePro document. To change the project’s name or properties select “Schedule/Define Campaign Projects…” Select a project to edit ( ), or create a new project ( ).

Assigning Campaigns to Projects
A project may belong to only one project. To assign a campaign to a project, edit the campaign properties, and select the desired project from the Project menu. Note: the project view must be enabled.

7.4 Scheduling Campaigns

7.4.1 Scheduling and Unscheduling
When SchedulePro schedules a campaign, it creates the batches and schedules them according to the campaign specifications and the scheduling mode.

The simplest way to schedule all the campaigns is to select the scheduling mode then select the schedule ( ) button from the main toolbar.

A single campaign may be scheduled by selecting it in the campaign window and select the schedule campaign ( ) button.

A campaign may be unscheduled (batches deleted) by selecting the Unschedule Campaign ( ) button from the campaign window. Similarly all campaigns may unscheduled by selecting the Reset Schedule ( ) button from the main toolbar.

7.4.2 Scheduled Entities
A scheduled campaign consists of scheduled batches. A batch has a series of procedure entries, and each procedure entry has one or more operation entries. Unlike their recipe counterparts, procedure and operation entries describe activities at a fixed time with fixed resources.

The Campaign and Batch Windows are displayed automatically on the right pane when the SchedulePro Project node is selected in the SchedulePro Navigation Tree, or when the Production Schedule node is selected.
Batch IDs consist of the campaign ID followed by a sequence number. Start and end times are shown on the Campaign and Batch Windows. The status of every batch (started, completed etc.) is shown on the Batch Window. Resource conflicts with other batches of the same or different campaign are also indicated.

More detailed views of the schedule are provided on the Batch Entry and Procedure Entry Windows.

The Batch Entry Window is displayed when a scheduled batch node is selected on the SchedulePro Navigation Tree under Production Schedule. It provides updated procedure start/end times.

The Procedure Entry Window is displayed when a scheduled procedure node is selected on the SchedulePro Navigation Tree. It provides updated operation start/end times.
7.4.3 Viewing Conflicts

If SchedulePro cannot arrange a feasible schedule it will leave some resources over-allocated, creating conflicts in the schedule.

To view the conflicts, select Conflict View from the batch’s context (right-click) menu. A table appears with information about all the conflicts in the batch.

<table>
<thead>
<tr>
<th>Type</th>
<th>Start</th>
<th>End</th>
<th>Duration [sec]</th>
<th>Resource</th>
<th>Event</th>
<th>Conflicting Event</th>
<th>Priority</th>
</tr>
</thead>
<tbody>
<tr>
<td>Equipment</td>
<td>4/12/2020 10:03:41</td>
<td>4/2/2020 02:51:41</td>
<td>8068</td>
<td>R1</td>
<td>Mab1-1-6: P5</td>
<td>Mab1-1-5: P5</td>
<td>3</td>
</tr>
<tr>
<td>Equipment</td>
<td>4/6/2020 10:45:11</td>
<td>4/7/2020 03:33:11</td>
<td>8068</td>
<td>R1</td>
<td>Mab1-15: P5</td>
<td>Mab1-14: P5</td>
<td>3</td>
</tr>
<tr>
<td>Auxiliary</td>
<td>4/7/2020 00:18:10</td>
<td>4/7/2020 01:25:28</td>
<td>4038</td>
<td>CIF-Stir-102</td>
<td>Mab1-1-4: P7</td>
<td>Mab1-1-3: P7</td>
<td>3</td>
</tr>
</tbody>
</table>

The following columns are reported:

**Type**
The type of resource that is over-allocated

**Start/End**
The period of the conflict

**Resource**
The over-allocated resource

**Event/Conflicting Event**
The operations or procedures that are involved in the conflict

**Priority**
An internal metric used by SchedulePro

Equipment conflicts are also displayed in the equipment occupancy charts.
The right-click or context menu for a conflict has the following options:

- Edit Procedure – Edit the scheduled procedure
- Resolve Conflict – Attempt to resolve the conflict with the default resolution strategy.

7.4.4 Resolving Conflicts
SchedulePro does not automatically resolve conflicts that result from scheduling in layout mode or from user modifications to the schedule. The user may resolve such conflicts manually. The conflict resolution tools are only enabled when there are conflicts to be resolved.

Conflicts may be resolved from the SchedulePro main view or from the Equipment Occupancy Chart (see Charts and Reports). Conflicts may be resolved for batches, for campaigns, or for the entire schedule.

**Resolving Conflicts for the Entire Schedule**
The Resolve Conflicts tool in the main toolbar will invoke the scheduler to resolve all conflicts in all batches.

**Resolving Conflicts for a Campaign**
Select the campaign in the Campaign Sequence window and click the Resolve Conflicts button in the toolbar. Alternatively, select the campaign, right-click and select “Resolve Conflicts.”

**Resolving Conflicts for a Batch**
Select the batch in tree, the batch sequence window and select the resolve conflicts button. Alternatively, right-click on the batch and select “Resolve Conflicts.”

7.4.5 Campaign Scheduling Dependencies
Normally, campaigns scheduling priorities are determined by their order in the campaign list. However if a campaign is set to be event-based, it is always scheduled after the other campaigns that affect the storage unit in the event condition. Furthermore, if the storage unit in the event condition is associated with one or more equipment units, SchedulePro will automatically generate campaigns to represent the occupancy of the storage equipment.

To view the order of scheduling select “Schedule→Scheduling Dependencies and Order…” from the main menu.

**Dependencies Tab**
If an event-based campaign is selected in the drop-menu, the controlling campaign is shown in the Depends On list. Any associated holding campaigns are shown in the Is Scheduled in Parallel With list.
Order Tab
The order tab shows how all the campaigns are scheduled.
7.5 Modifying the Schedule

The schedule may be modified by editing any of the scheduled items (batches, procedures or operations). These items may be edited by accessing their properties dialogs. Timing changes may also be made through drag-and-drop operations in the Equipment Occupancy Chart. See Chapter 8.

The schedule’s overall economics are available from the context menu of the Production Schedule node in the navigation tree or from the Schedule menu.

7.5.1 Modifying Scheduled Campaigns

Accessing Campaign Properties

The scheduled campaign properties dialog is accessed by any of the following:

- Right-click the scheduled procedure icon ( располагаемый ) in the tree-view (left pane)
- Right-click the campaign in the campaign-list view
- Click the Edit Campaign (редактирование) button in the campaign-list view
- Right-click a campaign bar in the Gantt chart
Right-click a bar in the Equipment Occupancy chart

For a Scheduled campaign, the user-editable options are limited.

**Campaign ID**
The name of the campaign may be modified.

**Number of Batches**
Batches may be added by increasing the number of batches. The number of batches may *not* be set to a value less than the number of currently scheduled batches. The additional batches will be added to the end of the campaign according to the campaign’s batch start time options. Any resulting conflicts will not be resolved automatically, but they may be resolved by the user.

**Release Date**
Changing the release date does not immediately affect the campaign or any of its batches, but if the campaign is rescheduled, it will respect the new release date.

**Start Date**
Changing the start date of the campaign immediately shifts all batches by the amount of the change. If there are conflicts with other campaigns, SchedulePro will offer to shift them as well. Otherwise resulting conflicts are not resolved.

**Advanced (Cleanout/Changeover) Options**
Pre-campaign and post-campaign options may be added or modified for scheduled campaigns.

**Comments**
User comments or note may be added to scheduled campaigns.

### 7.5.2 Modifying Scheduled Batches
The batch properties may be accessed by any of the following actions:

- Right-click the batch icon (ın the tree-view (left pane)
- Right-click the batch in the batch-list view
- Click the Edit Batch (ın the batch-list view
- Right-click a batch bar in the Gantt chart
- Right-click a bar in the Equipment Occupancy chart
The batch properties dialog has four tabs: Schedule, Resources, Status and Comments.

**Batch Schedule Tab**

The following options are available:

**Batch ID**
The name for the batch; must be unique

**Recipe**
The recipe (information only).

**Color**
The batch color to be displayed in the equipment chart.

**Start Date and Time**
If this is adjusted, the batch start will be set to the time entered. Resulting conflicts are shown but not resolved.

**End Date and Time**
This is displayed for information only.
**Conflicts**
(Information only) This displays whether this batch has any conflicts with previous batches.

**Batch Resources Tab**

**Suite Assignments**
This is a table of the suite assignments (if any) for all the sections in the batch. Changes in suite assignment will result in new equipment assignments for procedures in the affected sections. Resulting conflicts are not resolved.

**Resource Assignments**
This tab displays an editable table of all the equipment and work area assignments for all the procedures and for those operations that use auxiliary equipment. Any conflicts that result from changes to resource assignments are not resolved.

This table is intended as a quick way to edit the most commonly considered resources for procedures and operations. For other resources, edit the procedure and operation entries.

**Batch Messages Tab**
This tab displays information about any scheduling actions taken by the scheduling algorithm.

**Batch Comments Tab**
This tab displays and allows editing of user comments.
Batch Status Tab
This tab provides a status display. **Started** indicates that one or more operations in the batch have been started and at least one is not complete. **Completed** indicates that all operations in all procedures are completed.

This tab is only displayed if the current time is set.

User Messages Tab
This tab displays information about any scheduling actions taken by the scheduling algorithm. User changes and drag/drop actions are not logged.

Batch Economics Tab
This provides an overview of the cost information for the batch.

Batch Locking
To lock a batch is to prevent any modification by either the user or the scheduling algorithm. Right-click on a batch and select “Lock” to toggle its lock status.
7.5.3 Modifying Scheduled Procedures

Any of the following actions will modify the properties of a scheduled procedure entry:

The scheduled procedure properties dialog may be accessed any of the following:

Right-click the scheduled procedure icon ( ) in the tree-view (left pane)
Right-click the procedure in the scheduled procedure list view
Click the Edit Scheduled Procedure ( ) button in the scheduled procedure list view
Right-click a procedure bar in the Gantt chart
Right-click a bar in the Equipment Occupancy chart

The procedure entry dialog has three tabs: Schedule, Resources and Status

Procedure Schedule Tab

The following options are available:

Start Date and Time
Changing this value introduces a time-shift in the first operation in the procedure. If other operations are independently scheduled, it may be more effective to change the operation timing directly. Resulting conflicts are not resolved.

Procedure Resources Tab

The following are available:

Equipment
Change the main equipment selected for the procedure. Resulting conflicts are not resolved. If the desired equipment resource is in a difference suite, change the batch suite first.

Work Area
Change the work area for the procedure. Resulting conflicts are not resolved.

Procedure Status Tab

Started
Indicates that at least one operation is started and at least one operation is complete.

Completed
Indicates that all operations are complete.

Operations Tab

The table displays the scheduled operations and their respective timing. Use the edit ( ) button or double-click to edit an operation.

Comments Tab

User comments may be entered for the scheduled procedure. The comments will be deleted if the campaign is rescheduled.

7.5.4 Modifying Scheduled Operations

The user may modify the timing, equipment, transfer panels or staff for a scheduled operation. Resulting conflicts are not automatically resolved.
The scheduled procedure properties dialog may be accessed by any of the following:

- Right-click the operation in the scheduled operation list view
- Click the Edit Scheduled Operation properties button in the scheduled operation-list view
- Right-click an operation bar in the Gantt chart
- Right-click a bar in the Equipment Occupancy chart

**Schedule Tab**

The scheduled operation dialog has the following entries:

- **Operation Identification**
  (Information only) This includes the operation name, procedure, batch and campaign.

- **Scheduling**
  Displays the scheduling link for the operation

- **Duration link**
  Displays the duration link if any

- **Actual Start**
  The user may change the start of the operation. This action will add a shift. Alternatively the user may check the “Set Delay” box to enter a value for the time shift.

- **Time Shift**
  Displays the time shift (either fixed or flexible)

- **Set Time or Set Duration Options**
  The user may modify both the duration and the time shift. This may be done directly or indirectly by modifying

  - **Duration (Working/Actual)**
    Modify the duration of the operation (if it is not linked). Durations that are linked to other operations cannot be directly edited. The working duration is exclusive of any idle time introduced by operation interruptions. The Actual duration is the difference between the overall end and start times.

  - **Delay**
    Modify the start time shift of the operation. This will be applied regardless of any flex shift limits.

- **Breaks**
  For interruptible operations, this table displays any interruptions that have been added to the operation. The user may add, delete or modify breaks in an operation.

**Resources Tab**

- **Auxiliary Equipment**
  If the operation has auxiliary equipment, a pull-down list displays the current assignment. The equipment assignment may be changed.

- **Transfer Panels**
  If the operation uses transfer panels, the panels and the assigned pathways for each panel are displayed. The pathway assignment may be changed.

- **Staff**
If the operation requires staff, the assigned staff is listed. The user may change staff assignments if other staffing options are available.

**Status Tab**

**Started**
Indicates that at least one operation starts before the current time and ends after.

**Completed**
Indicates that the operation ends after the current time.

**Comments Tab**
The comments window allows the user to enter comments that will be saved with the scheduled operations. The comments will be deleted if the campaign is rescheduled.

### 7.5.5 Modifying the Completion Status

The completion status of an operation, procedure, batch or campaign is determined by its relationship to the *current time*. The current time in SchedulePro reflects the division between past events and future (planned) events. To set the current time, use the Schedule Timing Tool ( ) on the main toolbar and select the Current Time Tab.

![Scheduler Timing](image)

Enter a time or select “Set to Computer Clock” to set the current time. All operations that are completed before the current time are marked completed. All operations that start before the current time but end after are marked as started.

Moving an operation forward or backward in time may affect its completion status.
Chapter 8: Charts and Reports

8.1 Introduction

8.2 Contents and Ordering Options for Charts and Reports

8.2.1 Clipping Options

Campaign/Batch selection
Start and End time Selection

8.2.2 Contents and Ordering

Resource Selection Tab
Ordering Tabs

8.3 Common Chart Timescale Toolbars and Commands

8.3.1 Timescale Buttons
8.3.2 Timescale Options

8.4 Gantt Chart

8.4.1 Gantt Chart Commands

File Menu Item
Edit Menu Item
Preferences Menu Items
Gantt Chart Toolbar
Editing the Schedule from the Gantt Chart

8.5 Equipment Occupancy Charts

8.5.1 Equipment Occupancy Chart Toolbars
8.5.2 Drag and Drop Editing Menu
8.5.3 Scheduler Settings
8.5.4 Campaign Management
8.5.5 Database Menu
8.5.6 Weekend Hours
8.5.7 Viewing Other Charts from the Equipment Occupancy Chart
Resources Tab ............................................................................................................. 262
Recipes Tab ........................................................................................................... 262
8.7 Inventory Profiles ............................................................................................... 262
    8.7.1 Types of Inventory Profiles .......................................................................... 262
        Storage Unit Inventory ..................................................................................... 262
        Supply System Inventory .............................................................................. 262
        Equipment Capacity Inventory ...................................................................... 262
        Equipment Material Inventory ...................................................................... 262
    8.7.2 Displaying an Inventory Profile ................................................................. 262
        Inventory Profile Setup Resources Tab ......................................................... 262
        Inventory Profile Setup Recipes Tab ............................................................ 263
    8.7.3 Inventory Chart – Printing, Copying, and Exporting .................................. 263
    8.7.4 Inventory Chart Line Styles in Detail .......................................................... 263
        Lines .................................................................................................................. 263
        Y-Axes .............................................................................................................. 265
8.8 Utilization Charts ............................................................................................... 266
    8.8.1 Utilization Chart Fit-to-Window Mode ....................................................... 267
    8.8.2 Utilization Chart Styles in Detail ................................................................. 267
    8.8.3 Setting the Time Window for Utilization Charts ........................................ 268
8.9 Easy-Print Charts .............................................................................................. 268
    Easy Print Chart Controls .................................................................................. 269
        Print .................................................................................................................. 269
        Print Preview .................................................................................................. 269
        Copy to Clipboard ......................................................................................... 269
        Toggle Fit to Window ...................................................................................... 269
        Zoom Menu ................................................................................................... 269
        Settings .......................................................................................................... 269
8.10 SchedulePro Reports ................................................................. 269

8.10.1 Report Options ........................................................................... 270

8.10.2 Schedule Reports ....................................................................... 270

  Schedule Report .............................................................................. 270
  Equipment Occupancy Report ......................................................... 272
  Staff Report ..................................................................................... 273
  Equipment Utilization Table ............................................................ 274
  Equipment Utilization Trend Report ................................................. 274
  Materials Report .............................................................................. 275
  Daily Activities Report ..................................................................... 277
  Economics Report ............................................................................ 279

8.10.3 Graphical Reports .................................................................... 280

  Gantt Report ................................................................................... 280
  Equipment Occupancy Graph .......................................................... 281

8.10.4 Recipe Report ......................................................................... 282

8.10.5 Transfer Panel Report .............................................................. 284

8.11 Saving Reporting Options ........................................................... 285

8.1 Introduction

SchedulePro presents results in charts and reports. SchedulePro can also export data for reporting in external applications.

All the charts are available under menu item “View” on the main SchedulePro menu. The equipment occupancy and Gantt charts may also be viewed in “Easy-Print” format, which is not interactive but which has more printing options.

SchedulePro also provides a number of report types for reporting scheduling results. All reports are generated in HTML format. Reports are generated and viewed by selecting item “Reports” from the main SchedulePro menu and by selecting the appropriate report type. A name and location for the report file must be specified. Reports may be printed from the context menu of the report-viewing window. Reports may also be opened with and displayed in any web browser and in most office software supporting the HTML format.

Chart data may be exported for use with MS Excel. The scheduling data may be exported to MS Project or to an Access database format. Chapter 9 describes the SQL Server database features.

8.2 Contents and Ordering Options for Charts and Reports
8.2.1 Clipping Options

A number of charts and reports are clippable that is their contents may be limited to included only certain campaigns or batches and to cover only a certain time range. Select “Reports/Clipping Options” to access the clipping dialog.

Campaign/Batch selection

The campaigns and batches that will be included in the reports and charts can be selected from the Campaign/Batch tab of the Clipping Options dialog. By selecting a campaign, all batches belonging to this campaign are also selected. Individual batches can be selected by checking the batch elements on the second level of the tree. The following toolbar buttons can also be used:

- Select all tree items
- Deselect all tree items

Start and End time Selection

On the Time tab of the dialog, the start and end time clipping options can be set. By setting the start and end times the reports or charts are created only for the specified time period and not for the whole schedule duration. By choosing the Auto option for the report start time, the report starts at the beginning of the schedule, while by choosing the Auto option for the report end time the report ends at the end of the schedule. If both options are set to Auto there is not any time clipping done and the report contains the entire schedule. By selecting the User Defined option the start and end times can be set either in an absolute manner or relatively to the start of the schedule (in which case the preferred time units can also be selected). The absolute and relative times always have equivalent values (when one changes the other is automatically updated).
8.2.2 Contents and Ordering

The primary resources contained in the charts and reports (equipment, work areas, staff), as well as the order in which they are displayed can be set through the Contents and Ordering dialog. This dialog can be accessed from the either from the Equipment Occupancy Chart context menu or from the Report Options dialog.

The Contents and Ordering dialog provides a maximum of 4 tabs for controlling the visibility of resources and for setting the ordering within each resource category. Currently, the options set through this dialog apply to the Equipment Occupancy Chart, the Equipment Time Utilization Chart, the Equipment Occupancy Graph and the Equipment Utilization Table.

Resource Selection Tab

The Resource Selection Tab consists of a number of inclusion options and a check tree that are based on the available facilities. The contents of the tree can be modified by setting the options on the left side of the dialog, while the visibility of individual resources can be modified by selecting or deselecting the corresponding elements on the tree. The tree is structured in the hierarchical order Facilities, Resource Categories, Individual Resources, allowing the selection of a group of resources to be done at once. For example, by selecting a facility, all resources (equipment, work areas, staff) belonging to this facility will also be selected.

On the left side of the Resource Selection tab the following options are available:

Include Main Equipment: Include main equipment on the tree.

Include Auxiliary Equipment: Show/hide auxiliary equipment on the tree.

Include Staff: Include staff in the tree.

Include Work Areas: Include work areas in the tree.

Include Material Supply Systems: Include material supply systems in the tree.

Include Transfer Panels: Show/hide transfer panels on the tree. The transfer panels can be shown as components (in which case bridges and ports can be individually selected) or as complete paths.

Exclude Unused Equipment: Show/hide unused equipment on the tree.

Exclude Unused Work Areas: Show/hide unused work areas on the tree.

Exclude Unused Staff: Show/hide unused staff on the tree.

Exclude Unused Material Supply Systems: Show/hide unused material supply systems in the tree.

On the right side of the Resource Selection tab each tree element has a corresponding check box that can be checked or unchecked. By clicking on the (+) or (-) signs the corresponding branches can be expanded or collapsed respectively. Additionally, the following toolbar items can be used:

Select all tree items.

Deselect all tree items.
Ordering Tabs

*Equipment Ordering Tab*

The Equipment Ordering tab provides control over the order in which the equipment items are displayed. The tab is displayed only if there is at least one piece of equipment. Equipment may be repositioned by dragging and dropping.

Additionally, the following toolbar items are available:

- ![Swap](image) Swap with the next higher item.
- ![Swap](image) Swap with the next lower item.
- ![Move](image) Move to the top.
- ![Move](image) Move to the bottom.
- ![Order](image) Order alphabetically by name.
- ![Order](image) Order by time of first use.
- ![Reset](image) Reset the order to the previously saved settings.

Other ordering options include:

- **Show Main First:** When clicked, equipment that is used as main equipment in the current schedule will be displayed first in the ordered list.
- **Show Auxiliary First:** When clicked, equipment that is used as auxiliary equipment in the current schedule will be displayed first in the ordered list.
- **Group by Facilities:** If checked the equipment will be grouped so that equipment in the same facility are near one another.
- **Group by Suites:** If checked, equipment in the same suite will be grouped together.

*Work Areas Ordering Tab*

The ordering of the work areas can be set in the same way as the ordering of equipment in the Equipment Ordering tab. The tab is displayed only if there is at least one work area. The main and auxiliary options do not apply to work areas.

*Staff Ordering Tab*

The ordering of the staff members can be set in the same way as the ordering of equipment in the Equipment Ordering tab. The tab is displayed only if there is at least one staff member. Additional options include:

- **Group by Facilities**
  If checked, the staff members will be grouped so that equipment in the same facility are near one another.

- **Show Before Equipment**
  If checked, staff members will appear before the rest of the resources (equipment and work areas); if not checked, staff members will appear after the rest of the resources.
8.3 Common Chart Timescale Toolbars and Commands
A number of SchedulePro charts are displayed with a time scale on the horizontal (x) axis. The charts have common toolbar options and style commands to adjust how the time axis is displayed.

8.3.1 Timescale Buttons

Zoom: Zoom in or out to the desired percentage or zoom to a selected time value.

Toggle Fit to Window: When on, the entire contents are scaled to fit in the chart. This is the default setting. When fit-to-window mode is active, the zoom features are disabled.

8.3.2 Timescale Options
To access the timescale options for any time chart, right-click on the white space on the chart to access the context menu and select option to edit the style. The style dialog will have several tabs; select the Time Scale tab.

The following items are available:
**Time Basis**
Use either Absolute (calendar) or Relative times.

**Minor Time Interval**
The chart shows minor and major time unit intervals. Set options related to the minor time units.

- **Show minor grid lines**: Show/hide vertical grid lines for minor time units.
- **Minor Units**: Specify the minor time interval units.
- **Minor Units/Tick**: Specify the number of minor units (i.e. 2 hrs) contained in one minor unit interval.
- **Minor Label Format**: Specify a display format for the minor unit labels. Several locale options are available.

**Major Time Interval**
Set options related to the major time units.

- **Show major grid lines**: Show/hide vertical grid lines for major time units.
- **Major Units**: Specify the major time interval units.
- **Major Units/Tick**: Specify the number of major units (i.e. 2 days) contained in one major unit interval.
- **Major Label Format**: Specify a display format for the major unit labels. Several locale options are available.

### 8.4 Gantt Chart
To view a Gantt chart of the current schedule, select “View→Gantt Chart…” from the main menu or select the Gantt Chart ( ) button from the toolbar. The Gantt chart appears in a separate window.

The bars are color-coded as operation, procedure, batch, or campaign. Vertical hatching indicates a partially completed activity. Cross hatching indicates a fully completed activity. The current time, if specified, is displayed on the chart as a vertical red line.
The Gantt chart displays campaigns, batches, procedures, and operations. Outline buttons in the table can be used to show (+) or hide (-) items in the chart.

### 8.4.1 Gantt Chart Commands

The Gantt chart commands are also available from the Gantt context menu.

#### File Menu Item

The File menu item provides entries for printing and print previewing the chart.

- **Print Preview Chart**
  Display the print preview of chart portion of the Gantt chart window.

- **Print Chart**
  Print the chart portion of the Gantt chart window.

- **Print Preview Spreadsheet**
  Display the print preview of the spreadsheet portion of the Gantt chart window.

- **Print Spreadsheet**
  Print the spreadsheet portion of the Gantt chart window.

- **Exit**
  Close the Gantt chart window.

#### Edit Menu Item

The Edit menu item provides entries for copying the chart.

- **Copy Gantt Chart**
  Copy the chart portion of the Gantt chart window to the system clipboard in Windows Metafile format (wmf).

- **Copy Gantt Spreadsheet**
  Copy the spreadsheet portion of the Gantt chart window to the system clipboard.

#### Preferences Menu Items

The Preferences menu item provides entries for setting style preferences in the Gantt chart. Also, by clicking on the “Clipping Options…” menu item the global clipping options can be changed as described in section 8.3.

- **Styles/Gantt Chart**
  Edit all of Gantt chart style options.

  - **Grid Columns**
    
    - **Include Start Time**: Display the start time.
    
    - **Include End Time**: Display the end time.
    
    - **Include Description**: Display the description.

  - **Include Summaries**
    Include bars for the following summary information.

    - **Branch Summary**: Include Branch bars.
Section Summary: Include Section bars.

Cycle Summary: Include cycle bars.

General

Show horizontal gridlines.

Show equipment name in procedure.

Bar Display Options
Edit bar styles for all the chart elements (campaigns, batches, branches, sections, procedures, cycles, operations). The following options are available for all elements:

Name: Display the name near the bar.

Duration: Display the duration near the bar.

Description: Display the description near the bar.

Color: Select a color for the corresponding element. Clicking on the “Color” button brings up the color picker dialog.

Pattern: Select fill-patterns for started and completed elements. Clicking on the “Pattern” button brings up the pattern picker dialog.

Include Equipment in Procedure Name: Includes the main in equipment with the procedure name.

Include Used Equipment List in Batch Text: Includes all the main equipment in the batch text.

Gantt Chart Toolbar
The first two buttons of the Gantt chart toolbar belong to the common timescale toolbar described in section 8.4.1. The rest of the buttons have the following functionality:

Detail Level
Set the detail level for the Gantt chart. Selecting a certain level of detail forces all tasks on the Gantt chart to be expanded up to the selected level.

Current Time
Set the current time shown on the chart as a vertical red line.

Editing the Schedule from the Gantt Chart
To edit a schedule from the Gantt chart, right-click on an item bar to bring up the item’s context menu. The first menu option will display the appropriate dialog for editing the schedule.

This interface is not available for branch, section, or cycle summary bars.

8.5 Equipment Occupancy Charts
To display an equipment occupancy chart, select “View→Equipment Occupancy Profile…” from the main SchedulePro menu or select Equipment Occupancy button () from the toolbar. The equipment occupancy chart is shown in a separate window.
Equipment is listed on the vertical axis of the chart, while time is shown on the horizontal axis. Staff resources, if assigned, are shown on the same chart. Chart bars are optionally color coded by batch, campaign or recipe. Each section in a bar denotes an operation. A hollow bar indicates idle time within a procedure. Moving the mouse over each bar section displays the names of the procedure and operation for which the equipment is used.

Weekend hours are optionally displayed as a background color. Facility down time is displayed as a gray background color. To set the weekend hours, select “Schedule ➔ Set Weekend Hours…” from the main menu. Downtime is set for the specific equipment or facility.

Cross hatching indicates a completed activity. Facility and equipment down-time are displayed as gray blocks.

Quick drag-and-drop editing may be performed by dragging and dropping the bars. In the Equipment Occupancy chart the zoom buttons have been consolidated so that both functions (zoom-to-time and zoom-by-percentage) are accessible through a single magnifying glass button.
8.5.1 Equipment Occupancy Chart Toolbars

The Equipment Occupancy Chart (EOC) has two toolbars. The main toolbar supports most chart operations except tracing. The second toolbar supports the tracing feature, see 8.5.12. The toolbars may be moved by dragging. The toolbars may only be attached at the top or bottom of the window.

8.5.2 Drag and Drop Editing Menu

There are five drag-and-drop modes for the Equipment Occupancy chart. The desired mode can be selected from the corresponding combo box. The following drag-and-drop modes are available:

- Drag and drop in the Equipment Occupancy chart is disabled when the No Drag option is selected.
- Drag and drop by project. This option is only available if viewing projects is enabled and projects have been defined.
- Drag and drop by campaign. In this mode, dragging and dropping a bar moves the entire campaign by the amount that the bar is dragged.
- Drag and drop by batch. In this mode, dragging and dropping a bar moves the entire batch by the amount that the bar is dragged. To delay for specific conflicts, use the “Delay for Conflict” option in the Batch context menu.
- Drag and drop by procedure. In this mode, the procedure is moved by the amount dragged. This move is accomplished by adding a positive or negative shift to the first operation in the procedure. If other operations in the procedure are not dependent on the first operation, unexpected results may occur. To delay for specific conflicts, use the “Shift for Conflict” option in the Procedure context menu.
- Drag and drop by operation. In this mode only the operation is moved. The move is accomplished by adding a positive or negative shift to the operation.

8.5.3 Scheduler Settings

The scheduler settings can be modified through the following buttons on the Equipment Occupancy chart toolbar:

- Edit Schedule Timing
  Brings up the Scheduler Timing dialog containing two tabs. From the Scheduling Horizon tab the Start Date and Time and the Scheduling Horizon can be modified. From the Current Time tab the current time can be set. By clicking on the Set to Computer Clock button the SchedulePro current time can be set to the system time.

  Use the slider to drag the current time line.
Selects the active scheduling mode. The available scheduling modes include the three built-in modes (Automatic, Layout, ASAP) as well as any number of custom modes created by the user. Through the “Scheduling Options…” command the scheduling options of the selected scheduling mode can be modified. The “Add New Mode…” command creates a new scheduling mode, while the “Edit mode…” command brings up the mode management window.

8.5.4 Campaign Management

The campaign creation, sequencing and scheduling can be managed through the buttons on the right side of the Equipment Occupancy chart toolbar. The combo box in the center of the campaign management buttons contains all campaigns in the production schedule. Each button can trigger one or more actions using as a reference the currently selected campaign. The buttons available on the campaign management section of the toolbar are the following:

Schedule campaigns
The schedule campaigns button groups the following commands:

“Schedule All Campaigns:” Schedules all the campaigns.

“Reset and Schedule All Campaigns:” Unschedules and schedules all unscheduled campaigns.

Unschedule campaigns
The unschedule campaigns button groups the following commands:

“Unschedule Campaign:” Unschedules the currently selected campaign.

“Unschedule From Start to Campaign:” Unschedules all scheduled campaigns from the start of the production schedule up to and including the selected campaign.

“Unschedule From Campaign to End:” Unschedules all scheduled campaigns from the selected campaign to the end of the production schedule.

“Unschedule All:” Unschedules all scheduled campaigns.

Resolve conflicts
(Available only if conflicts exist.)
The resolve conflicts button groups the following commands:

“Resolve Conflicts for Campaign:” Resolves conflicts in the currently selected campaign.

“Resolve Conflicts from Start to Campaign:” Resolves conflicts in all scheduled campaigns from the start of the production schedule to the currently selected campaign.

“Resolve Conflicts from Campaign to End:” Resolves conflicts in all scheduled campaigns from the currently selected campaign to the end of the production schedule.

“Resolve All Conflicts:” Resolves conflicts for all scheduled campaigns.

Select Campaign (Drop Menu)
Select a campaign. All campaign operations apply to the selected campaign.

Campaign Drop Menu
“Edit Selected Campaign:” Brings up the Campaign Setup dialog through which the campaign options can be edited.
“Add new campaign:” Adds a new campaign to the end of the production schedule priority list.
“Insert new campaign:” Inserts a new campaign after the currently selected campaign.
“Promote campaign:” Moves the selected campaign one place up the production schedule priority list.
“Demote campaign:” Moves the selected campaign one place down the production schedule priority list.
“Delete campaign:” Deletes the selected campaign.
“Scheduling Dependencies and Order:”

8.5.5 Database Menu
The database dropdown menu should be used with the SQLServer database features. See Chapter 9 for details.
“Export Schedule to SQL DB:” This options exports all the scheduled campaigns to the SQL database.
“Export Selected Campaign to SQL DB:” This options exports only the selected campaigns to the SQL database.
“View Stored Campaigns:” View the exported campaigns
“Manage Database:” View and manage all campaigns in the database.
“Scheduling Dependencies and Order:” Displays the scheduling dependencies dialog.
Scheduling Dependencies and Order

This dialog shows the dependencies of campaigns scheduled with the event-based option. The check box indicates that the campaign selected in the drop-menu is automatically updated and is dependent upon the campaign(s) in the “Depends On” list. If the storage unit in the event-based condition is associated with equipment, then the automatically generated material holding campaigns are shown in the “Scheduled in Parallel With” box.

8.5.6 Weekend Hours

The equipment chart may optionally display weekend hours. These hours have not influence on scheduling. Select “Schedule→Set Weekend Hours…” from the main menu.
8.5.7 Viewing Other Charts from the Equipment Occupancy Chart

The main SchedulePro view displays only one chart at a time. The Equipment Occupancy Chart can display multiple resource or inventory charts and align their time axes. The details for resource and inventory charts are described in sections 8.7 and 8.8.

Displaying Resource Charts from the Equipment Chart

Click the resource chart button ( ) on the chart toolbar to display a resource consumption chart as described in section 8.6. Multiple resource charts may be displayed. Editing actions in the Equipment Occupancy Chart will immediately update the resource chart(s).

Displaying Inventory Charts from the Equipment Chart

Click the inventory chart button ( ) to display an inventory chart as described in section 8.7. Multiple inventory or resource charts may be displayed. Editing actions in the Equipment Occupancy Chart will immediately update the inventory chart(s).

Managing Child Charts

When inventory or resource charts are displayed from the equipment chart, they are child charts. Click the link button on the toolbar to manage the behavior of the child charts. The following options are available:

“Unlink Charts:” Unlinks any linked child charts. By default child charts are linked, so any user modifications, e.g. drag and drop, are immediately reflected in the child charts. Unlinking the charts disables the update and can improve the performance of charts for large schedules.

“Bring Unlinked Charts to Front:” This option displays any child charts that may be hidden by other windows.

“Auto Update Children Charts:” When checked (default) any editing actions in the Equipment Chart are automatically reflected in the child chart(s).
**Update Child Charts**
This button manually updates the child chart if the chart is not linked.

**Child Chart Buttons**
Any chart that is displayed from the Equipment chart may be linked with the equipment chart. Select the link button from the toolbar of the child chart. The chart will be reconfigured so its time scale is aligned with the scale in the Equipment Chart. Any actions in the Equipment Chart (scrolling etc.) will be reflected in the linked child chart. A linked chart remains linked even if the equipment chart is dismissed.

The update button on the child chart will update the chart if the Auto Update option has not been selected in the Equipment Chart.

### 8.5.8 Conflict Display
SchedulePro will display those conflicts due to equipment, staff, or work area over-allocation. Operations that have resource conflicts are displayed with a red frame and the equipment name on the Y-Axis is followed by an exclamation mark (!). Operations that over allocate equipment are displayed as an additional row in the chart below the original equipment row. The row is labeled with an exclamation mark (!).

### 8.5.9 Equipment Occupancy Context Menu
The chart view may be adjusted from the context (right-click) menu.

- "Fit to window:" Select this option to stretch or compress the entire chart in the available view area. Zooming is disabled. Scrolling is disabled.
- "Zoom in:" If the chart is not at maximum zoom, select this option to magnify the scale.
- "Zoom out:" If the chart is not at minimum zoom, select this option to view more of the schedule.
- "Edit Style:" Edit the chart display options and scale. See section 8.6.8.
- "Edit Contents / Ordering:" Edit the chart contents options. See section 8.2.
- "Copy:" Copy the chart as a graphic object.
- "Copy Legend:" Copy only the legend as a graphic object.
"Export Data to Excel:" Exports the data used to generate the chart. The data is saved in a file.

"Export Entire Schedule to SQL Database:" Exports the schedule to the SQL Server Database.

"Print Preview:" Displays the print preview screen.

"Print:" Prints the chart.

8.5.10 Styles in Detail
The default chart style may be modified by selecting item “Edit Style” from the context menu.

The equipment occupancy chart’s Style dialog provides two Tabs for customizing different aspects of the Gantt chart display details.

General Tab
On the General tab, the following options are available.

Show Legend
Show/hide descriptive legend on the right of the chart. The legend has four display options: Batch, Recipe, Campaign, Project. These may be set independently of the bar coloring option.

Maximum (Legend) Width
The legend, if displayed, will be sized to show up to the specified number of characters.

Bar Color Option
The choice is independent of the legend contents. One of the following bar coloring options may be chosen: Color by batch, Color by recipe, Color by Campaign, Color by Project (when projects are used).

Use Operation Type Colors
If chosen, operations will be display the color of their associated types. Types must be previously defined and assigned to operations.

Use Gray for Untyped Operations
Operations without a type will be displayed in gray regardless of the bar coloring choice.

Percent fade for cleanout/changeover batches
Cleanout or changeover batches will be displayed in the campaign color faded by this factor. A value of 100 results in those batches to be filled with white color. A value of 0 results in those batches to be filled with the campaign color.

Bar Height
The height of the bars in pixels.

Drag / Drop Mode
Items on the equipment occupancy chart may be dragged and dropped to manually adjust the schedule. Select the type of item to move (batch, procedure, or operation). Deselect all the drag/drop options to exit drag/drop mode.

Bar Style Tab
No Text Display in Occupancy Bars: Information about each bar is displayed only in the tooltips.

Display Text On Bars: If the Display Text On Bars options is selected then for the checked entities the names will be displayed on the corresponding bars.
**Time Scale Tab**

See 8.3.2, Time Scale Options.

**Edit Contents/Ordering**

Brings up the “Contents/Ordering” dialog that allows for selecting which resources will be shown and in what order, as explained in section 8.2.

**8.5.11 Editing from the Occupancy Chart**

To edit a schedule from the equipment occupancy chart, right-click on an item bar to bring up the item’s context menu. Four different menu items can be selected to bring up the operation, procedure, batch, or campaign related options. The bar context menu has the following entries:

**Operation**

“Properties:” Brings up the Edit Scheduled Operations dialog.

“Delete Batch Onwards:” Deletes the current operation and all operations to the end of the batch.

**Procedure**

“Properties:” Brings up the Edit Scheduled Procedure dialog.

“View Conflicts:” Display the conflicts for the batch.

“Resolve Conflicts:” Resolves all conflicts for the selected procedure. Available only for procedures with conflicts.

“Delete Batch Onwards:” Deletes the current procedure and all procedures to the end of the batch.

“Shift For Conflict:” (Displayed only for procedures with conflicts.) Delay (shift) the procedure to avoid the current conflict.

**Batch**

“Highlight:” Toggles highlighted display mode which fades all batches except the highlighted one.

“Properties:” Displays the Edit Scheduled Batch dialog.

“Lock:” Locks the selected batch so that it cannot be moved.

“Delete:” Deletes the selected batch.

“Copy Batch Timing and Equipment:” Copy all the updated durations, shifts, and equipment selections.

“Copy User-Defined Shifts to Recipe :” Copy all the user-defined scheduling shifts to the recipe.

“Recalculate Conflicts:” Recalculates the conflicts for the selected batch (updates the conflict list).

“View Conflicts:” Brings up the Conflicts List window containing a detailed list with all the conflicts of the selected batch. Available only for batches with conflicts.

“Resolve Conflicts:” Resolves all conflicts for the desired batches. The submenu items resolve conflicts for the following batches:

“For Batch” – only for the selected batch, “From Campaign Start” – the batches from the start of the current campaign up to and including the selected batch,

“To Campaign End” – the batches from the selected one to the end of the current campaign,
Charts and Reports

“From Schedule Start” – the batches from the start of the schedule up to and including the selected batch, “To Schedule End” – the batches from the selected one to the end of the schedule. The command is available only for batches with conflicts.

“Delay Start For Conflict::” (Displayed only for batches with conflicts.) Delay the start of the batch to avoid the current conflict.

“Remove All Shifts and Breaks:” Reset to default timing. This option appears only if there are user-defined shifts.

“Reschedule::” Deletes the desired batches and schedules them from scratch. The functionality of the submenu items is the same as in the “Resolve Conflicts” command above.

**Campaign**
The Campaign menu item contains the following subcommands:

“Highlight:” Displays the campaign in highlighted mode, fading all batches in other campaigns.

“Properties:” Brings up the Campaign Setup dialog.

“Lock::” Locks all batches of the selected campaign.

“Promote:” Raises the priority of the campaign.

“Demote::” Lowers the priority of the campaign.

“Delete::” Delete the selected campaign.

“Unschedule::” Unschedules the desired campaigns. The submenu items unschedule the following campaigns:

“Campaign” – only the selected campaign.

“From Schedule Start” – the campaigns from the start of the schedule to and including the selected one.

“To Schedule End” – the campaigns from the selected one to the end of the schedule.

“Resolve Conflicts::” Resolves conflicts for the desired campaigns. The functionality of the submenu items is the same as in the “Unschedule” command. Available only for campaigns with conflicts.

“Reschedule::” Deletes the desired batches and schedules them from scratch. The functionality of the submenu items is the same as in the “Unschedule” command.

### 8.5.12 Managing Campaigns from the Equipment Occupancy Chart

**Campaign Selection**

Use the campaign selection button ( ) to select a campaign. Both scheduled and unscheduled campaigns are available.

**Scheduling and Rescheduling**

The scheduling button ( ) provides a menu with the following options:

“Schedule Campaign::” Schedules any unscheduled batches of the selected campaign.
“Schedule Start to Campaign:” Schedules all campaigns up to and including the selected campaign.

“Schedule Campaign to End:” Schedules the selected campaign an all subsequent campaigns.

“Schedule All Campaigns:” Schedules all campaigns.

“Reset and Schedule all Campaigns:” Unschedules and reschedules all campaigns.

**Unscheduling**

The unschedule button ( ) provides the following menu options:

“Unschedule Campaign:” Unschedules the selected campaign.

“Unschedule Start to Campaign:” Unschedules all the campaigns up to and including the selected campaign.

“Unschedule Campaign to End:” Unschedules all the campaigns from the selected campaign to the end.

“Reset Schedule:” Unschedules all campaigns.

**Conflict Resolution**

The resolve conflicts button ( ) provides the following menu options:

“Resolve Conflicts for Campaign:” Attempt to resolve all the conflicts in the selected campaign.

“Resolve Conflicts from Start to Campaign:” Resolve all conflicts in all batches from the start through the currently selected campaign.

“Resolve Conflicts from Campaign to End:” Resolve conflicts in the selected campaign to the end of the schedule.

**Campaign Management**

The Campaign Management button ( ) provides a menu with the following options:

“Edit Campaign:” Displays the campaign properties dialog.

“Add New Campaign:” Add a new campaign at the end of the campaign list (lowest priority).

“Insert New Campaign Before Selected:” Insert a new campaign at priority just above that of the selected campaign.

“Promote the Selected Campaign:” Move the selected campaign up one level in the priority list. This does not affect the current scheduling.

“Demote the Selected Campaign:” Move the selected campaign down one level in the priority list. This does not affect the current scheduling.

“Delete:” The selected campaign. Deletes the campaign and all its batches.

**Database Functions**

The database button ( ) provides the following functions for using the SQL SchedulePro database:

“Export Schedule to Database:” Saves a snapshot of all the current campaigns the the SQL Server database.

“Export Selected Campaign to Database:” Exports the selected campaign to the SQL Server database.
“View Stored Campaigns:” Displays a dialog for viewing all the campaigns in the current dataset.

“Manage Database:” Displays an interactive tree of all datasets in the database.

See chapter 9 for more details on the SQL Server database.

8.5.13 Trace and Rollback for Changes to the Schedule

The trace and rollback feature can automatically record manual changes to the schedule. The feature allows either user-initiated or automatic recording of any user changes to the scheduled batches or campaigns. Each change represents a rollback point, so a user may revert to any point in a series of changes.

This feature uses the SQL Server database, so this feature must be configured. See “Using the SQL Server Database” in Chapter 9.

Save Trace
This saves a full snapshot to the database. These traces remain in the database unless deleted by the user and are indicated by an asterisk (*).

Start Recording
Toggle the recording feature. When activated, every change in the schedule is recorded.

Move to Previous Trace
Reverts the schedule to the most recently saved trace.

Move to Next Trace
If Schedule has been reverted to an earlier version, move to the next later version.

Trace Menu
Revert to any recorded version.

At the close of the session, when the document is closed, only the explicitly saved versions will remain in the database.

8.5.14 Resource Search

If there are many equipment or staff items on the chart, some may be scrolled out of view. Use the “Go To” feature to scroll an item into view. Right-click the chart and select “Go To Equipment…”
Select the type of resource to find (equipment, work area, or staff), and begin typing the name. The list will automatically select the first match. Select OK to scroll the selected item into view.

8.6 Resource Consumption Charts

Resource profile charts display the rate of consumption or generation for material inputs, material outputs, labor, and utilities. These resources must have been assigned to operations in the scheduled recipes.

To view a resource chart, select “View/Resource Profiles” from the menu, and then select the resource to be viewed.

8.6.1 Resource Chart General Features

Resource Chart Line Edit Style (Lines Tab)

The resource profile charts can be customized by selecting item “Edit Style” from the context menu. The style dialog provides line settings and time settings in separate tabs.

All resource profile charts display instantaneous resource requirements as a function of time (rates). The Lines tab provides options for extending this functionality by displaying resource requirements averaged over a period of time (average rates), and cumulative resource requirements (amounts) for a period of time.

The Lines tab is slightly different for each resource type (labor, material, or utility) in the selected units of rate and amount.
Rate Line
Toggle the display of the instantaneous rate line and set its width and color.

Rate Limit Line
Toggle the display of the instantaneous rate line and set its width and color.

Rate Average Line
Toggle the display of the rate average line and set its width and color.

Cumulative Amount Line
Toggle the display of the cumulative amount line and set its width and color.

Reset Limit Time
Set the time after which the cumulative amount is reset to zero.

Reset Limit Amount
Set the amount at which the cumulative amount is reset to zero.
Legend
Toggle the legend and set its width.

Resource Chart Y-Axes Tab
The resource chart may have up to two y-axis scales. Rate values are read from the left axis, while cumulative amount values are read from the right axis. The Y-Axes tab has the following options:

Display Units
Rate In
Select the unit for the rate (left) axis.

Amount In
Select the unit for the cumulative (right) axis.

Rate/Amount Range
Auto
Allow SchedulePro to determine the minimum and maximum values from the data.

Set To
Set the minimum and maximum values by hand.

Resource Time Scale Tab
See section 8.3.2

Resource Chart Context Menu - Printing, Copying, and Exporting
The resource profile charts provide a context menu by right clicking on any available chart area. The context menu supplies entries for performing several chart operations, including printing, copying, and exporting of the chart.

To print the chart select item “Print” from the context menu.

To copy an image of this chart select item “Copy” from the context menu.

To export the data from the chart, select item “Export Data to Excel (HTML)” from the context menu. This creates an HTML file that may be viewed by a web browser or imported into most office software.

Resource Chart Context Menu - Zooming In and Out
The resource profile chart view may be adjusted from the context (right-click) menu.

“Fit to window:” Select this option to stretch or compress the entire chart in the available view area. Zooming is disabled. Scrolling is disabled.

“Zoom in:” If the chart is not at maximum zoom, select this option to magnify the scale.

“Zoom out:” If the chart is not at minimum zoom, select this option to view more of the chart.

“Edit Style:” Displays the style dialog.

“Copy:” Copies the chart image to the clipboard.

“Export Data to HTML for Excel:” Displays the export data dialog with the following options:
Charts and Reports

Export Options

Include Data

- **Instantaneous Rate** Export the instantaneous rate with the following options:
  - **Exact Data** exports raw data duplicate values may be exported for a given time.
  - **Sampled Data** exports data taken at regular intervals specified by the sampling period.
  - **Peak Data** exports the maximum in the specified sampling period.
  - **Average Rate** exports the averaged value for each period of the specified length.
  - **Cumulative Amount** exports the cumulative data with the specified time or amount reset limits. If both reset limits are included, the first limit encountered is applied.

“Print Preview:” Displays the print preview.

“Print Chart:” Prints the chart.

Resource Chart Link Buttons

The link (🔗) and update (🔄) buttons are only enabled when the chart is activated from the equipment chart. See section 8.5.5.

8.6.2 Material Profiles

A material profile may show the instantaneous and average consumption or production rates along with the total cumulative amount consumed or produced. The values are shown as a function of time.

There are three tiers of choices for plotting materials.

First, choose the material type from the “View→Resource Profiles” menu. The choices are:
“Raw Materials:” These are materials that enter the process. They are supplied through material input streams.

“Products:” These are materials that leave the process through material output streams that are designated as product streams.

“Waste:” This is any material that leaves the process through a designated waste stream.

**Second**, choose whether to plot by material, storage unit, or supply system.

The option **Plot by Material** shows the chart for a selected material component. When multiple materials are plotted, the contribution of each material’s consumption or production may be adjusted by a multiplier.

Select the properties ( ) button to enter the multiplier.

Plotting by **storage unit** shows the chart for all the material supplied by or to the storage unit. When plotting waste generation from a storage unit, the waste type should be specified.

Plotting by **material supply system** shows the chart for the component supplied by the material supply system. Material supply systems apply only to input (raw material) streams.

**Third**, optionally choose which recipes should be included in the plot.

The chart is displayed by clicking on the “Plot” button.
The legend on the right summarizes the types of profiles on the chart. The red line indicates the instantaneous production rate of material “Media” in the selected time units of kg/h; the blue line is the cumulative amount of “Media” in kg. The green line is the one-day average rate.

8.6.3 Labor Profiles
Labor requirements are displayed by selecting item “View/Resource Profiles/Labor…” from the SchedulePro menu. The following dialog appears.

Labor Chart Setup Resources Tab
The following options are available:

Facility
Select the facility to which the labor belongs.

Plot Single Resource
This Option plots the usage of a single labor resource.

Plot Multiple Resources (additively)
This Option plots the sum of all the labor pools.

Labor Chart Setup Recipes Tab
Select/deselect the recipes to be included in the plot.
8.6.4 Utility Consumption Charts

Utilities in SchedulePro are heat-transfer agents (steam, cooling water etc.) and electrical power. Utility charts are similar to the resource charts for material and labor.

To plot utility consumption, select “View/Resource Profiles/Utilities/” from the main menu. Then select either “Heating/Cooling Utilities…” or “Electrical Power…”. The resource selection dialog will appear with the following choices:

Resources Tab
- **Facility**
  Select the facility to which the utility belongs.

- **Plot Single Resource**
  This Option plots the usage of a single utility.

- **Plot Multiple Resources (additively)**
  This Option plots the sum of all the selected utilities.

Recipes Tab
- Select/deselect the recipes to be included in the plot.

8.7 Inventory Profiles

8.7.1 Types of Inventory Profiles

An inventory profile is a time chart that shows storage unit or equipment inventory over time.

- **Storage Unit Inventory**
  An inventory profile is generated for any storage unit (supply, product or intermediate) that has its inventory tracking feature selected.

- **Supply System Inventory**
  Material supply systems are special storage units. An inventory profile is generated for any supply system that has its inventory tracking feature selected.

- **Equipment Capacity Inventory**
  This profile is generated when equipment size and procedure sizes are specified. The profile displays the procedure size for the duration of the procedure.

- **Equipment Material Inventory**
  This profile is generated when equipment is associated with a storage unit. The profile displays the inventory of material held in the equipment.

8.7.2 Displaying an Inventory Profile

Select “View/Inventory Profiles” and select the type profile to plot. The setup dialog has a resources tab and a recipes tab.

Inventory Profile Setup Resources Tab

- Select the storage unit, supply system, or equipment to plot.
Inventory Profile Setup Recipes Tab
Select or deselect the recipes that contribute to the profile.

The green line indicates inventory amount in kg. The red line is the inventory amount limit.

8.7.3 Inventory Chart - Printing, Copying, and Exporting
The inventory profile charts provide a context menu by right clicking on any available chart area. The context menu supplies entries for performing several chart operations, including printing, copying, and exporting of the chart.

To print the chart select item “Print” from the context menu.

To copy an image of this chart select item “Copy” from the context menu.

To export the data from the chart, select item “Export Data to Excel (HTML)” from the context menu. This creates an HTML file that may be viewed by a web browser or imported into most office software.

8.7.4 Inventory Chart Line Styles in Detail
The inventory profile charts can be customized by selecting item “Edit Style” from the context menu. The style dialog provides line settings and time setting in separate tabs.

Lines
All inventory profile charts display inventory amounts as a function of time. The Lines tab provides options for customizing the time line properties.
Inventory Line
Set display options for the inventory amount line.

Include
Include/exclude the inventory amount line from the chart.

Width
Enter a custom width for the inventory line.

Color
Select a custom color for the inventory line.

Limit Line
Set display options for the inventory limit line.
Include
Include/exclude the inventory limit from the chart.

Color
Select a custom color for the limit line.

Width
Enter a custom width for the limit line.

Supply Rate Line
Set display options for the supply rate line.

Include
Include/exclude the supply rate line from the chart.

Width
Enter a custom width for the supply rate line.

Color
Select a custom color for the supply rate line.

Discharge Rate Line
Set display options for the discharge rate line.

Include
Include/exclude the discharge rate line from the chart.

Width
Enter a custom width for the discharge rate line.

Color
Select a custom color for the discharge rate line.

Legend
Select whether to display the legend and the maximum legend width.

Y-Axes
The inventory chart may have up to two y-axis scales. Rate values for the optional supply rate are read from the left axis, while cumulative amount values are read from the right axis. The Y-Axes tab has the following options:

Display Units

Rate In
Select the unit for the rate (left) axis.

Amount In
Select the unit for the cumulative (right) axis.

Rate/Amount Range

Auto
Allow SchedulePro to determine the minimum and maximum values from the data.

Set To
Set the minimum and maximum values by hand.
8.8 Utilization Charts

The equipment time utilization chart displays the percentage of the total schedule time during which each equipment, work area or staff unit is occupied. Utilization is counted as the time that the unit is occupied during the selected time span. Time periods during which the unit is multi-tasking or overbooked are counted as a single occupied period.

To display the equipment utilization chart, select item “View/Equipment Time Utilization…” from the SchedulePro menu.

On the equipment utilization chart, units are shown on the horizontal axis. The chart displays the following bars for each unit:

- **% occupied – total**: The percentage of scheduling horizon during which a unit is occupied by procedures
- **% occupied – busy**: The percentage of scheduling horizon during which a unit is occupied by operations
- **% occupied – idle**: The percentage of scheduling horizon during which a unit is reserved by procedures but not performing operations (i.e. waiting for operations to begin or resume)

The scheduling horizon may be modified by selecting item “Set Time Horizon” from the context (right click) menu.
8.8.1 Utilization Chart Fit-to-Window Mode

The equipment occupancy chart view may be adjusted from the context (right-click) menu.

Select this option to stretch or compress the entire chart in the available view area. Scrolling is disabled.

Note: If there are too many equipment items to display properly, turn off the Fit-to-window mode.

8.8.2 Utilization Chart Styles in Detail

The equipment occupancy chart may be customized by selecting item “Edit Style” from the context menu. The style dialog provides bar style settings.

Occupied-Total Bar
Select a custom color for the Occupied-Total bars by clicking on the color button.

Occupied-Busy Bar
Select a custom color for the Occupied-Busy bars by clicking on the color button.

Occupied-Idle Bar
Select a custom color for the Occupied-Idle bars by clicking on the color button.

Selecting the “Edit Contents/Ordering” item from the context menu brings up the “Contents/Ordering” dialog that allows for selecting which resources will be shown and in what order, as explained in section 8.2.
8.8.3 Setting the Time Window for Utilization Charts

The time horizon that is used to compute equipment utilization may be adjusted directly from the chart. Select “Set Time Horizon...” from the context (right-click) menu on the chart.

The time window adjustment dialog offers the following options:

**Date/Time**
If this is selected the time-window start and end are set in actual calendar time.

**Relative Time**
If this is selected, the time-window is set in terms of time from the beginning of the schedule.

**Exclude Outages**
If checked, facility or equipment outages are excluded from the utilization computation.

**Reset to Entire Horizon**
Select this button to reset the time window to the entire schedule start to end.

8.9 Easy-Print Charts

Easy-print charts are non-interactive forms of the Gantt and Equipment occupancy charts. Both charts can be time-clipped and both have improved printing and copying options.

To use the Easy-Print charts, select “View/Easy Print Charts” from the main menu. The charts have toolbar buttons for print, preview, copy, fit-to-window, zoom, and display options. The Gantt chart also has a detail-level tool.
Easy Print Chart Controls
The Easy Print chart controls parallel those in the standard charts.

Print
Displays the setup dialog for the default printer then prints the chart.

Print Preview
Displays the setup dialog for the default printer then displays the preview viewer. SchedulePro will not scale the image, but many printers allow scaling in the setup options.

Copy to Clipboard
Copies the chart or legend to the clipboard for pasting into external applications.

Toggle Fit to Window
Toggles the fit-to-window mode for the chart. If the time window of the chart has been clipped, only the included time range is displayed.

Zoom Menu
Provides the standard zoom options.

Settings
Displays the chart options or clipping options.

8.10 SchedulePro Reports
The schedule report is a table that shows the timing and resource assignments of all scheduled operations in the active SchedulePro project.
8.10.1 Report Options
SchedulePro reports are generated as HTML files and may be viewed with a web browser and most office software. SchedulePro also provides a built-in mini-browser. By default, reports will be displayed in your system’s default web browser.

To change the report view option select “Edit/Preferences…” from the main menu. Select the desired report viewing option in the dialog.

SchedulePro reports can be customized through three distinct sets of options. These options can be accessed from the “Report/Options” submenu. The “Reports…” menu item brings up the “Report Options” dialog, which contains a separate tab for each type of report that has special options (Schedule, Batch, Gantt, Material and Recipe reports). The “Clipping…” item of the “Options” submenu sets the clipping options (clipping based on campaign/batch and/or time), while item “Contents…” sets the resources included in the reports as well as the order in which they appear. The clipping and contents options are shared among various SchedulePro reports and charts. More details about these options can be found in paragraph 8.3.

8.10.2 Schedule Reports

Schedule Report
This report provides complete information about the timing and resource assignments for every scheduled operation. The schedule report is generated by selecting “Reports/Schedule Report...” from the main SchedulePro menu. The schedule report options can be changed through the “Schedule” tab of the “Report Options” dialog.
On the options tab, the following options may be set:

**Level of Detail**
Set the detail level for the schedule report. Scheduling and consumption information will be reported based on the selected level.
General Details
This section contains columns that can be included in the report regardless of the selected level of detail:

Calendar time
Check this option to include the start/end times of operations in absolute time.

Relative Time
Check this option to include the start/end times of operations in relative time.

Materials Usage
Check this option to include a column/field for materials consumption in the table.

Labor requirements
Check this option to include a column/field for labor requirements in the table.

Level Dependent Details
This section contains columns that can be included in the report only for certain detail levels and higher:

Batch Size (if available)
Check this option to display the campaign batch size. Available at the batch level and above.

Main Equipment
Display the main equipment. Available at the procedure level and above.

Transfer Panel Usage
Display Transfer Panel information. Available at the operation level.

Auxiliary Equipment
Display Auxiliary Equipment information. Available at the operation level.

Staff Requirements
Display staff information. Available at the operation level.

User Comments
Display user comments where available.

User Campaign Props
Display user-defined campaign properties.

Even Row Color
For improved readability, every other row may be displayed with the chosen background color.

Both the campaign/batch and the time clipping from the “Common” tab are applied on the schedule report.

Equipment Occupancy Report
The equipment table shows when the equipment is in use. Use the “Contents and Ordering” options to select the equipment to be displayed.
The report has the following formatting options:

**Operations**
Display the operations detail. Otherwise the report will display only the procedures for main equipment usages.

**Status**
Show the started/completed status of the procedures or operations.

**Main Equipment (For Auxiliary Uses)**
For auxiliary equipment, also show the main equipment with which the auxiliary equipment is used.

**Show Idle Time**
Explicitly display the equipment idle periods.

**Even Row Color**
For improved readability, every other row may be displayed with the chosen background color.

**Time Period and Units**
Set the reporting period for the Equipment Utilization Trend Report.

**Staff Report**
This displays the activities for the staff members. Use the contents/ordering dialog to select the staff to display.

**Status**
Show the started/completed status of the procedures or operations.

**Main Equipment**
Show the main equipment.
Auxiliary Equipment
Show the auxiliary Equipment.

Equipment Utilization Table
This is a tabular display of the percent utilization data shown in the equipment utilization chart. The equipment utilization report is generated by selecting “Reports/Equipment Utilization Table...” from the main SchedulePro menu. There are currently no additional options to specify for this report type.

<table>
<thead>
<tr>
<th>Equipment</th>
<th>Percent Occupied</th>
<th>Percent Busy</th>
<th>Percent Occupied Idle</th>
<th>Percent Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>CIP-Soda 1</td>
<td>67.78</td>
<td>67.78</td>
<td>0.00</td>
<td>32.22</td>
</tr>
<tr>
<td>MT-1 (12GL)</td>
<td>62.55</td>
<td>52.72</td>
<td>9.83</td>
<td>37.45</td>
</tr>
<tr>
<td>MT-2 (12GL)</td>
<td>60.46</td>
<td>37.66</td>
<td>22.80</td>
<td>39.54</td>
</tr>
<tr>
<td>ST-101</td>
<td>62.76</td>
<td>54.39</td>
<td>8.37</td>
<td>37.24</td>
</tr>
<tr>
<td>ST-102</td>
<td>59.83</td>
<td>54.39</td>
<td>5.44</td>
<td>40.17</td>
</tr>
<tr>
<td>Filler-1 (1-2L bag)</td>
<td>51.14</td>
<td>51.14</td>
<td>5.44</td>
<td>41.42</td>
</tr>
<tr>
<td>Filler-2 (1-2L bag)</td>
<td>53.88</td>
<td>51.14</td>
<td>5.44</td>
<td>41.42</td>
</tr>
<tr>
<td>Filler-3 (0.5L bag)</td>
<td>94.98</td>
<td>94.98</td>
<td>0.00</td>
<td>5.02</td>
</tr>
</tbody>
</table>

Equipment Utilization Trend Report
This report displays equipment utilization information as a function of time. The time window for reporting is determined from the clipping options, and the equipment are set by the contents and ordering options. The time period for reporting is set in the Equipment tab of the Report Options Dialog.
**Materials Report**

This is a set of tables that display consumption or generation of material over time. The materials may be grouped in several ways. The materials report is generated by selecting “Reports/Materials...” from the main SchedulePro menu. The materials report options can be changed through the “Material” tab of the “Report Options” dialog.

The Materials report can have two distinct sections. In the first section the amounts are reported by batch, campaign, or project (the columns represent batches, the rows represent materials) and in the second the amounts are reported for the entire schedule (the columns can be materials, streams or storage units, the rows represent time). The batch/campaign section has the following options:

**Columns per Page**
Maximum number of columns for the materials table. If that number is reached a new table will be created for the rest of the batches.

**Batch Size**
If checked the batch size is displayed in the column header.

**Calendar Time**
If checked the calendar time is displayed in the column header.

**Relative Time**
If checked the relative time is displayed in the column header in the selected units of measurement.

The entire schedule section has the following options:
By Material
Include a section that reports material consumption on a material basis (the columns of the tables in this section correspond to materials).

By Stream
Include a section that reports material consumption on a stream basis (the columns of the tables in this section correspond to streams).

By Storage Unit
Include a section that reports material consumption on a storage unit basis (the columns of the tables in this section correspond to storage units).

Reporting Period
Select the time period that will correspond to the rows of the table.

The rest of the material report options can be in certain cases applicable to both sections. The common options are the following:

Materials Consumed
Include consumed materials. If the Per material utilized radio button is selected then composite materials will be reported upon as single items. If the Per pure component radio button is selected then composite materials will be broken down to their components and each component will be reported upon separately.

Materials Used as Utilities
Include material consumption used to produce utilities (i.e. water for the creation of steam).

Materials Generated
Include generated materials. The selection can be further refined by checking the Products, Waste, or Unspecified options.

Preferred Physical Quantity
The preferred physical quantity for material reporting. The material density is used internally to convert from one quantity to the other. This option is ignored by Storage Units since they already have their own inventory basis quantity.

Preferred Unit of Measurement
Preferred units of measurement for the two physical quantities mass and volume.

The time clipping options from the “Common” tab are applied on the materials report.
Daily Activities Report

The daily activity report is a customizable listing of tasks that start or occur each day. The report may be customized at the recipe level as well as with the general reporting options.
**Report-Specific Options**

**Reporting Level**
Select the type of task to be reported.

The “Use Recipe Settings” checkbox activates the include/exclude settings in the recipes.

If the “Use Recipe Settings” checkbox is not selected, all the activities will be included.
The “Include User Comments” checkbox controls whether user comments are included for the appropriate level.

Also by default, only the tasks that start on a given day are reported for that day. If the “Include Tasks Started on Previous Days” checkbox is checked, ongoing activities will also be included.

**Include Facilities**
There are three options for limiting activities by facility.

- Report All Facilities Separately – Each facility will comprise a different section of the report.
- Single Report for All Facilities – All activities are reported in a single session regardless of facility.
- Report for Selected Facility – The report is limited to the selected facility.

**Color by Shift**
The report shows activities in chronological order. An activity may also be color-coded according to the shift in which it starts. Start time and duration define a shift. If shifts overlap, the color of the first matching shift will be used. SchedulePro ignores shifts with zero duration. Ongoing activities (started on a previous day) are always displayed in black.

**Report Format**
The report is a table in which each day is a column. There are three choices for organizing the rows.

- Daily – the user may select how many days to include in each row.
- Weekly – each row is a week.
- Monthly – the rows are grouped like a standard monthly calendar.

The **display width** of one-day may be set by the user.

**Economics Report**
The economics report provides cost summaries at the following levels of detail:

- Schedule
- Project (when displayed)
- Campaign
- Batch

At each level, the cost may optionally be broken down by resource.
8.10.3 Graphical Reports

Gantt Report

The Gantt report is an HTML version of the Gantt chart. The Gantt report is generated by selecting “Reports/Gantt Report...” from the main SchedulePro menu. The Gantt report options can be changed through the “Gantt” tab of the “Report Options” dialog.

The level of detail can be specified on the “Gantt” tab of the report options. The default level of detail includes campaign bars and batch bars on the chart.

Campaigns Only
Only campaign bars are shown on the chart.

Batches
Campaign and batch bars are shown on the chart.

Unit procedures
Campaign, batch, and procedure bars are shown on the chart.

Operations
Campaign, batch, procedure, and operation bars are shown on the chart.
Both the campaign/batch and the time clipping from the “Common” tab are applied on the Gantt report.

**Equipment Occupancy Graph**

This is an HTML version of the equipment occupancy chart. The equipment occupancy report is generated by selecting “Reports/Equipment Occupancy Graph...” from the main SchedulePro menu. There are currently no options to specify for this report type. Both the campaign/batch and the time clipping from the “Common” tab are applied on the equipment occupancy graph. The resources included in the graph as well as their order of display can be set from the “Contents/Ordering” dialog.
8.10.4 Recipe Report
Select “Reports/Recipe Report Options…” from the main menu. The recipe report options can be changed through the “Recipe” tab of the “Report Options” dialog.
The following options are available:

**Recipes to Include**
Select the recipes to be included in the report. The **Select All** and **Clear All** buttons automatically select and unselect all the recipes.

**Show Details**
Select the resource entries to be included. The selections apply to all selected recipes:

- **Work Areas**
- **Main Equipment**
- **Auxiliary Equipment**
- **Bill of Materials**
- **Transfer Panels**
- **Labor**
- **Material Input/Output**
- **Utilities**

**Background Color**
For improved readability, every other row may be displayed with the chosen background color.
The report will be displayed in your default report viewer.

8.10.5 Transfer Panel Report

Because transfer panels are relatively complex equipment items, there is a separate report that lists all the transfer panels in a facility along with their topology and connectivity.

To generate the transfer panel report, select “Reports/Transfer Panel Report…” and choose the facility. Alternatively, select the desired facility in the navigation tree, and right click on either the facility node or on the transfer panel node within the facility.

Enter a name for the file and click Save.
8.11 Saving Reporting Options

The clipping options, contents and ordering options and report options may be saved to a named options set and applied. This provides a way to apply commonly used settings without the need to reset them.

First set the desired clipping, equipment ordering, and report options. Then select “Reports ➔ Saved Options…”

The saved options dialog will appear.

Use the create-new ( ) button to create a new option set based on the current options.

The properties button ( ) allows renaming of the selected option set.

Use the get options ( ) button to save the current options to the selected options set.

Use the put options ( ) button to apply the selected set of saved options.
Chapter 9: Data Import/Export

Chapter 9: Data Import/Export ................................................................. 287

9.1 Exporting Schedule Data to MS Project™ ............................................. 288

9.1.1 Database Method ............................................................................... 288
  - Setting up The MS Project® Database .................................................. 288
  - Using the Access Database ................................................................ 288
  - Other Databases..................................................................................... 288
  - Exporting Data to Project .................................................................... 289
  - Exporting from SchedulePro / Opening in MS Project ....................... 289

9.1.2 MS Project XML Files ....................................................................... 289
  - Exporting the XML File ...................................................................... 289
  - Opening the XML File ........................................................................ 289

9.1.3 SchedulePro Formatting (Optional) .................................................... 290

9.2 Exporting Data to MS Access™ ............................................................. 290

9.2.1 The Recipe Database ......................................................................... 291

9.2.1 The Schedule Report Database ......................................................... 291
  - Exporting Data to the MS Access™ Report Database ......................... 291
  - Report Database Definition ................................................................. 291

9.3 Exchanging Data with ERP Systems ..................................................... 292

9.3.1 Overview .......................................................................................... 292

9.3.2 Configuring the MRP Interface ........................................................ 293
  - MRP File Input Configuration .............................................................. 293
  - MRP Export File Configuration ........................................................... 294
  - MDB Database Input Configuration .................................................... 295
  - MDB Database Export Configuration ................................................. 295

9.3.3 Importing and Exporting Data .......................................................... 296
  - Importing from an Input File ............................................................... 296
  - Exporting to a File .............................................................................. 296
9.1 Exporting Schedule Data to MS Project™

There are two methods for exporting schedule data to Microsoft Project.

9.1.1 Database Method

SchedulePro can export data to the MS Project 2000 ® database format. Although MS Project 2003 has a new database format, it is compatible with the 2000 format.

By default, the Project database will be an MS Access® (mdb) file. However, SchedulePro is able to work with other databases.

Setting up The MS Project® Database

Using the Access Database

SchedulePro uses the ODBC data source name (DSN) “SCP MSProj DB 2000”. By default this name is associated with the Access file, “SCP Project DB.mdb”.

If the DSN is not registered, select “Databanks/Edit Location…” from the SchedulePro main menu, and enter the path for the file, “SCP Project DB.mdb”.

Alternatively, the Windows ODBC data source manager may be used to set up the DSN.

Do not enter a password.

Other Databases

To use a database other than Access, configure the DSN “SCP MSProj DB 2000” using the Windows ODBC data source manager.

In SchedulePro, select “Databanks/Edit Location…” and enter the database login ID and password.
Exporting Data to Project

Exporting from SchedulePro / Opening in MS Project

Select “Connectivity/MS Project Link/Export to MDB File (Version Prior to 2003)” from the SchedulePro main menu.

Enter a name and select the resources (labor, utilities or materials) to be exported. Equipment resources are always exported. Note: you may export multiple projects to the same database.

Select OK.

Open MS Project.

Select “File/Open…” and either (a) select the Access file, “SCP Project DB.mdb” or (b) select ODBC and select the machine DSN, “SCP MS Proj DB 2000.”

Select the project to be imported and click “Open”. You may also delete projects from this dialog.

The table below describes how SchedulePro objects are translated to MS Project.

<table>
<thead>
<tr>
<th>SchedulePro Object</th>
<th>MS Project® Translation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign</td>
<td>Summary task</td>
</tr>
<tr>
<td>Batch</td>
<td>Summary task</td>
</tr>
<tr>
<td>Unit Procedure</td>
<td>Summary task</td>
</tr>
<tr>
<td>Operation</td>
<td>Fixed-duration Task</td>
</tr>
<tr>
<td></td>
<td>(Scheduling links are translated as predecessors)</td>
</tr>
<tr>
<td>Equipment</td>
<td>Work resource</td>
</tr>
<tr>
<td>Utility (power or heat-transfer)</td>
<td>Material resource</td>
</tr>
<tr>
<td>Material</td>
<td>Material resource</td>
</tr>
</tbody>
</table>

Operations that have been marked as completed in SchedulePro will be marked as 100% complete.

9.1.2 MS Project XML Files

For Project versions 2003 and later, XML is the preferred method. This method does not require a database file.

Exporting the XML File

Select “Connectivity/Export to XML File (2007 Version)” from the main menu. Enter a file name, and select the resources to be exported.

Opening the XML File

In MS Project, simply open the file and be sure to specify the file type as XML.
9.1.3 SchedulePro Formatting (Optional)

Because the campaigns, batches, and procedures are all summary tasks, it may be convenient to modify their bar styles to distinguish them.

SchedulePro sets four custom flag fields in Project as follows:

Flag1 = Campaign
Flag2 = Batch
Flag3 = Procedure
Flag4 = Operation

These flags may be used to create bar styles that distinguish campaigns from batches etc.

Select “Format Bar Styles…” from the Project Menu and select the color and shape as shown below.

The macro, “ScheduleProStyles”, which is included in “PrjSCPStyles.bas”, will set up bar styles that are similar to those in SchedulePro. Also it will set the default date/time format to show both date and time.

Installing the Macro File in Project

To install the macro file, select “Tools/Macro/Visual Basic Editor …” from the project menu.

When the VBA editor appears, select “ProjectGlobal (Global.MPT)” in the project explorer tree.

Select “File/Import File…” from the main menu and select the “PrjSCPStyles.bas” file.

Close the VBA editor. The macro, “ScheduleProStyles” can now be run by selecting “Tools/Macro/Macros…” from Project’s Main Menu.

9.2 Exporting Data to MS Access™
9.2.1 The Recipe Database

The recipe Database is normally used for interaction with SuperPro Designer. It may also be used to store recipes. It is possible to construct recipes directly in the database. The database supports most but not all SchedulePro features. Importing and managing recipes is described in section 5.2.

To find or change the patch of the recipe database, Select “Connectivity  Recipe Data…” from the main menu. The recipe database location is listed under location. The browse (…) button allows the user change change the location of the recipe database.

To export a recipe, right-click on the recipe (either in the navigation tree or in a recipe list) and select “Write Back to Recipe DB.” To export a facility, right click on the facility and select “Write to Database.”

9.2.1 The Schedule Report Database

SchedulePro can export schedule information to MS Access™ for custom reporting. The database file is “Spoutput.mdb.” Normally this file should be registered when SchedulePro is installed. To register the datasource name or to change the location of the file, select “Connectivity  MDB Report  Register Report Database…” from the main menu. In the dialog, select the browse (…) button and select the location of the file. Select OK to exit.

Exporting Data to the MS Access™ Report Database

Only schedule data are exported, so be sure that all desired campaigns have been scheduled. Select “ConnectivityMDB ReportExport Schedule Report to Database…” from the main menu.

Report Database Definition

The database tables are described below:

<table>
<thead>
<tr>
<th>TABLE</th>
<th>ID</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPORT</td>
<td>ID</td>
<td>Long Integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FILE</td>
<td>Varchar (255)</td>
<td>SchedulePro File name</td>
</tr>
<tr>
<td></td>
<td>CREATION_DATE:</td>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td>CAMPAIGNS</td>
<td>ID</td>
<td>Long Integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REPORT_ID</td>
<td>Long integer</td>
<td>REPORT.ID</td>
</tr>
<tr>
<td></td>
<td>CAMPAIGN_NAME</td>
<td>Varchar (255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>RECIPE</td>
<td>Varchar (255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>START</td>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td></td>
<td>END</td>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td>BATCHES</td>
<td>ID</td>
<td>Long integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>CAMPAIGN_ID</td>
<td>Long integer</td>
<td>CAMPAIGN.ID</td>
</tr>
<tr>
<td></td>
<td>REPORT_ID</td>
<td>Long integer</td>
<td>REPORT.ID</td>
</tr>
<tr>
<td></td>
<td>BATCH_NAME</td>
<td>Varchar (255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>START_DATE</td>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td></td>
<td>END_DATE</td>
<td>Timestamp</td>
<td></td>
</tr>
<tr>
<td></td>
<td>START_SHIFT</td>
<td>Integer (1,2,3)</td>
<td>(from SchedulePro Shift definition in Report Options...)</td>
</tr>
<tr>
<td>PROCEDURES</td>
<td>ID</td>
<td>Long integer</td>
<td></td>
</tr>
<tr>
<td></td>
<td>BATCH_ID</td>
<td>Long integer</td>
<td>BATCHES.ID</td>
</tr>
<tr>
<td></td>
<td>PROCEDURE_NAME</td>
<td>Varchar (255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>REPORT_ID</td>
<td>Long integer</td>
<td>REPORT.ID</td>
</tr>
<tr>
<td></td>
<td>DESCRIPTION</td>
<td>Varchar (255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>MAIN_EQUIPMENT</td>
<td>Varchar (255)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>FACILITY</td>
<td>Varchar (255)</td>
<td></td>
</tr>
</tbody>
</table>
### 9.3 Exchanging Data with ERP Systems

#### 9.3.1 Overview

SchedulePro supports the exchange of campaign information with external systems including MRP systems. The concept of a campaign in SchedulePro corresponds to a production order in an MRP system. The exchange takes place via either a text file or MS Access database file as shown below.

![Data Import/Export Diagram](image)

The configuration utility maps file or database fields to the campaign properties in SchedulePro.
9.3.2 Configuring the MRP Interface

**MRP File Input Configuration**

From the main menu, select “Connectivity/ERP Link/Configure Import/Export…” The first tab of the dialog shows the input configuration. The following options are available:

**File Type**

The file may be delimited or fixed-width. If the file is delimited (e.g. a CSV file), the *delimiter* should be selected below. If a delimited file has a title row with headings, the **Import Columns** button allows SchedulePro to open a sample file and guess the columns. If the file is fixed-width but also has separator characters, use the **Trim Delimiter** check, to ensure that the spacer characters do no interfere.

**Date/Time Options**

The **Date Delimiter** selects the day-month-year separator, and the **Date Format** option selects whether the day or month is first and the number of digits in the year. The **Has Time** option selects whether the date field also includes a time of day. The **Time Format** option selects 12 or 24 hour time.

The **Thousands Separator** specifies what, if any, character is used to separate thousands.

The **Header Rows** value should be the total number of rows before the data starts. This number should include the title row.

The **Footer Rows** value indicates the number of non-data rows at the end of the file.

The columns in the Table depend on the file type. The **Import File Field** is the name of the field in the ERP system. A value may be entered even if there is no title row. If the type is delimited the, **Order** column indicates the position of the field in a line of input data. The field entries do not need to be in order for fixed width files. If the type is fixed-width, the **Width** value indicates the width of the field.

The **Check Configuration** button opens and reads a sample file.
MRP Export File Configuration

From the main menu, select “Connectivity/ERP Link/Configure Import-Export…” The second tab of the dialog shows the export configuration. The following options are available:

File Type

The file may be delimited or fixed-width. If the file is delimited (e.g. a CSV file), the delimiter should be selected. If the file is fixed-width, the Include Delimiter option will place the delimiter character between fields as a separator. The Output Header option will include a title row for the fields.

Date/Time Options

The DateDelimiter selects the day-month-year separator, and the Date Format option selects whether the day or month is first and the number of digits in the year. The Has Time option selects whether the date field also includes a time of day. The Time Format option selects 12 or 24 hour time.

The following columns are in the configuration table: The SchedulePro Value corresponds to a campaign property to be exported. The Export File Field is the name of the corresponding field in the ERP system. The fields must be entered in order. The Width value indicates the width of the field. The width is ignored for delimited configurations.
**MDB Database Input Configuration**

Select “Connectivity/MDB Link/Configure Import-Export…” The first tab of the dialog shows the import configuration.

![Configure Campaign Importing/Exporting for Database File](image)

The following options are available:

**Setup Database**

The **Location** shows the MDB file location. The browse (“…”) button opens a dialog to browse to the file location. The **Status** indicates the whether the file opened as a database. The **Select Table** option is a pull-down menu of the tables/views found in the database.

The configuration table shows the correspondence between a **Database Field** and a **SchedulePro Value**. The SchedulePro values are campaign properties. Campaigns must have an ID and Recipe to be imported.

The **Check Configuration** button reads some data with the specified configuration and displays the results in a table.

**MDB Database Export Configuration**

Select “Connectivity/MDB Link/Configure Import-Export…” The second tab of the dialog shows the export configuration.

**Setup Database**

The **Location** shows the MDB file location. The browse (“…”) button opens a dialog to browse to the file location. The **Status** indicates the whether the file opened as a database. The **Select Table** option is a pull-
down menu of the tables/views found in the database. The Select Key value indicates a unique identifier for a database record. Typically this is the field that corresponds to the campaign ID. During export, SchedulePro uses this key to look up a record corresponding to a campaign. If a record is found it is updated with new information. If no record is found a new record is added.

The configuration table shows the correspondence between a Database Field and a SchedulePro Value. The SchedulePro values are campaign properties. An entry with the Select Key value must be present.

9.3.3 Importing and Exporting Data

Importing from an Input File
Select “Connectivity/ERP Link/Import…” and browse to the import file. The import results will be displayed in a table. Lines with a red status code will be skipped.

Exporting to a File
An export configuration must be present prior to export. Select “Connectivity/ERP Link/Export…” A table will display the lines to be written to the file. The Include field selects whether a particular record will be written to the file. Select Ok to create the file.

Importing from a Database File
Select “Connectivity/MDP Link Import…” The import table shows the fields to be imported. The Include column indicate whether at particular field should be imported. The Recipe ID field is a drop list that allows selection of alternative recipes for import. The Status field indicates whether the record will be imported. Records with a red status code will be skipped.

Exporting to a Database File
Select “Connectivity/MDB Link Export…” The export table displays the records to be sent to the database. The Include field selects whether a particular record will be written.

9.4 Scheduling from Text File Input
Sometimes it may be more convenient to prepare a list of batches to be scheduled in a separate application, e.g. a spreadsheet. This allows the user to define the batch names and (optionally) the start times in a formatted text file.

Note: Please see Chapter 8 for importing campaign information from ERP systems.

9.4.1 Formatting the Schedule File
The schedule input file is a tab-delimited text file. The first row lists the following field headers:

CAMPAIGN, BATCH, RECIPE, BATCHSIZE, CYCLETIME, BATCHSTART

Order and spelling are important, but case is not.

Each subsequent row must have the following fields. The fields are separated by tab characters. The text fields should not have quotes.

Campaign – this is a text Campaign ID.

Batch – this is a text batch ID.
Recipe – The name of the recipe for the batch. The recipe name must match a recipe that is loaded in the active SchedulePro project. If no matching recipe is found, the row will be skipped.

Batch size – If supplied the batch will be scaled to the size entered. The units must match the recipe’s batch size units. If the entry is zero or if the recipe’s nominal batch size is zero, no scaling is done.

Cycle time – Displays and sets the minimum time between consecutive batch starts. If this is the first batch or if the start date is supplied, the field is ignored.

Batch start – The start date and time in the format "mm/dd/yyyy hh:mm." The time is in 24 hour format. If this field is supplied, the cycle time field is ignored.

An example schedule file is shown below.

<table>
<thead>
<tr>
<th>CAMPAIGN</th>
<th>BATCH</th>
<th>RECIPE</th>
<th>BATCHSIZE</th>
<th>CYCLETIME</th>
<th>BATCHSTART</th>
</tr>
</thead>
<tbody>
<tr>
<td>XYZ-A</td>
<td>XYZ-1</td>
<td>Recipe-1</td>
<td>0</td>
<td>0</td>
<td>9/15/2004 8:00</td>
</tr>
<tr>
<td>XYZ-A</td>
<td>XYZ-2</td>
<td>Recipe-1</td>
<td>0</td>
<td>0</td>
<td>9/15/2004 10:00</td>
</tr>
<tr>
<td>XYZ-A</td>
<td>XYZ-3</td>
<td>Recipe-1</td>
<td>0</td>
<td>0</td>
<td>9/15/2004 12:00</td>
</tr>
</tbody>
</table>

9.4.2 Loading the Schedule File

Ensure that all the recipes listed in the file exist in the current SchedulePro project.

Select “Schedule → Load Schedule File…” from the main menu.

Browse to the desired file, and select Open.

SchedulePro will schedule the batches in the order that they appear in the file.

9.5 Using the SQL Server Database

9.5.1 Introduction

Beginning with version 3.6, SchedulePro will provide a database for saving, retrieving, and analyzing schedule data. The database is implemented in Microsoft SQL Server or SQL Server express. The SQL Server Management Studio is not required, but it may convenient.

Before using the Schedule you should install a SQLServer® or SQL Server Express® database.

9.5.2 Setting Up the Database

Install SQL Server

You may use a either a local instance of SQL Server or an instance on another computer on your network. Be sure you have adequate permissions to set up a database. The SQL Server Management Studio is not required, but it may convenient.

Configure the Database

Select “Connectivity SQL Server…/Connection Settings…” from the main menu.

Connection Type

Choose Local (Shared Memory) if you are using SQL Server express on your local machine. Choose Network if you are using an instance on another server.
Address
Required only if the SQL Server instance resides on another computer on your network. Enter the network name of the server machine.

Port
Required only if the SQL Server instance resides on another computer on your network. If your network has a dedicated port for SQL Server, enter the value.

Instance Name
A server may have more than one installation of SQL Server (usually for different versions of the software). Each installation or instance supports multiple databases. Enter the correct name for your SQL Server instance. If you are using a local instance, the instance name can be found through the SQL Server Management Studio or through the services list in the computer management utility in the control panel.

Authentication Type
If you are using a local version of SQL Server Express, the “Windows (Integrated)” authentication is sufficient. A user name and password are required for network versions of SQL Server.

Database
Any Database Name may be used. It is best to select a name associated with the application, e.g. “SchedulePro.” There are three configuration buttons:

1. **Check**: Checks whether a previously configured database needs to be updated.
2. **Setup**: Setup the database or update a previously configured database.
3. **Recreate**: Delete and rebuild the database

Dataset
The Dataset is a name that is associated with a SchedulePro file or set of files. The Dataset name should be changed when starting a new and unrelated scheduling project. The Dataset name does not need to be changed each time a SchedulePro file is saved with a new name.

The **Defaults** button resets the database setup values to their original defaults.
9.4.3 Exporting Data to SQL Server

Essentially all the data in a SchedulePro Document may be exported to the SQL Server database. Each time an export is done a snapshot is created, so the history of changes to a document can be archived. SchedulePro allows the export of the entire document, campaigns, recipes, materials and facilities.

Exporting the Document

Select “Connectivity→SQL Server…→Export Document” from the main menu. SchedulePro displays a notification dialog when the export is complete.
Exporting only the Scheduled Campaigns

Select “Connectivity → SQL Server… → Export Schedule” from the main menu. Only the scheduled campaign information is exported. To make the data completely retrievable, it is a good idea to export the entire document once before exporting the schedule.

Exporting the Materials

Right-click on the **materials** node in the navigation tree, and select “Export Materials to the SQL DB.” All the materials will be exported.

Exporting Facilities

To export all the facilities, right-click on the **Facilities** node in the navigation tree and select “Export All Facilities to the SQL Database.”

To export a single facility right-click on a facility in the navigation tree and select “Export to the SQL Database.”

All resources will be exported with the facility.

9.5.4 Viewing, Managing and Retrieving Data in the SQL Database

Retrieving a Dataset

To import an entire dataset to SchedulePro, check the **Selected** box for the row corresponding to the dataset, and select the import button. The last saved version of all resources, recipes and campaigns will be imported. If an imported object (recipe, facility, campaign) already exists in the SchedulePro document, a dialog provides the option of overwriting or keeping the object.
**Managing Snapshots**

To select a snapshot, check the *Selected* box. Click the import () button. All recipes, resources and campaigns in the snapshot will be retrieved.

The select all () button selects all snapshots. Snapshots may be deleted using the *delete* () and *deselect all* () buttons.

**Managing Material Resources in the Database**

When importing campaign data into an empty document, it is necessary to import the materials and facilities *before* importing the recipes.

To import materials select “Connectivity→SQL Database→Stored Materials…” from the main menu.

Click the *Selected* box corresponding to your dataset and select the import () button. The latest exported version of all materials in the dataset will be imported to the current SchedulePro document. The *delete* and *delete all* buttons will delete all materials in the dataset. The *zoom* () button shows all the snapshots for the selected material. The report () button shows list of materials in the dataset.

**Managing Facilities in the Database**

To import facilities, select “Connectivity→SQL Database→Stored Facilities…” from the main menu. Click the *Selected* box corresponding to each facility that you wish to import and select the import button ( ).

To import facilities, select “Connectivity→SQL Database→Stored Recipes…” from the main menu. Click the *Selected* box corresponding to each recipe that you wish to import and select the import button ( ).

The *zoom* button display the history of facility snapshots. The *report* button displays a report listing all the resources in the facility.
Retrieving Recipes

Recipes may be retrieved individually. When importing recipes into a new document, it is a good idea to retrieve the resources first. To retrieve a recipe, select “Connectivity → SQL Database → Stored Recipes…” from the main menu. Check the Selected box for the recipe(s) to be imported and click the import button.

The delete buttons remove recipes from the database. The zoom button shows the snapshot history of the recipe. The report button displays a tabular description of the recipe.

Managing Stored Campaigns

To view and report schedule data stored in the database select the “Connectivity → SQL Database → Stored Campaigns…” from the main menu. The stored campaign window appears.

The following options are available:

Campaign Search Criteria
Limit the time window for viewing campaigns.

Selected Datasets
Choose the dataset(s) to view. The dataset associated with the active document is the default.

Tardiness Report Time Units
The tardiness report is a bar graph that shows the days early or late for each campaign. Select an appropriate time unit depending on the duration of the schedule.

Schedule Report Detail Level
The Schedule Report lists all the activities by campaign and batch. The subsequent levels of detail are selectable.

Activities Report Detail Level
The activities report is a time based report that shows chronological daily listing of all scheduled procedures or operations.

The following tool bar buttons are available:

Select All
Deselect All
Retrieve from Database
Import the selected campaigns into the active SchedulePro document.
Show Tardiness Report
Display the campaign tardiness chart for the selected campaigns.

Show Campaign History
Show all the individual snapshots associated with the selected campaign.

Report Menu
The following reports are available:

- Campaign Details – show the properties for the selected campaign.
- Schedule Report – show the activities at the selected level of detail for the selected campaigns.
- Daily Activities Report – show the chronological activities for the selected campaigns.

9.5.5 Using the Database - Example

Exporting Data
This section covers basic data storage, retrieval and reporting. The general idea is that a schedule evolves over time. For example, an initial production plan may appear as shown in the Gantt chart below. Project 1 is initially scheduled to start in January and end in July.

Plan 1 - Initial Schedule
The project is associated with the dataset name “CMO Planning.” The scheduler saves this version to the database by selecting “Connectivity/SQL Server…/Export Schedule.”

At some point the plan is changed to reflect delays in the third and fourth campaigns as shown below. The schedule exports this plan as well.
Plan 2 - Revised with Delays

As the schedule is executed, the scheduler updates the data with actual durations. The final result is shown below. This final schedule

Plan 3 - Completed Schedule

Campaign Views

SchedulePro provides some basic reporting for the exported data. Select “Connectivity/SQL Server…/Stored Campaigns” from the menu. SchedulePro displays a list of all the campaigns associated with the dataset named in the file.
Stored Campaign List

The planned and actual is based on a comparison of the most recently exported (actual) campaign with a planned campaign selected by the user. By default, the first campaign exported is considered to be the planned campaign.

The recipe column is used for importing campaign data. See the Importing section below.

Campaign History

The magnifying glass button displays the campaign history view. This view displays a row for each time the campaign was exported to the database. The Planned column may be used to select which of the campaigns should serve as the official planned version for planned vs. actual reporting.

The scheduler in the above example may decide that the second version of the campaign should be used as the official plan, selects corresponding campaign and uses the check button.

Campaign History View

The campaign history view may also be used to delete or import any version of the campaign.

Reporting

The Stored Campaign list may be used to generate a schedule report at the batch, procedure, or operation level of detail. Select the detail level, and click the report button.
### Campaign Report Shown at the Procedure Level of Detail

<table>
<thead>
<tr>
<th>Batch</th>
<th>Procedure</th>
<th>Planned Start</th>
<th>Actual Start</th>
<th>Planned End</th>
<th>Actual End</th>
<th>Delay</th>
<th>Completion</th>
</tr>
</thead>
<tbody>
<tr>
<td>PR1-PD-56L-2B-1</td>
<td>Preculture</td>
<td>1/4/2010 8:00 AM</td>
<td>1/4/2010 8:00 AM</td>
<td>2/1/2010 8:00 AM</td>
<td>2/1/2010 8:00 AM</td>
<td>0d 0h 0m</td>
<td>856.93%</td>
</tr>
<tr>
<td></td>
<td>Cell Culture</td>
<td>1/15/2010 8:00 AM</td>
<td>1/15/2010 8:00 AM</td>
<td>2/3/2010 8:00 AM</td>
<td>2/3/2010 8:00 AM</td>
<td>0d 0h 0m</td>
<td>1,409.66%</td>
</tr>
<tr>
<td></td>
<td>Purification</td>
<td>2/1/2010 8:00 AM</td>
<td>2/1/2010 8:00 AM</td>
<td>2/9/2010 8:00 AM</td>
<td>2/9/2010 8:00 AM</td>
<td>0d 0h 0m</td>
<td>2,525.12%</td>
</tr>
<tr>
<td></td>
<td>Analytical</td>
<td>2/8/2010 8:00 AM</td>
<td>2/8/2010 8:00 AM</td>
<td>2/22/2010 8:00 AM</td>
<td>2/22/2010 8:00 AM</td>
<td>0d 0h 0m</td>
<td>1,459.67%</td>
</tr>
<tr>
<td>PR1-PD-56L-2B-2</td>
<td>Preculture</td>
<td>1/20/2010 8:00 AM</td>
<td>1/20/2010 8:00 AM</td>
<td>2/17/2010 8:00 AM</td>
<td>2/17/2010 8:00 AM</td>
<td>0d 0h 0m</td>
<td>752.89%</td>
</tr>
<tr>
<td></td>
<td>Cell Culture</td>
<td>2/3/2010 8:00 AM</td>
<td>2/3/2010 8:00 AM</td>
<td>3/2/2010 8:00 AM</td>
<td>3/2/2010 8:00 AM</td>
<td>4d 0h 0m</td>
<td>770.41%</td>
</tr>
<tr>
<td></td>
<td>Purification</td>
<td>2/17/2010 8:00 AM</td>
<td>2/21/2010 8:00 AM</td>
<td>3/4/2010 8:00 AM</td>
<td>3/4/2010 8:00 AM</td>
<td>4d 0h 0m</td>
<td>1,266.73%</td>
</tr>
<tr>
<td></td>
<td>Analytical</td>
<td>2/24/2010 8:00 AM</td>
<td>2/28/2010 8:00 AM</td>
<td>3/10/2010 8:00 AM</td>
<td>3/10/2010 8:00 AM</td>
<td>4d 0h 0m</td>
<td>1,307.21%</td>
</tr>
</tbody>
</table>
Index

A

Application Options, 15
ASAP, 13
ASAP Mode, 203
Automatic Mode, 203
Auxiliary equipment, 154

B

Batch
  Modifying, 225
Batch Economics, 228
Batch Window, 28

C

Calendar
  facility, 174
  labor, 177
Calendar Report. See Daily Activities Report
Calendar Times, 26
Campaign
  Creating, 17
  Due Date, 212
  Modifying, 224
  Scheduling, 219
  Start Mode, 211
Campaign Management
  In Equipment Occupancy Chart, 246
campaign priority, 209
Campaign Scaling, 218
Campaign Setup, 209
Campaign Window, 25
Campaigns, 209
cascaded supply systems, 197
Conflict Display, 250
Conflict Resolution Attempts, 208
Conflicts
  viewing, 221
Context Menu
  Batch, 29
  Campaign, 27
  Equipment, 46
  Facility, 41
  Labor, 42
  Material, 39
  Operation, 37
  Procedure, 34
  Recipe, 31
  Scheduled Operation, 53
  Scheduled Procedures, 52
  Storage Unit, 48
  Utilities, 44
Cost
  labor, 176
  material, 172
  staff, 178
  utility, 179

D

Daily Activities Report, 277
Databanks Menu, 59
Database
  Locations, 4
  Login ID, 5
  Microsoft Project, 288
  Password, 5
Dataset, 298
Drag and drop
  Schedule Editing, 251
Drag and Drop Editing, 245

economics
  overview for schedule, 224
Economics
  campaign, 217
  Reporting, 279
Edit Menu, 54
Equipment, 180
  ordering in charts & reports, 239
  Size, 183
Equipment Occupancy Charts, 243
Equipment Table Report, 272

F

Facility
  Adding, 16
Features, 12
File Menu, 53
Finding SchedulePro Objects, 55
Flexible shifts, 162
Full Conflict Calculation, 209

G

Gantt chart
  recipe, 168
Index

Gantt Chart, 241
Entire Schedule, 241
Gantt report, 280

Hardware key, 3, 4
Help Menu, 60

Installation
From CD-Media, 4
From Download, 4
Intermediate
Storage Unit Type, 190
Inventory
Tracking with Storage Units, 191
Inventory Chart
Y Axes, 265
Inventory Profiles, 262

Labor Profiles, 261
Labor resources
in recipes, 157
Labor Resources, 176
Launching SchedulePro, 15
Layout Mode, 203
Linking Child Charts, 250
long-term planning, 208

Major Time Interval, 241
Manual
contents, 2
Material inputs, 155
Material outputs, 156
Material Profiles, 259
Material Supply Systems, 196
Materials, 171
Materials Report, 275
MDAC, 3
Menus
Context, 22
Microsoft Project™
Export To, 288
Minor Time Interval, 241
Modes
campaign start, 211

Navigation Tree, 24

Operation
Labor, 157
Scheduling, 149
Operation Type, 145
Operation Types, 144
Operations, 144
scheduled, 229
Outages
scheduling operations in, 154

packaging size, 136
Preferences, 62
Procedures
in Recipes, 141
scheduled, 229
Projects
campaign, 219

Receiving
Storage Unit Type, 190
Recipe
Creating, 16
Recipe List Window, 29
Recipe Menu, 55
Recipe Report, 282
Recipe types, 136
Recipes
Basic concepts, 8
Scaling, 166
validating, 167
Report Viewer Options, 270
Reports Menu, 58
Resolving Conflicts, 222
in Equipment Occupancy Chart, 246
Resource Calendar, 173
Resource Chart
Y Axes, 258
Resource Consumption Charts, 256
Resource Selection
for charts and reports, 238
Resources
Basic concepts, 10
Resources Menu, 55
S
Schedule
   Creating, 17
Schedule Menu, 56
Schedule Report, 270
Schedule Start, 26
Schedule Start Date and Time, 25
Scheduled Procedure
   Editing, 229
Scheduler Settings, 25
Scheduling
   Basic concepts, 11
Scheduling Dependencies and Order, 247
Scheduling Horizon, 25
Scheduling Options
   Basic, 203
Scheduling Timing Options, 12
Scheduling Tolerance, 208
Sections
   Recipe, 140
Staff, 177
   ordering in charts and reports, 239
Staff resource, 177
Staff Resources
   in recipes, 157
Start Date and Time, 25
Storage Units, 190
Stored Campaigns, 302
Streams. See Material inputs
   managing for a recipe, 163
Suites, 198
SuperPro Designer
   Exporting from, 134
   Importing from, 135
Supply
   Storage Unit Type, 190
System Requirements, 3

T
Timescale Buttons, 240
Timescale Options, 240
Toolbar
   Batch, 28, 49
   Campaign, 26
   Equipment, 45
   Facilities, 40
   Material, 38
   Operation, 36
   Procedure, 33
   Recipe, 30
   Scheduled Operation, 53
   Scheduled Procedures, 51
   Utilities, 44
Transfer Panel, 186
Transfer Panel Report, 284
Transfer Panels
   in recipes, 159

U
Used-By feature, 171
Uses, 2
Utilities, 178
   in Recipes, 158
Utilization Chart, 266
Utilization Charts, 266

V
View Menu, 57
Viewing Resource and Inventory Charts from the Equipment Occupancy, 249

W
weekend hours, 248
Work Areas, 185
   ordering in charts & reports, 239